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INTRODUCTION 1 

For mining operations that are conducted below the water table, there are two important 

water-related problems that mine operators could face: groundwater inflow into an 

underground excavation or an open pit if the country rock is relatively permeable or, if the 

rock is impermeable, pore pressure affecting the stability of open-pit highwalls or 

underground excavation. For economic and safety purposes, it is important to be able to 

predict the nature and magnitude of these potential problems so that appropriate dewatering 

or depressurizing systems may be installed. 

Numerical groundwater flow models are now routinely used to predict inflows and pore-

pressure distributions for both open-pit and underground mines and to help design mine 

dewatering systems. Although adequate for addressing broad issues such as the impact of 

mining operations on regional water resources, available groundwater numerical codes are 

limited in their ability to quantify the more detailed problems of the phreatic surface in 

highwalls and inflows to both open pits and underground openings. These limitations arise 

primarily from the following: 

▪ How the flow domain is subdivided into finite, geometric pieces—the discretiza-
tion used in a numerical model—could strongly affect the predictions of inflow 
and the shape of the phreatic surface near an excavation. Not only must discrete 
features, such as faults and contacts between different hydrogeologic materials, 
be included in the discretization, but predicting the essentially radial flow toward 
an excavation is more accurately performed by using small, approximately 
logarithmic mesh spacing. Finite-difference codes have an inherent limitation 
relative to finite-element discretization when applied to any problem that is 
hydrogeologically or geometrically complex. 

▪ The seepage face—the surface of the highwall of an open pit through which lateral 
flow occurs—is usually not properly estimated in most commonly used finite-
difference codes. The height of the seepage face affects both the amount of lateral 
inflow and the height of the water table behind the highwall. A poor estimate of 
the height of the seepage face can introduce significant errors to the predicted 
inflows and pore pressures. 

▪ For slope-stability analysis, it is critical that the output of the pore pressure can 
be readily used in the geomechanical model. The pore pressure data from the 
groundwater flow model that are not compatible with the data requirements of 
the geomechanical model will delay the integration between these two models. 
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To overcome limitations such as those described above, Itasca Denver, Inc. (Itasca) developed 

MINEDW, a three-dimensional (3-D), finite-element groundwater flow code. The core of the 

code is based on algorithms previously developed by Durbin and Berenbrock1 for the United 

States Geological Survey (USGS) code FEMFLOW3D. As of early 2018, MINEDW has been used 

successfully at more than 50 mines located throughout the world and in diverse 

hydrogeologic and climatic conditions. The code has been in use for approximately 30 years, 

and its predictions have been validated by field data collected over many years. 

Since Itasca first commercially released MINEDW in 2012, Itasca has continued to improve 

the functionality of MINEDW. The current version, MINEDW 3.05, represents over XX years 

of development and is commercially available. 

Itasca would like to acknowledge the contributions from the past and current employees of 

Itasca and its predecessor, Hydrologic Consulting, Inc. Among them, Mr. Timothy Durbin and 

Dr. Lee Atkinson were instrumental in the inception and early development of MINEDW.  

 

 
 

1 Durbin, T.J., and C. Berenbrock. 1985. Three-dimensional simulation of free-surface aquifers by the finite-
element method. U.S. Geological Survey Water-Supply Paper 2270, pp. 51–67. 
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FEATURES OF MINEDW 2 

The MINEDW software includes special features that facilitate the  

3-D simulation of dewatering operations in open-pit and underground mines. Some of these 

features are as follows: 

▪ The progressive excavation of an open pit can be simulated in the model by 
changing the elevation of the nodes affected by mining over time.  

▪ A groundwater flow problem is simulated as saturated-unsaturated groundwater 
flow. This allows the finite-element mesh to remain fixed with time (except for 
excavations) and the saturated flow domain to adjust with time in accordance 
with changes in the position of the water table. The fixed mesh, in contrast to a 
deforming mesh, facilitates the representation of the spatial hydrogeologic 
variability of a groundwater system by the finite-element mesh.  

▪ MINEDW provides 3-D graphic representations of geology, model domain, pit 
geometry, groundwater heads, groundwater flux, recharge and evaporation 
zones, particle tracking, and pore pressures. 

▪ Specified-head boundary conditions can be imposed using heads that are either 
invariable with time or variable with time. In the latter case, the boundary heads 
are specified in terms of tables representing a hydrograph of the heads. 

▪ Specified-flux boundary conditions and internal source-sink terms are defined by 
a group of data sets that can be combined in different configurations for each time 
step. 

▪ Variable-flux boundary conditions can be imposed to simulate time-variant 
boundary fluxes in response to changing boundary heads. This boundary condi-
tion allows the finite volume of the modeled flow domain to be “extended” to 
infinity by “attaching” the analytical solution for a semi-infinite, linear aquifer to 
the boundary of the flow domain.2 

▪ The interaction between the groundwater system and river networks can be 
realistically simulated. Streams are simulated as a river network (or networks) 
that consists of a main river channel and tributary channels. The model accounts 

 
 

2 Carslaw, H.S., and J.C. Jaeger. 1959. Conduction of heat in solids. 2nd ed. Oxford, UK: Oxford University 
Press. 
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for streamflow depletions or additions by simulating the exchange of water 
between the stream and the groundwater system. 

▪ In addition, evapotranspiration of groundwater from vegetated areas or 
evaporation from bare-soil areas can be simulated. The evapotranspiration rate 
is assumed to be inversely proportional to the depth from the ground surface to 
the water table elevation. MINEDW uses the maximum evaporation rate and the 
extinction depth as constraints. 

▪ Spatial and temporal variation in precipitation across the model domain can be 
simulated. In areas with steep relief, MINEDW has the capability to simulate 
orographically controlled precipitation.  

▪ Open-pit excavation, open-pit backfilling, and pit-lake formation can be efficiently 
simulated within a MINEDW model.  

▪ MINEDW can efficiently simulate the formation of a zone of relaxation (ZOR) 
around a pit excavation or underground mining operation through time 
according to the mining schedule. 

▪ Outputs of pore-pressure distribution can be seamlessly used in both two-
dimensional (2-D) and 3-D geomechanical models using Itasca’s geomechanical 
codes. 
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MINEDW INTERFACE  3 

Chapter 3 of the MINEDW manual provides an overview of the menu and display options in 

the MINEDW graphical user interface (GUI). The layout of the main MINEDW interface is 

shown in Figure 3.1. 

 

Figure 3.1. The MINEDW main interface 

The main interface shown in Figure 3.1 consists of the following components: 

1. View Pane (shown in the purple frame), 

2. Main Menu banner (shown in the red frame), 

3. Toolbar (shown in the green frame), and 

4. Control Panel (shown in the yellow frame). 
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3.1. View Pane 

View Panes are used to store plots and function as a window that can be opened and closed. 

The View Pane without any plot items is defined as the base View Pane as shown in Figure 

3.1. The base View Pane is a unique View Pane (there is only one) in that it is permanent and 

cannot be closed, although it can be hidden from view. 

The assembly of plot items within a View Pane is performed using the Control Panel, which 

provides tools that can be used to define the contents of the plot (plot items) and the 

appearance of those items. A description of the Control Panel is provided in later sections. 

Plots typically consist of a model mesh, geologic setting, wells, boundary conditions, model 

outputs, and legend, as shown in Figure 3.2. Note that the Control Panel is turned off in Figure 

3.2 in order to illustrate the View Pane. 

The plot items in a specific View Pane can be saved in views using the “View” menu. There is 

no limit to the number of View Panes that can be created and saved. Each saved View Pane is 

listed under the “View” menu and can be retrieved for viewing or permanently deleted using 

this menu. 

 

Figure 3.2. Typical layout of a View Pane 
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3.2. Main Menu 

The Main Menu banner in MINEDW includes the major functions of the MINEDW GUI. It 

contains 11 items: 1) “File,” 2) “Project,” 3) “Mesh,” 4) “BCs,” 5) “Mining,” 6) “Run,” 7) “Results,” 

8) “View,” 9) “Tools,” 10) “Windows,” and 11) “Help,” as shown in Figure 3.3. 

 

 

Figure 3.3. Main Menu banner 

3.2.1. The File Menu 

The “File” drop-down menu contains the items shown in Figure 3.4. Detailed descriptions of 

each menu item are also provided in Figure 3.4. 

 

Figure 3.4. “File” drop-down menu 

New Project: Creates a new project. 

Open Project: Opens an existing project. 

Save Project: Saves the current project file. This menu item remains inactive unless there is a 
change to the modeling components such as geologic setting, boundary condition, etc. 

Save Project As: Saves a copy of the current project file using a different file name. 

Close Project: Closes the project. 

Print Base: Selects the printing device and prints the base image. 

Export Base: Exports the base image as a bitmap, .DXF, .VRML, postscript, or .SVG file. 
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Import: Imports a MINEDW project, a FEFLOW data set or a stereolithography file containing 
a finite-element mesh. After the “Import” button is clicked, an “Import File” dialog box 
opens and provides four options. A user can import a MINEDW data-file list (.FEL) that 
was created for MINEDW model simulations, a MINEDW geometry file (.PST) that was 
created with the mesh generator from MINEDW 2.10, a geometry file (.STL) that was 
created using Rhinoceros 3D, a FEFLOW ASCII data file (.FEM), or a FEFLOW ASCII result 
file (.DAC). If a MINEDW data-set file (.FEL) is used, then all information related to the 
model—except the results—is imported; however, if a MINEDW geometry file (.PST) is 
used, then only the geometry and the geologic zone information are imported. 
Importing model data sets is discussed in detail in Chapter 4. 

Export: Exports the model in a FEFLOW-supported format that can be imported into FEFLOW 
for simulation. 

Quit: Exits MINEDW. When the “Quit” menu item is selected, a warning message appears 
reminding the user to save the project if it has not been saved, as shown in Figure 3.5. If 
“Discard” is selected, then all unsaved changes to the model are lost. To save a project 
or changes to an existing project, the file must be saved before the “Quit” command is 
used. 

 

 

Figure 3.5. The MINEDW “Quit” dialog box 

3.2.2. The Project Menu 

The “Project” drop-down menu is available from the Main Menu banner and includes the 

items shown in Figure 3.6. 
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Figure 3.6. The “Project” drop-down menu 

Project Properties: Contains specifications for the simulation parameters, including units, 
type of simulation, closure criteria, solver type and solver parameters, and output 
names. A detailed description of the parameters specified in the “Project Properties” 
dialog box (Figure 7.1) is provided in Section 7.1.1. 

Time Steps: Contains information on time steps, the maximum number of time steps, and 
simulation time steps for model simulations. The parameters specified in the “Setup 
Time Step” dialog box (Figure 7.2) are described in Section 7.1.2.  

Zone Properties: Defines the hydraulic properties for each geologic unit simulated in the 
model. Each zone represents a geologic unit with unique hydraulic properties. A 
detailed description of material properties is provided in Section 7.3. 

Initial Head: Defines the initial conditions for hydraulic head in the model. Section 7.5 
provides detailed information about the assignment of initial head values. 

Import Elevations from Node File: Allows for the importing of a node elevation file (node.fem) 
if changes have been made to node elevations using other editing tools or in another 
MINEDW model. A brief description on how to import node elevations is provided in 
Section 7.2.4.  

Import Zones from Parameter File: Allows for the importing of a zone parameter file 
(para.fem) if changes have been made to the distribution of hydraulic properties using 
other editing tools or in another MINEDW model. A detailed description of this function 
is provided in Section 7.3.1. 

Undo: Allows the user to undo changes that were made to the groundwater flow model, except 
in cases where the nodes were changed. A detailed description of this function is 
provided in Section 3.3. 

Redo: Allows the user to redo any undone changes to the model, except in cases where the 
nodes were changed. A detailed description of this function is provided in Section 3.3. 
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3.2.3. The Mesh Menu 

The “Mesh” drop-down menu is available from the Main Menu banner and includes the items 

shown in Figure 3.7. Detailed information about these menu items is available in Section 7.2. 

 

Figure 3.7. The “Mesh” drop-down menu 

Define Main Layer: This menu is used to create main layers for the model. Main layers are 
defined as layers that are present throughout the whole model domain. Details about 
layers can be found in Section 7.2.2. 

Define Pinch-Out: This menu is used to refine the vertical discretization of the main layers in 
selected areas. Details about the pinch-out method can be found in Section 7.2.5. 

Modify Mesh: This menu is used to refine or extend the mesh for a selected area using a 
boundary line file (.BLN). Details about mesh refinement can be found in Section 7.2.6. 

3.2.4. The BCs Menu 

The “BCs” menu is a drop-down menu (Figure 3.8) that includes the menu items listed below. 

Detailed information about these menu items is provided in Section 7.4. 

 

Figure 3.8. The “BCs” menu 

Constant Head: Menu for assigning constant-head boundary conditions (e.g., boundary head 
invariable with time, boundary head variable with time, and drain nodes). See Section 
7.4.2 for complete details on constant-head assignment. 

Variable Flux: Menu for assigning variable-flux boundary conditions. See Section 7.4.3 for 
complete details on the assignment of variable-flux boundaries. 

Pumping Well: Menu for specifying source-sink terms (e.g., pumping wells). See Section 7.4.4 
for complete details on source-sink terms. 
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River: Menu for creating rivers and tributaries. See Section 7.4.5 for complete details on river 
boundary conditions. 

Recharge: Menu for assigning recharge zones to the groundwater system. See Section 7.4.6 
for complete details on recharge. 

Evaporation: Menu for assigning the loss of groundwater from a shallow water table due to 
evapotranspiration and/or evaporation. See Section 7.4.7 for complete details on 
evaporation. 

3.2.5. The Mining Menu 

The “Mining” drop-down menu contains the options shown in Figure 3.9. Note that this menu 

is not active for a steady-state simulation. Details about these menu items can be found in 

Section 7.6. 

 

Figure 3.9. The “Mining” drop-down menu 

Open Pit: This menu is used to simulate open-pit mining in MINEDW. It allows the user to 
import a previously created mining plan, create new mine plans, set up input 
parameters for pit-lake simulation, create a ZOR, and define backfilling operations for 
open pits. Details about this function can be found in Sections 7.6.1 to7.6.5. 

Dewatering and Underground Mining: This function is used to construct a simulation 
involving underground mining. The menu allows the user to create a time-varied 
hydraulic conductivity file for the model to simulate the changing hydraulic 
conductivity that results from underground mining operations, freeze-thaw conditions, 
or other scenarios wherein hydraulic conductivity changes. This menu also allows the 
user to specify details to simulate the groundwater recovery after the end of mining and 
to simulate backfilling of the underground excavation if desired. Details about options 
can be found in Section 7.6.7. 

Create Mining Plan: Creates a mining file that simulates the progressive excavation of an 
open-pit mine. Mining plans are then imported into the model using the “Open Pit” 
menu. Details about creating a mining plan can be found in Section 7.6.1. 

Zone of Relaxation for Caving: Creates an input file related to caving. Details about ZORs for 
caving can be found in Section 7.6.6. 

3.2.6. The Run Menu 

The “Run” drop-down menu contains the items listed in Figure 3.10. Details about these menu 

items can be found in Section 8. 
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Figure 3.10. The “Run” drop-down menu 

Validate: Verifies that the groundwater model is correctly defined. 

Create Data Set: Creates the data files in ASCII format. These files are used in the MINEDW 
calculation. 

Execute: Starts the simulation. 

3.2.7. The Results Menu 

The “Results” drop-down menu contains the items shown in Figure 3.11. Details about these 

menu items can be found in Section 9. 

 

Figure 3.11. The “Results” drop-down menu 

Read Results: Reads the results from a .PLB file. The .PLB file contains the output of 
groundwater head at specified time-step intervals from the model simulation. After the 
results have been read, they can be visualized in the View Pane (described in Section 
9.1). 

Export Results As Text File: This function allows the user to convert a .PLB file (binary file of 
MINEDW simulation results) to a .PLT file (ASCII file). 
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Observations: Defines the locations and screen intervals of monitoring borehole(s) and the 
locations of piezometer(s) that can be used to export simulated water levels in ASCII 
format for external plotting. Details about observations are provided in Section 9.2.  

Hydrograph: Creates an output data file—in ASCII format and with the file extension .DAT—
for plotting a hydrograph based on the observation locations defined in the 
“Observations” menu. The output data file contains time steps, date and time, and water 
levels for each observation point. Details about hydrographs are provided in Section 9.3.  

Particle Tracking: Defines the parameters for particle-tracking simulations and runs the 
simulations. A detailed explanation of the particle-tracking simulations is provided in 
Section 9.4. 

Section Flux: Computes the flux passing through a plane defined by the user using the start 
and end locations of the plane and vertical height of the plane, as described in detail in 
Section 9.5. 

Seepage Component to Pit: Computes seepage to the pit from each geologic unit through time. 
Details about seepage are provided in Section 9.6.  

Pit Node Elevation and Water Table: Plots changes in pit node elevation and the water table 
below the pit node through time for nodes selected by the user. Details about “Pit Node 
Elevation and Water Table” plots are provided in Section 9.7.  

Export State: Exports simulation results in either 2-D or 3-D (e.g., x, y, elevation, pressure, 
drawdown, head, water table, head difference) for the time step selected using the time-
step slider. Details about exporting results are discussed in Section 9.8. 

Export Pore Pressure: Exports pore pressures in 3-D with a specified grid space and 
dimensions. Details about exporting pore pressures in 3-D are provided in Section 9.9.  

Export Cross-Section Pore Pressure: Exports pore pressures in 2-D with a specified grid space 
and section. Details about exporting pore pressures of cross sections are provided in 
Section 9.10. 

Export Pore Pressure to FLAC3D: Exports the simulated pore pressure to a FLAC3D format. 

Drawdown Base Time Step: Defines the time step at which the simulated water level is used 
as the reference for calculating the drawdown or head difference of a given time. The 
drawdown is calculated according to the reference time and the selected time step. 
Detailed information can be found in Section 9.11. 

3.2.8 The View Menu 

The “View” drop-down menu contains the items shown in Figure 3.12.  
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Figure 3.12. The “View” drop-down menu 

Vertical Exaggeration: Vertically exaggerates the view of plot items. This exaggeration applies 
to all plot items in the view. 

New: Creates a new view that can be stored. 

Save: Saves the current view. View items can be saved with the project file and be reloaded 
when a project file is loaded in MINEDW. To save the view items that will be reloaded 
with the project file, the user must also click “Save” in the “File” menu to save the project 
that contains the saved view items. 

Save As: Saves a copy of the current view using a different name. 

Options: Opens “View Options” dialog box, which allows the user to export, import, and delete 
saved views.  

Listed Views: If views have been created and saved to the MINEDW .PRJ file, a list of the saved 
views that are available appears in the drop-down menu (e.g., in Figure 3.12, the listed 
views are “3D Element,” “Elevation,” and “Geology”). In order to reload these saved view 
items when reloading a saved project, the project file needs to be saved before 
termination of the model operation. 

3.2.9. The Tools Menu 

The “Tools” drop-down menu contains the items listed in Figure 3.13.  

 

Figure 3.13. The “Tools” drop-down menu 

Options: The user-specified configuration options in MINEDW are shown in Figure 3.14 and 
described below. These options are accessed via the “Options” dialog box. The dialog box 
is divided into areas of functionality that correspond to the buttons shown below.  
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Disable Tooltips: Disables the descriptions that pop up when the mouse hovers on top of a 
function such as the “Select” tool.  

Restore Layout: The “Control Panel” Pane, as well as the View Pane, can be moved within the 
MINEDW window and toggled on or off. To revert back to the default layout of MINEDW, 
use the “Restore Layout” option. 

The “MINEDW Options” dialog box (Figure 3.14) presents the options listed below. The 

“Display” and “Movie” tabs are discussed in Sections 3.4.1.1 to 3.4.1.3. 

 

Figure 3.14. The “MINEDW Options” dialog box 

Show Startup Dialog: After selecting this option (see Figure 3.14) and restarting MINEDW, the 
“Startup Options” dialog box is displayed (Figure 3.15, below). This enables a user to 
select what to do next (e.g., “Open Last Project,” “Open Existing Project,” “Create New 
Project,” or “Cancel”), as shown in Figure 3.15. The "Startup Options" dialog box can be 
disabled by checking the box at the bottom if the user does not wish to see this option 
upon startup (see Figure 3.15).  

Open Most Recent: When selected, this control sets MINEDW to open the most recent project 
upon startup and to hide the startup dialog box. 

Start New: When selected, this control sets MINEDW to start a new project upon startup and 
to hide the startup dialog box.  

Do Nothing: When selected, this control sets MINEDW to open with no project loaded and to 
hide the startup dialog box. 

Splash Screen: When enabled, this control sets the MINEDW splash screen to be shown at the 
startup of MINEDW. 
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Figure 3.15. The “Startup Options” dialog box 

3.2.10. The Windows Menu 

The “Windows” drop-down menu allows the user to toggle the Control Panel and the available 

plots on or off. By default, it contains the “1 Control Panel” and “2 Plot 1 - Base” file (Figure 

3.16). Clicking on the “1 Control Panel” and “2 Plot 1 - Base” options turns the Control Panel 

and Plot 1 - Base on (as indicated by a check mark) or off. If any plots have been created, they 

will appear in the “Windows” drop-down menu below “2 Plot 1 - Base” and can be toggled on 

or off by clicking on the plot name. In Figure 3.16, the plot file named “3 Plot 2 - View004” has 

been created but is turned off. Clicking on the plot file will turn it on. 

 

Figure 3.16. The “Windows” drop-down menu 

3.2.11. The Help Menu 

The “Help” (Figure 3.17) drop-down menu provides some information about MINEDW as well 

as contact information for Itasca Denver and a short description of the Qt library that was 

used to develop the MINEDW interface. 

 

Figure 3.17. The “Help” drop-down menu 
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3.3. Toolbar 

The MINEDW Main Menu toolbar (Figure 3.18) is found next to the menu banner at the top 

of the screen. It contains the tools shown in Table 3.1 (below). 

 

Figure 3.18. The MINEDW Main Menu toolbar 

Table 3.1 (below) describes the functions of the Main Menu toolbar items.  

Table 3.1. The Main Menu Toolbar Item Descriptions 

 

Create New Plot 
Creates a new plot file in a new View Pane in the active 

window. 

 

Regenerate Current Plot 

(F5) 

Refreshes the current plot to reflect the current model 

data.  

 

Print the Current Plot 

(CTRL+P) 
Sends the current plot to the printer. 

 

Export to File 
Exports the current plot to a bitmap, .DXF, .VRML, 

Postscript, or .SVG file format. 

 

View Mode ‒ Change View 

Perspective 

Changes the cursor to the mode used for basic view 

manipulation (e.g., rotation, translation, and 

magnification). 

 

Select  
Changes the cursor to the mode for selecting elements 

or nodes. 

 

Move Node Moves finite-element mesh nodes. 

 
Search Node/Element 

Searches for nodes or elements by node or element 

number. 

 

Measure Distance Calculates the distance between two points. 

 

Define Plane 
Calculates the dip, dip direction, and normal direction 

of a plane defined by three selected points. 

 

Create Plane 
Creates a cross section using two points defined by 

the user. 

 
Select with Polygon 

Selects nodes or elements in a desired area defined by 

a polygon drawn with the mouse pointer. 

 
Select with Overlay 

Selects nodes or elements using a point, polyline, or 

polygon from “*.DAT,” “*.BLN,” or “*.SHP” files. 

 

Plot Items Shows or hides the “Plot Items” control panel. 

 

View Controls Shows or hides the “View” control panel. 
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View Information Shows or hides the “Information” control panel. 

 

To view the desired time step, enter it in the variable field and press [Enter], move the time-

step slider (found on the right side, as shown in Figure 3.19), or click the up or down arrow 

to the desired time step.  

 

Figure 3.19. Time-step slider 

To undo an action, click the “Undo Action” button (Figure 3.20). You can see a list of the actions 

available to undo in the “Show Undo Stack” window.  

  

Figure 3.20. “Undo,” “Redo,” and “Show Undo Stack” buttons 

To redo an action that you undid, click the “Redo Action” button. The action is then reversed.  

3.4. Control Panel Pane 

The Control Panel displays a plot file created through “Create New Plot.” Each of the plot files 

is listed under the View Pane. A specific plot file will display in the Control Panel after it is 

selected.  

The attributes of the selected plot are displayed in three sub-panes of the “Control Panel” 

Pane: 1) “Plot Items,” 2) “View,” and 3) “Information” (as shown in Figure 3.1). The “Plot Item” 

sub-pane is used to build plots by adding items to the view and specifying their appearance 

using the available options. The “View” sub-pane provides tools for manipulating the view 

(e.g., rotation, magnification, and position). The “Information” sub-pane displays information 

(e.g., location and ID) pertaining to items in the current plot when the cursor is positioned 

over a specific item in the view. The “Plot Items” and “View” sub-panes are each divided into 

two sections that can be independently minimized. Each sub-pane set can be displayed or 

hidden using the control buttons on the toolbar (shown in Figure 3.21).  

 

Figure 3.21. Sub-pane control buttons on the toolbar 

3.4.1. Plot Items 

Each plot file may consist of several plot items. In MINEDW, plot items are 2-D or 3-D 

representations of node or element properties and model output such as particle tracks and 

mk:@MSITStore:C:/Program%20Files/Itasca/Flac3d400/flac3d400help.chm::/toolbar.html
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open-pit seepage. As shown in Figure 3.22 (the MINEDW interface), the “Plot Items” sub-pane 

contains two sections. The upper section shows the list of plot items, and the lower section 

offers the option of displaying the attributes (“Attributes”) or selecting other plot items to be 

displayed (“List”). When a plot item is highlighted, the attributes associated with that item 

become active. The plot item can be activated (made visible) or deactivated (made invisible) 

by clicking the ellipse icon to the left of the plot item. Additionally, right-clicking on a plot 

item brings up a menu that allows the user to activate, deactivate, or delete a plot item from 

a plot file. 

 

Figure 3.22. The MINEDW main interface 

The “Plot Items” sub-pane contains three groups, differentiated by color as shown in Figure 

3.23. The first group, which is in blue, contains three special plot items, 1) “Legend,” 2) 

“Display Settings,” and 3) “Global Settings.” These three plot items are included for all plots. 

The second group, which is in black, consists of 1) “Axes,” 2) “Observation,” 3) “Boundary 

Conditions,” 4) “Element,” 5) “File Data,” 6) “Node,” and 7) “Post Processing.” Each item in the 

second group can be added to a plot. The third group of plot items, which is in green, contains 

“Cutting Planes” and “Clip Box.” The plot items in the third group can be added to a plot to 

create different cross-section views through the model domain. 
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Figure 3.23. MINEDW plot items 

3.4.1.1. Legend 

“Legend” is a local copy of the legend’s settings that are in effect for the current plot. The 

legend is displayed on the Legend Pane. On top of the Legend Pane is the MINEDW version 

and time stamp when the plot was created. There are two alternatives for setting the legend: 

• Alternative 1 is to set legend attributes before the creation of a plot file. Legend 
attributes of this alternative are set through the “Options” dialog box under the “Tools” 
menu on the Main Menu banner. The attributes from Alternative 1 will apply to all 
new plot files. 

• Alternative 2 is to set the legend attributes for the currently displayed plot file in the 
Control Panel Pane. Legend attributes from this alternative only apply to the currently 
selected plot file and will not affect other plot files or new plot files that will be 
created.  

The attributes associated with legends are described below: 

Placement: Sets the position of the Legend Panel to one of three preset options: 1) “Left” (side 
of View Pane), 2) “Right” (side of View Pane), or 3) “Floating” (inside the View Pane).  

Width: Sets the width of the legend as a percentage of the View Pane containing the plot. The 
minimum value of width is 25. The width can be increased for all three placement 
options of the Legend Panel. 

Height: Sets the height of the Legend Panel as a percentage of the View Pane containing the 
plot. This setting is only applicable if the “Placement” attribute is set to “Floating.” 

Position: Specifies the left-side position and bottom position of the plot item as a percentage 
of the available rendering area. It uses a scale of 0 to 100, in which 0 indicates the 
bottom-left corner and 100 indicates the top-right corner. Continuous adjustment of the 
upward vertical position once the top of the Legend Panel reaches the top of View Pane 
will reduce the height of the Legend Panel. The “Position” setting is only applicable if the 
legend “Placement” attribute is set to “Floating.”  

Legend 
Display Settings 
Global Settings 
Axes 
Observation 
Boundary Conditions 
Element 
File Data 
Node 
Post Processing 
Cutting Planes 
Clip Box 
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Outline: Sets the visibility, color, and thickness of the plot item’s outline. 

Heading: Sets the color of the legend heading. 

Copyright: Sets the color of the copyright notice in the legend. 

View Info: Sets the visibility of the current view orientation report in the legend. The report 
can include the following items—each of which can be selected individually for 
inclusion in the view info in the legend—“Center,” “Eye,” “Dip/DD/Roll,” “Normal,” 
“Radius,” and “Projection.” Sub-controls for each of the items are provided for specifying 
the size, font, style, and color of the text used. 

Step: This option is inactive in MINEDW. 

Time: Sets the visibility of the time in the legend. The time used is that at which the view was 
last modified. The sub-controls provided can specify the size, font, style, and color of the 
text used to display the time in the legend. 

Customer Title: This option is not active in MINEDW. 

On the “Attributes” tab for the “Legend” item, the legend settings for each of the plot items 

that the user has added to the current plot are also listed beneath the “Customer Title” 

attribute. The controls provided can add or remove the plot item from the legend and specify 

the size, font, style, and color of the text. In the case of plot items that have multiple sub-parts, 

such as contours or units, the user can add or remove the individual sub-labels from the 

legend.  

3.4.1.2. Display Settings 

“Display Settings” is a local copy of the display settings that are in effect for the plot items 

currently selected. There are two alternatives for setting display: 

• Alternative 1 is to set display attributes before the creation of a plot file. Display 
attributes of this alternative are set through the “Options” dialog box under the “Tools” 
menu on the Main Menu banner. The attributes from Alternative 1 will apply to all 
new plot files. 

• Alternative 2 is to set the display attributes for the currently displayed plot file in the 
Control Panel Pane. Display attributes from this alternative only apply to the 
currently selected plot file and will not affect other plot files or new plot files that will 
be created. 

The attributes available under “Display Settings” and their descriptions are presented below: 

Name: Indicates the name of the active view. For all views except the Base View, this control 
can be used to name or rename the current view. 

Active: Controls whether the view is active or inactive. 

Auto Update: Sets the option of whether to auto-update the view while cycling (this is enabled 
via a checkbox). The interval for updating is found under the “Global Settings” plot item 
because the interval is the same for all auto-updating views. 

Background: Sets the background color of the view. 
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Outline: Sets the visibility, color, and thickness of the item’s outline. 

Job Title: This option is inactive in MINEDW. 

View Title: Sets the visibility of the title. The sub-controls provided can specify the size, font, 
style, color, and title displayed in the plot. 

Target: This option is inactive in MINEDW. 

Movie: This option is inactive in MINEDW. 

3.4.1.3. Global Settings 

“Global Settings” is a local copy of the global settings that are in effect for the current plot. The 

options can be set in the “Plot Items” sub-pane or via the “Options” dialog box found under the 

“Tools” menu on the Main Menu banner. Changing the settings on the current plot also sets 

them in the “Options” dialog box and subsequently affects all plot files because these changes 

are applied globally. The attributes available under “Global Settings” and their descriptions 

are listed below. 

Vertex Arrays: Specifies whether vertex arrays are used to draw objects in Open Graphics 
Library. The default setting is “on.” When using older OpenGL display drivers, disabling 
this attribute can improve images sometimes. Note that disabling this attribute implies 
that the vertex buffer objects are also turned off. 

Vertex Buffer Objects: Determines whether the vertex buffer object OpenGL extension is used 
(if available). The default setting is “on.” Note that disabling this attribute can improve 
images when using display drivers that presently report this extension but do not 
properly support it. 

Interactive1: This option is inactive in MINEDW. 

Interactive2: This option is inactive in MINEDW. 

Picking: This option is inactive in MINEDW. 

Sketch Mode: Renders the item using a reduced (rather than full) rendering method, which 
can accelerate response in certain rendering situations (e.g., model rotation). 

Update Interval: This option is inactive in MINEDW. 

Print Size: Sets the width and height of the output sent to a printer or to a bitmap file. 

DXF Warning: Option to display the warning about styling when a .DXF file is exported. 

VRML Warning: Option to display the warning about styling when a .VRML file is exported. 

Movie: This option is inactive in MINEDW.  

The second group in the “Plot Items” sub-pane consists of “Axes,” “Observation,” “Boundary 

Conditions,” “Element,” “File Data,” “Node,” and “Post Processing” (shown in MINEDW and 

Figure 3.23 in black), which can be added to the plot items. These are discussed in more detail 

in the following sections. 

mk:@MSITStore:C:/Program%20Files/Itasca/Flac3d400/flac3d400help.chm::/options.html
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3.4.1.4. Axes 

The “Axes” plot item is an interactive orientation indicator that can be displayed as x-, y-, and 

z-axes or as compass points (easting and northing). The attributes available for axes and their 

descriptions are given below. 

AutoConf: Sets the axes display as either x-, y-, and z-axes or as compass points (easting and 
northing) by clicking the icons shown. 

X-Axis: The x-axis display with sub-controls for specifying color, draw (in positive, negative, 
or both directions), “+” label, and “-” label (the axis label in positive and negative 
directions). 

Y-Axis: The y-axis display with sub-controls for specifying color, draw (in positive, negative, 
or both directions), “+” label, and “-” label (the axis label in positive and negative 
directions). 

Z-Axis: The z-axis display with sub-controls for specifying color, draw (in positive, negative, 
or both directions), “+” label, and “-” label (the axis label in positive and negative 
directions). 

Fixed: When enabled, this control fixes the axes to a location on the screen. Use the “Screen” 
attribute to specify the position. When disabled, this control positions the axes in model 
space. 

Scale: Specifies a size in percentage units when the axes are fixed. 

Screen: Specifies the x and y position of the axis center in percentage units  
(0, 0 = bottom left; 100, 100 = top right) when the axes are fixed. 

Size: Specifies the axes size in model units when the axes are not fixed. 

Position: Places the origin of the axis at the x-, y-, and z-position (in model units) specified 
when the axes are not fixed. 

Font: Specifies the font, size, and style (e.g., normal, bold, italic) used by the plot item. 

Transparency: Specifies the plot item’s transparency (70–100). When transparency is toggled 
off, the point and its label are displayed in opaque state. 

Caption: When enabled, this control shows the plot item (labeled, described, and enumerated 
as needed) in the plot legend. The sub-attributes provided are dynamic and contingent 
on the plot item and its display requirements in the legend. At a minimum, all captions 
have a “Title” sub-attribute. 

3.4.1.5. Observation  

The “Observation” plot item includes the display settings for observation wells such as stand 

pipe with screen (Borehole in Observation) and grouted-in vibrating piezometers (Piezo in 

Observation). For Piezo, the location of the transducer can also be displayed (Transducer in 

Observation). The display attributes available for observation wells and their descriptions 

are given below. 

Map: This attribute positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
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standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) translate (or offset), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. These attributes are generally not required to change if the coordinates of the 
observation points are the same as other plot items of the plot file. 

Colors: Specifies the number of colors to use on the plot. Includes sub-attributes that 
enumerate the indexed items to enable specification of color by item. Observation wells 
are colored by borehole, piezometer, and transducer. 

Line: Sets the thickness and style of the line(s) used to represent the screen interval of the 
observation well or piezometer. 

Scale: Specifies a size in percentage units when the axes are fixed. 

Text: Displays the labels of the observation wells. By toggling the arrow, the label can be 
displayed or hidden. 

Transparency: Specifies the plot item’s transparency (70–100). When transparency is toggled 
off, the point and its label are displayed in opaque state. 

Caption: When this control is selected, the plot item is shown (labeled, described, and 
enumerated as needed) in the plot legend. The sub-attributes provided are dynamic and 
contingent on the plot item and its display requirements in the legend. At a minimum, 
all captions have “Title” or “Line” and “Color” sub-attributes. In the case where the 
Legend Pane is occupied by the legend of other plot items (such as hydrogeologic units), 
the user can disable the display of selected plot items (such as “Element” or “Node”) to 
see the caption attributes of the “Observation” plot item. 

Toggle Well: Provides a list of each observation well that is included in the plot. Individual 
observation wells can be removed from the View Pane. This function allows the user to 
include some or all observation wells when exporting a .DXF file from MINEDW. 

Section Distance: This feature is used in conjunction with a cross-section view. It allows the 
user to specify which observation locations to display by using a distance. For example, 
if a user creates a cross section and wishes to display observation locations within 100 
meters of the cross-section plane, they would enter “100” in the box next to the attribute 
label if the coordinate system used in the model is in meters. 

3.4.1.6. Boundary Conditions 

The “Boundary Conditions” plot item includes the display settings for boundary conditions. 

The boundary conditions include “Constant Head & Drain,” “Pumping Well,” “River,” and 

“Variable Flux.” The display attributes available for boundary conditions and their 

descriptions are given below. Detailed information about the boundary conditions can be 

found in Section 7.4. 

Constant Head & Drain 

Map: This attribute positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) translate (or offset), which specifies values for x, y, and z plot-item 
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position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. These attributes are generally not required to change if the coordinates of the 
constant head or drain are the same as other plot items of the plot file. 

Scale: Specifies the size of the plot item. 

Groups: Constant-head boundary nodes can be grouped to represent a specified 
hydrogeologic component, such as a surface-water body, an underground drift, or a 
pumping well. Each group of constant-head nodes can be presented in a different color 
in MINEDW.  

Text: This attribute sets the font style, text size, and text style of the labels of the boundary 
conditions displayed in the View Pane. 

Transparency: Specifies the plot item’s transparency (70–100). The minimum value for 
transparency setting is 70. When the transparency is toggled off, the plot item is 
displayed in opaque state. 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Line” and “Color” sub-attributes. In the case where the Legend Pane is 
occupied by the legend of other plot items (such as hydrogeologic units), the user can 
disable the display of selected plot items (such as “Element” or “Node”) to see the caption 
attributes of the “Boundary Conditions” plot item. 

Maximum Flux: By specifying a value, the user can specify the upper limit of flux values to 
display. Flux values larger than the specified value will not be displayed. 

Excluded Flux: By specifying a value, the user can exclude certain flux values from display.  

Dynamic: This option only applies to “Constant Head & Drain” boundary conditions and is 
used to visualize boundary conditions that become active/inactive at different times 
through the model simulation. 

Pumping Well 

There are three types of pumping wells in MINEDW: 

1. Rate: The well is simulated with the assigned pumping rate. 

2. Head: The well is simulated as a specified head and the pumping rate is derived from 
the model simulation. 

3. LPE: The well is simulated with the assigned lowest pumping elevation (LPE). If the 
simulated water level of the well reaches the LPE, the active pumping will be switched 
to passive draining to prevent the drying up of the well and pump. 

 

Map: Same as in “Constant Head & Drain.” 

Color: Each type of pumping well is presented in a different color. Deselecting a specific type 
will remove that type of well from the View Pane and Legend Pane. 

Line: Sets the thickness and style of the lines used to represent the well depth. 
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Scale: When the “Scale” box is checked, increasing the scale value will increase the size of the 
dot of each well. Unchecking the “Scale” box will display the default size of the dot.  

Text: Same as in “Constant Head & Drain.” 

Transparency: Same as in “Constant Head & Drain.” 

Caption: Same as in “Constant Head & Drain.” 

Toggle Well: This feature is used to toggle the display of each well.  

Section Distance: This feature is used in conjunction with a cross-section view and only 
applies to the “Pumping Well” plot item. It allows the user to specify which pumping well 
to display by using a distance in model units. For example, if a user creates a cross 
section and wishes to display pumping wells within 100 meters of the cross-section 
plane, they would enter “100” in the box next to the attribute label.  

Variable Flux 

Map: Same as in “Constant Head & Drain.” 

Scale: Same as in “Constant Head & Drain.” 

Transparency: Same as in “Constant Head & Drain.” 

Caption: Same as in “Constant Head & Drain.” 

Flux View: Same as in “Constant Head & Drain.” 

File: Same as in “Constant Head & Drain.” 

Minimum Flux: Same as in “Constant Head & Drain.” 

Maximum Flux: Same as in “Constant Head & Drain.” 

Excluded Flux: Same as in “Constant Head & Drain.” 

3.4.1.7. Element 

The “Element” plot items include 2-D and 3-D plot items that can be used to display 

hydrogeologic properties of elements. These properties include geologic zones, recharge, 

evaporation, hydraulic properties, and time-varied conductivity. “Element” plot items also 

include the “Pinch-Out” plot item, which can be used to view and assign pinch-outs in the 

model. 

2D Plane: Displays element information for the geologic zone (“Zone”), recharge (“Recharge”), 
or evaporation (“Evaporation”) in 2-D plane view. 

3D Element: Displays element information for the hydrogeologic zone in 3-D. 

Pinch-Out: Allows the user to create areas of refined vertical discretization and display these 
areas.  

Properties: Displays hydraulic properties (Kx, Ky, Kz, Sy, and Ss) in 3-D. 

Time-Varied Conductivity: Displays the ZOR created for an open pit or cave zone for 
underground mining in the “Mining” menu. 

The attributes related to these plot items are described below. 



3. MINEDW INTERFACE 
 

 

MINEDW  27 

 

2D Plane 

Color By: Specifies which attribute is used for the plot. The attributes include “Zone,” 
“Recharge,” and “Evaporation.” 

Layer: Indicates which layer of the model to display on the plot.  

Map: This attribute positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Colors: Allows the user to specify the colors to be used in the plot. This attribute also allows 
the user to select which items they wish to display in the plot by activating the checkbox 
next to the item.  

Fill: Specifies whether polygons rendered by a plot item should be filled. 

Wireframe: Specifies whether the plot item should be displayed with a wireframe and 
determines the color and the line thickness of the displayed wireframe. 

Wire Trans.: Not active. 

Cull Backface: Specifies whether backface culling is enabled. When set to “On,” the backfaces 
of polygons are not rendered (it is often necessary to disable this function to see the far 
side of some cut-plane plots).  

Lighting: Option to turn lighting on or off. Lighting provides depth to the plot item because it 
creates natural shadows.  

Offset: Specifies settings for the OpenGL polygon offset. If the polygons are rendered poorly, 
then setting these values close to zero might improve performance. The first value 
specifies a scale factor to create a variable-depth offset for each polygon; the second 
value creates a constant-depth offset. 

Cutline: Specifies the line thickness of lines plotted on a cutting plane, with a range of 1 to 10.  

Cutplane: This option is only active when a cutplane plot item is added to the plot view. The 
options for “Cutplane” are “On,” “Front,” and “Back,” which turn on the cutplane, make 
the model domain on the front of the cutplane visible, and make the model domain on 
the back of the cutplane visible, respectively. In order to show the entire plane, the “Cull 
Backface” option should be unchecked. 

Clip Box: Specifies which of the clip box items available in the current view to apply to the 
current plot item. This option is only active when a clip box plot item is added to the 
plot view.  

Transparency: Specifies the plot item’s transparency (70–100). When unchecked, the plot 
item is displayed in opaque state. 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 
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3D Plane 

Layer: Same as in “2D Plane.” 

Map: Same as in “2D Plane.” 

Zones: Allows the user to specify which of the geologic zones are visible in the plot. 

Fill: Same as in “2D Plane.” 

Wireframe: Same as in “2D Plane.” 

Wire Trans.: Same as in “2D Plane.” 

Cull Backface: Same as in “2D Plane.” 

Lighting: Same as in “2D Plane.” 

Offset: Same as in “2D Plane.” 

Cutline: Same as in “2D Plane.” 

Cutplane: Same as in “2D Plane.” 

Clip Box: Same as in “2D Plane.” 

Transparency: Same as in “2D Plane.” 

Caption: Same as in “2D Plane.” 

Pinch-Out 

Map: Same as in “2D Plane.” 

Colors: Change the color of each pinch-out zone. 

Fill: Same as in “2D Plane.” 

Wireframe: Same as in “2D Plane.” 

Wire Trans.: Same as in “2D Plane.” 

Cull Backface: Same as in “2D Plane.” 

Lighting: Same as in “2D Plane.” 

Offset: Same as in “2D Plane.” 

Cutline: Same as in “2D Plane.” 

Cutplane: Not active. 

Clip Box: Not active. 

Transparency: Same as in “2D Plane.” 

Caption: Same as in “2D Plane.” 

Properties 

Color By: Select a hydraulic parameter for display. 

Layer: Same as in “2D Plane.” 

Map: Same as in “2D Plane.” 
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Contour: Provides sub-attributes for controlling contour display. These are 1) “Ramp,” which 
defines the color ramp to use (grayscale, rainbow, etc.); 2) “Maximum,” which specifies 
(or automatically calculates) the maximum value (right-hand end of the ramp); 3) 
“Minimum,” which specifies (or automatically calculates) the minimum value (left-hand 
end of the ramp); 4) “Interval,” which specifies (or automatically calculates) the interval 
between colors on the ramp; 5) “Reversed,” which inverts the display of the maximum 
and minimum values relative to the ramp; 6) “Below,” which specifies (or automatically 
selects) the color to use for displaying values that are less than those specified by 
“Minimum”; and 7) “Above,” which specifies (or automatically selects) the color to use 
for displaying values that are greater than those specified by “Maximum.” This attribute 
is only available for the “Properties” plot item. 

Fill: Same as in “2D Plane.” 

Wireframe: Same as in “2D Plane.” 

Wire Trans.: Same as in “2D Plane.” 

Cull Backface: Same as in “2D Plane.” 

Lighting: Same as in “2D Plane.” 

Offset: Same as in “2D Plane.” 

Cutline: Same as in “2D Plane.” 

Cutplane: Same as in “2D Plane.” 

Clip Box: Same as in “2D Plane.” 

Transparency: Same as in “2D Plane.” 

Caption: Same as in “2D Plane.” 

Time-Varied Conductivity 

Map: Same as in “2D Plane.” 

Colors: Change the color of each pinch-out zone. 

Fill: Same as in “2D Plane.” 

Wireframe: Same as in “2D Plane.” 

Wire Trans.: Same as in “2D Plane.” 

Cull Backface: Same as in “2D Plane.” 

Lighting: Same as in “2D Plane.” 

Offset: Same as in “2D Plane.” 

Cutline: Same as in “2D Plane.” 

Cutplane: Same as in “2D Plane.” 

Clip Box: Same as in “2D Plane.” 

Transparency: Same as in “2D Plane.” 

Caption: Same as in “2D Plane.” 
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3.4.1.8. File Data 

The “File Data” item contains options for importing source files that were not generated by 

the MINEDW program. These options are described below. 

BLN (Boundary Line File) 

The “BLN” (boundary line) plot item is used to import and display a .BLN file. The attributes 

available for “BLN” and their descriptions are provided below. 

File: Clicking on the plus sign (+) opens the “Select BLN file” dialog box. Once loaded, the file 
name is shown in this attribute. 

Project to Surface: Projects the BLN lines to the ground surface. 

Map: This attribute positions, scales, and orients a plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Colors: Specifies the color of the BLN lines. 

Line: Specifies the thickness of the BLN lines. 

Text: Specifies the font used for labels.  

Transparency: Specifies the plot item’s transparency (0 = solid, 100 = invisible). 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

DXF (Drawing Exchange Format) 

This plot item is used to import and display a .DXF file in the View Pane. The attributes 

available for this option and their descriptions are provided below. 

File: The plus sign (+) available for this attribute can be used to display a “Select DXF data file” 
dialog box for selecting the .DXF file to load. Once loaded, the file name is shown in this 
attribute. 

Layers: Indicates the number of layers in a .DXF plot item and provides sub-attributes to 
control the visibility and color for each layer in the .DXF. 

Map: This control positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 
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Faces: Provides controls for rendering the faces of the plot item, including fill, wireframe, 
wireframe transparency, cull backface, lighting, offset, and cutline. 

Cut Faces: Specifies the thickness and style used to render the outline of faces on the plot item. 
A plane should be generated before the operation of this attribute. 

Cutplane: Specifies which of the cutplanes available in the current view to apply to the current 
plot item. A plane should be generated before the operation of this attribute. 

Clip Box: Specifies which of the clip box items available in the current view to apply to the 
current plot item. 

Transparency: Specifies the plot item’s transparency (0 = solid, 100 = invisible). 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

To Zone: Selects elements contained within a 3-D .DXF object based on the criteria selected 
by the user and assigns them to the selected group (options are “To Zone,” “Select With,” 
“Element Selected When Including,” and “Layer Thickness”). 

To Data File: Saves the .DXF file to a text file format that can be used for creating an open-pit 
mine plan. 

ESRI Shapefile (SHP)  

This plot item is used to import a shapefile (.SHP), a common ArcGIS© file format, to the 

current view. A shapefile is a popular geospatial vector data format for geographic 

information systems software. Shapefiles spatially describe geometries—points, polylines, 

and polygons. A shapefile is actually a group of several files, three of which are required to 

form a valid set. A valid shapefile set contains at least a main file (.SHP), a dBASE file (.DBF), 

and an index file (.SHX). The main file contains spatial information about features (e.g., 

coordinates along a line or polygon), the dBASE file contains a table of attributes related to 

those spatial features (e.g., the name of a feature or some measurement taken at a feature), 

and the index file indexes the byte-location of features within a .SHP file. The attributes 

available for this option and their descriptions are provided below.  

File: Use the plus sign (+) available for this attribute to display the “Select SHP file” dialog box 
to select which .SHP files to load. Once loaded, the file name is shown in this attribute. 

Attribute Table: Displays the contents of the dBASE file. A dBASE file contains a table of 
attributes associated with the features defined in a shapefile.  

Coordinate Info: Displays the contents of a .PRJ file (a .PRJ shapefile is not related to the .PRJ 
file created by MINEDW). A .PRJ file contains information about the coordinate system 
and projection in which the shapefile features are defined. A .PRJ file may or may not be 
present.  

Group by: Specifies an attribute of the dBASE file with which to group features. Each group is 
given a unique color and label in the legend and view. To display all features as separate 
entities, select the last item (Record ID) from the drop-down menu.  
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Label by: Specifies an attribute of the dBASE file by which to label features within the view. 
Because an apparently single feature may be defined in a shapefile as several features 
(e.g., a line composed of line segments), duplicate labels may appear. 

Project to Surface: Projects the .SHP file to the ground surface. 

Symbol: Specifies the symbol to represent the data. 

Scale: Specifies the size of the symbol. 

Colors: Specifies the colors of features in the shapefile. 

Line: Specifies line thickness of the data. 

Map: This control positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Text: Specifies the font used for labels. 

Transparency: Specifies the plot item’s transparency (70–100). The lowest value for 
transparency is 70. When unchecked, the plot item is displayed in opaque state. 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

Point Data  

This plot item is used to display x, y, and z data as points. The attributes available for this 

option and their descriptions are given below. 

File: Use the plus sign (+) available for this attribute to display the “Select Data File” dialog 
box to select which .DAT files to load. Once loaded, the file name is shown in this 
attribute. 

Project to Surface: Projects the .DAT file to the ground surface. 

Text: Specifies the font used for labels. 

Map: This control positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Scale: Specifies the size of the symbol. 

Colors: Specifies the color of the points. 

Transparency: Specifies the plot item’s transparency (0 = solid, 100 = invisible). 
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Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

3.4.1.9. Node 

The “Node” plot item includes 2-D and 3-D plots that are related to properties of finite-

element nodes. These properties include nodal elevation, groundwater head, pore pressure, 

drawdown at a given time, and head difference for two different dates in both 2-D and 3-D. 

2D Contour: Displays groundwater head, pressure, elevation, head difference, water table, 
and drawdown in 2-D. 

3D Contour: Displays groundwater head, pressure, elevation, and head difference in 3-D. 

Isoline: Displays isolines for elevation, pore pressure, head, head difference, water table, and 
drawdown.  

IsoSurface: Displays isosurfaces for elevation, head, pore pressure, and head difference.  

The attributes related to these four plot items are described below. 

2D Contour and 3D Contour 

Color By: Specifies which attribute is used for the plot. 

Layer: Specifies which layer of the model is displayed on the plot. 

Map: This attribute positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Contour: Provides sub-attributes for controlling contour display. These are 1) “Ramp,” which 
defines the color ramp to use (grayscale, rainbow, etc.); 2) “Maximum,” which specifies 
(or automatically calculates) the maximum value (right-hand end of the ramp); 3) 
“Minimum,” which specifies (or automatically calculates) the minimum value (left-hand 
end of the ramp); 4) “Interval,” which specifies (or automatically calculates) the interval 
between colors on the ramp; 5) “Reversed,” which inverts the display of the maximum 
and minimum values relative to the ramp; 6) “Below,” which specifies (or automatically 
selects) the color to use for displaying values that are less than those specified by 
“Minimum”; and 7) “Above,” which specifies (or automatically selects) the color to use 
for displaying values that are greater than those specified by “Maximum.” 

Fill: Specifies whether polygons rendered by a plot item should be filled. 

Line: Sets the thickness and color of the lines used to represent the plot item. The attribute is 
only available for the Isoline plot item. 

Wireframe: Specifies whether the plot item should display with a finite-element mesh 
wireframe as well as the color and the line thickness of the wireframe. 
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Wire Trans.: Specifies the wireframe’s transparency (0 = solid, 100 = invisible). 

Cull Backface: Specifies whether backface culling is enabled. When this setting is enabled, the 
backfaces of polygons are not rendered (it often is necessary to turn off this feature to 
see the far side of some cutplane plots). 

Lighting: Enables the lighting. 

Offset: Specifies settings for the OpenGL polygon offset. If the polygons are rendered poorly, 
then setting these values close to zero might improve performance. The first value is a 
factor that specifies a scale factor to create a variable-depth offset for each polygon; the 
second value is used to create a constant-depth offset. 

Cutline: Specifies the line thickness of lines plotted on a cutting plane. 

Cutplane: Option for displaying the model domain in front of or behind (or both) a cross-
section plane. This option is useful when orienting the cross-section plane. 

Clip Box: Specifies which of the clip box items available in the current view to apply to the 
current plot item. 

Transparency: Specifies the plot item’s transparency (70–100). The lowest value for 
transparency is 70. When unchecked, the plot item is displayed in opaque state. 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

Isoline 

The attributes of “Isoline” are the same as those described in the “2D Contour/3D Contour” 
section with the exception of following: 

Cutplane: Though a cutplane is not very meaningful for “Isoline,” a user can generate a plane 
through the “Cutplane” option from “List.” 

Clip Box: This operation is functional but does not provide meaningful display.  

Isosurface  

The attributes of “Isosurface” are the same as those described in the “2D Contour/3D Contour” 
section with the exception of “Cutplane.” A cutplane can only be created through the 
“Plane” option under “Cutting Planes” in “List.” 

 

 

 

3.4.1.10. Post Processing 

Particle Tracking: Displays particle-tracking results (Section 9.4). 
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Pit Flux: This option can be used to display the seepage that occurs at the pit wall, which is 
recorded by MINEDW during the model simulation in the file with a .SEP extension 
(Section 9.6). 

Particle Tracking 

To operate the attributes related to particle tracking, a particle-tracking result should be 

inputted as a MINEDW plot item. The attributes related to the “Particle Tracking” plot item 

are described below. 

File: The icon next to the “File” attribute opens a dialog box that is used to import particle 
tracks.  

Arrow Scale: This attribute controls the size of the arrow displayed on the particle tracks that 
indicate direction. It does not apply to the last time step. 

ColorByMag: The magnitude of the velocity along the displayed particle tracks can be shown 
by using this attribute. This attribute allows the selection of a number of color ramps 
and allows the “Maximum,” “Minimum,” and “Interval” to be defined. It does not apply to 
the last time step. 

Map: This attribute positions, scales, and orients the plot item via the sub-attributes. Sub-
attributes include 1) axes, which specify a coordinate substitution to use assuming a 
standard order of “x, y, z” (“xzy,” for instance, indicates that the y and z coordinates are 
to be swapped); 2) offset (or translate), which specifies values for x, y, and z plot-item 
position offsets; and 3) scale, which multiplies the coordinate system by the specified 
value. 

Colors: This attribute can be used to control the display color of particle tracks.  

Line: Sets the thickness and style of the lines used to represent the “Particle Tracking” plot 
item.  

Transparency: Specifies the plot item’s transparency (0 = solid, 100 = invisible). 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Colors” and “Label” sub-attributes. 

Scale: Controls the size of the displayed seepage point. 

Colors: This attribute can be used to control the display color of seepage points. 

Transparency: The same as in “Particle Tracking.” 

Caption: The same as in “Particle Tracking.” 

Flux View: This option enables the display of flux values from the “Pit Flux” boundary 
conditions using both color and marker size to represent the relative magnitudes of flux. 

File: The icon next to the “File” attribute opens a dialog box that is used to import a pit-flux 
file. 

Minimum Flux: Sets the minimum absolute flux value to display using the “Pit Flux” boundary 
condition. 
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Maximum Flux: Sets the maximum absolute flux value to display using the “Pit Flux” boundary 
condition. 

 Excluded Flux: Option to enable the display of flux values outside of the specified minimum 
and maximum flux values. 

3.4.1.11. Cutting Planes 

The third “Plot Items” group consists of “Cutting Planes” and “Clip Box.” “Cutting Planes,” 

contains “Plane,” “Wedge,” and “Octant.” Both “Cutting Planes” and “Clip Box” are displayed in 

green in MINEDW. These items are similar to plot items (and are handled as plot items) in 

that they are independent objects appearing in the plot. They are distinct from plot items in 

that they are applied to one or more plot items for the purpose of visualization and, as such, 

are dependent on plot items. For example, a cutplane can be defined as part of a plot, but until 

it is applied to at least one plot item, its rendering is incomplete and is not visible in the View 

Pane. 

The “Cutting Planes” group contains three items: 1) “Plane,” 2) “Wedge,” and 3) “Octant.” The 

function of each item is described below: 

Plane: The plane can be applied to plot items to “slice” them into 2-D. A plane is manipulated 
using its “Origin,” which can be repositioned to move the cutplane, and the visible 
surface of the plane itself can be rotated in the View Pane to view different aspects of 
the plane. 

Wedge: The wedge cutplane can be applied to plot items to “slice” the model into a wedge 
shape that is defined by two planes joined along an origin. The plane is manipulated 
using its “Origin,” which can be changed to reposition the location of the cutplane.  

Octant: The octant cutplane provides a cubical cutplane that can be applied to plot items to 
“slice” them in three orthogonal directions simultaneously. The plane is manipulated 
using its “Origin,” which can be repositioned. The visible surface of the plane itself can 
be dragged to rotate the plane three-dimensionally. 

The attributes available for cutting planes and their descriptions are given below. 

Plane 

Name: Sets or indicates the name of the cutplane. This name is used to label the cutplane as 
it is listed in the “Plot Items” list, on the “Cutplane” selector in the attribute list for all 
plot items (under the “Cutplane” attribute), and in the legend (if its “Caption” attribute 
is enabled). 

Origin: The origin of the plane. 

Normal (1, 2, 3): Defines the orientation of the indicated cutplane via a normal vector.  

Dip/DD (1, 2, 3): Sets the dip and dip direction, respectively, of the selected plane. There are 
two of these controls on a wedge and three on an octant; they are labeled with numerals 
(e.g., 1, 2, 3). 
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Snap View: Snaps the view to a perpendicular orientation so that the user sees the side of the 
plane. One click will display normal orientation; the second click will display the view 
in reverse orientation. 

Move Normal: Moves the cutting plane along the normal direction. The user can enter the 
interval of each move or use the default value. 

Target: This attribute is not used in “Move Normal.” 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
“Title” or “Line” and “Color” sub-attributes. 

Wedge 

Name: Same as in “Plane.” 

Origin: The origin of the wedge plane. 

Normal 1: Defines the orientation of one side of the wedge plane via a normal vector. 

Dip 1/DD 1: Sets the dip and dip direction of one side of the wedge plane. 

Snap View: Same as in “Plane” for one plane of the wedge. 

Normal 2: Defines the orientation of the other side of the wedge plane via a normal vector. 

Dip 2/DD 2: Sets the dip and dip direction of the other side of the wedge plane. 

Snap View: Same as in “Plane” for the other plane of the wedge. 

Wedge Angle: Sets the angle of the wedge cutting plane. 

Caption: Same as in “Plane.” 

Octant 

The attributes of “Octant” are the same as in “Wedge” with the following exceptions: 

1. There are three attributes of “Normal,” “Dip/DD,” and “Snap View.” 

2. There is no “Wedge Angle.” 

3.4.1.13. Clip Box 

When applied to a plot item, the “Clip Box” control constrains the display of the plot item 

according to its size, position, and orientation. It is similar to a cutplane in that it is applied to 

plot items and, although a view can have multiple clip boxes in it, only one clip box can be 

applied to a given plot item at a time. Both a cutplane and clip box can be applied to a plot 

item simultaneously. The attributes available for the “Clip Box” controls and their 

descriptions are given below. 

Name: Sets or indicates the name of the clip box. This name is used to label the clip box as it 
is listed in the “Plot Items” list, on the “Clip Box” selector in the attribute list for all plot 
items (under the “Clip Box” attribute), and in the legend if its “Caption” attribute is 
enabled. 
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Center: Sets the position of the plot item’s center in model units. 

Dip: Sets the dip of the clip box. 

Dip Dir: Sets the dip direction of the clip box. 

Clip Axis (1, 2, 3): Activates a specified axis that will determine the direction of clipping. If “Clip 
Axis 1” is selected, clipping only occurs along the x direction. 

Axis Radii: Specifies the radius of clip axis 1, clip axis 2, and clip axis 3, respectively, away 
from the current center. 

Axis Offsets: Specifies the offset from the center of each of the three axes. 

Interactive: This option is not active in MINEDW. 

Caption: When enabled, the plot item is shown (labeled, described, and enumerated as 
needed) in the plot legend. The sub-attributes provided are dynamic and contingent on 
the plot item and its display requirements in the legend. At a minimum, all captions have 
a “Title” sub-attribute. 

3.4.2. View 

The “View” sub-pane of the “Control Panel” Pane (Figure 3.24) is discussed in this section. As 

shown in Figure 3.24, the “View” sub-pane is divided into two sections that can be minimized 

independently and provides tools for manipulating (i.e., rotating, magnifying, positioning) the 

view. The functions available in the “View” sub-pane are shown in Figure 3.24 and are 

described below. 

 

Figure 3.24. A “View” pane and sub-panes 

3D Rotate: Use the roller tool to rotate the view in 3-D. 
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Reset View: Re-centers the model in the View Pane and zooms to the model extent. 

Slide Vertical Translation: Change the vertical translation by dragging the slider in the desired 
direction. 

Slide Rotation: Change the rotation by dragging the slider in the desired direction; rotation is 
normal (perpendicular) to the screen. 

Slide Horizontal Translation: Change the horizontal translation by dragging the slider in the 
desired direction. 

Slide Magnification: Change the magnification level by dragging the slider in the desired 
direction. 

Eye: Reports the x, y, and z positions of the “Eye” in model coordinates. Enter the desired 
values in the boxes and press the [Enter] key to “snap” the view as specified. 

Center: Reports the x, y, and z positions of the view center in model coordinates. Enter desired 
values in the boxes and press the [Enter] key to snap the view as specified. 

Rotation: Reports the dip, dip direction, and roll of the current View Pane in model 
coordinates. Enter desired values in the boxes and press the [Enter] key to snap the 
view as specified. 

Scale: Describes the view’s radius (extent from view center to view edge), eye distance, and 
magnification (respectively, from left to right). Radius and magnification both affect the 
apparent magnification of the view; however, radius uses a fixed angle for model 
perspective; thereby, reducing the value makes the model appear closer, and increasing 
the value makes the model appear farther away. In both cases, the eye position is moved 
accordingly to satisfy the fixed angle of the model perspective. Magnification increases 
or decreases the view without changing the eye position but correspondingly changes 
the radius value. The result is that increasing the value enlarges the model and reduces 
the radius value, and decreasing the value reduces the model and enlarges the radius 
value. 

Mode: This option can be used to choose the view mode, which changes the perspective of the 
View Pane.  

Clip: Clips the view shown in the View Pane. 

3.4.3. Information 

The “Information” control set provides information about the plot item located at the current 

cursor position (Figure 3.25). For this specific plot item, it shows the element ID, 

hydrogeologic zone simulated in the model for this element, and the x, y, z values of the 

cursor. 

 

Figure 3.25. Sample “Information” control set
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IMPORTING DATA SETS 4 

The MINEDW program can import MINEDW model data sets as well as FEFLOW data sets. 

4.1. Importing Earlier Versions of MINEDW Model Data Sets 

To import a MINEDW model data set or FEFLOW data set into MINEDW, select “File/Import” 

from the Main Menu banner at the top of the screen. The “Import File” dialog box opens, as 

shown in Figure 4.1. 

 

Figure 4.1. The “Import File” dialog box 

When selecting a data file, five options are available: 1) MINEDW geometry file (.PST), 2) 

MINEDW data-set file (.FEL), 3) FEFLOW data-set file (.FEM), 4) FEFLOW results data file 

(.DAC), or 5) stereolithography (.STL) file, which is used to import a finite-element mesh. If a 

MINEDW geometry file (.PST) is selected, then only geometry and zone information are 

imported; however, if a MINEDW data-set file (.FEL) is selected, then all information related 
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to the model inputs is imported. After selecting the desired model data file, click “Open” to 

continue.  

The MINEDW data-set file (.FEL) contains a list of references to MINEDW model files, which 

must be in the same directory as the .FEL file when the model is imported. If a .FEL file was 

created using a prior version (e.g., before MINEDW 3.0) of MINEDW, then the “Define 

Simulation Start Date/Time” dialog box appears (as shown in Figure 4.2). If the MINEDW data 

set was created with MINEDW version 3.0 or greater, the time-step information is imported 

automatically. 

 

 

Figure 4.2. The “Define Simulation Start Date/Time” dialog box 

When importing data from a .FEL file created by versions prior to MINEDW version 3.0, the 

simulation start date refers to time step = 0 in the simulation. After entering the simulation 

start date, click “OK” to complete the importing process. A progress window appears (Figure 

4.3), showing the completion percentage of the import. 

 

Figure 4.3. The “Importing” data progress window 

Time-varying conductivity (e.g., ZOR) information cannot be imported into MINEDW when 

importing from .FEL files created by MINEDW prior to version 3.0 and has to be regenerated 

using the “Open Pit” menu. 

4.2. Display the Imported Model 

After the model files are imported, the model can be displayed using plot items, as described 

in Chapter 3. 
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MESH GENERATOR 5 

In order to build a MINEDW model, the user must first create a 2-D mesh using either the 

Grasshopper plugin for Rhinoceros 3D (Rhino, a 3-D modeling program) that is distributed 

with MINEDW or any other software designed to create a 2-D mesh. The 2-D mesh needs to 

be saved as either a stereolithography (.STL) file or a MINEDW geometry (.PST) file. The 2-D 

mesh file can then be imported to the main MINEDW GUI where the rest of the model setup 

occurs.  

5.1. Creating a Mesh 

For the creation of a mesh, Rhino should be installed. After the successful installation of Rhino, 

copy the “MMesh.gha” and “triangulation.dll” files that were provided in the “bin” directory 

of the installed directory of MINEDW into the directory “C:\Users\[YOUR USER 

NAME]\Application Data\Grasshopper\Libraries.” 

Open Rhino and import or create any features you would like to include in your mesh. This 

can be done using the Rhino drawing tools or by importing or copying from AutoCAD .DXF 

files. Launch Grasshopper by typing “Grasshopper” into the Rhino command line, or double-

click the “Launch Grasshopper” tool icon to open the Grasshopper window. 

From the Grasshopper window, open the “template.gh” file that is in the “bin” directory of the 

installed MINEDW directory. A workflow will appear on the Grasshopper canvas, shown in 

Figure 5.1. This workflow is designed to create a 2-D mesh for a typical mining-related 

groundwater flow model. The workflow may be modified using the tools contained in Rhino 

and Grasshopper to suit any requirements. 

Rhino and Grasshopper are two powerful external visualization and mesh-generation tools 

that are not developed by Itasca. Users are strongly encouraged to read the operational 

manuals of Rhino and Grasshopper to become familiar with these tools. 

The user is also recommended to work through tutorials for mesh generation using Rhino 

and Grasshopper. 
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Figure 5.1. The Grasshopper mesh generator template 

The blocks shown in Figure 5-1 are called components. Each of the key components is labeled 

by number and will be explained in detail in Section 5.2. Components have input parameters 

on their left side and output parameters on their right side. A component box is orange in 

color if it has a warning message. The message can be viewed in the comment box on top of 

the component. The user assigns features such as rivers, wells, and faults to components in 

Grasshopper to add features to the mesh. The grey “All Faults” and “Regions” (6 & 7) 

components are used to combine multiple inputs of the same type. The grey slider blocks, if 

connected to another component’s input parameter, allow the user to adjust parameters such 

as maximum element area and fault width. The “MMesh” (8) component creates a mesh that 

incorporates all the components it is connected to. The yellow box below the “MMesh” 

component gives information about the mesh, including the number of vertices and elements 

and the minimum element size once it is created. Components may be connected by clicking 

on the half circle next to an input parameter and dragging the mouse to the half circle next to 

an output parameter. Components may be disconnected by right-clicking on a parameter at 

either end of the connection and choosing the “Disconnect” option. Once the components have 

been connected and assigned with the proper construction features, the mesh can be viewed 

and will dynamically update as changes are made to various components. The components 

and the steps involved in making a mesh are discussed in detail in the following sections. 
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5.2. The Mesh Components 

The template contains the following components, which are labeled by number in Figure 5.1: 

1. Domain: This component is used to define the extent of the model domain. The input 
will be a single, closed polyline curve. 

2. Mining Area, Mining, and Fine Area: These components are used to outline regions 
of the model domain that will have a finer mesh discretization. The input will be one or 
more closed polyline curves. 

3. Fault: This component is used to define any faults in the model domain. The mesh 
generator will ensure that model nodes follow the line of the fault and will apply a width 
of the fault for a more accurate geologic representation. The user may specify the width 
of a fault. The input for this feature is a curve that represents the centerline of the fault. 

4. Points: This component is used to specify any points that need to correspond to nodes 
in the mesh, such as a pumping well. The input for this feature is one or more points. 

5. Polylines: This component is used to specify any curves that need to correspond to 
edges in the mesh, such as rivers or streams. There is no width associated with this 
feature. The input for this feature is one or more curves. 

6. Regions: This component combines all the mesh regions created in the “Mesh Regions” 
group. The output of this component is connected to the regions input parameter of the 
“MMesh” component. 

7. All Faults: This component combines all the faults created in the “Faults with Different 
Widths” group. The output of this component is connected to the faults input parameter 
of the “MMesh” component. 

8. MMesh: This component receives input parameters from the regions, faults, lines, and 
points that the user specifies and then generates a mesh. Information about the mesh 
appears in the yellow box.  

9. Toggle: This component toggles between “True” and “False” values. The output of this 
component is connected to the “Simplify Lines” parameter: If the value is “True,” 
“MMesh” will simplify line inputs into the mesh; if the value is false, “MMesh” does not 
simplify line inputs. 

10. Area Tolerance: This component specifies the minimum ratio between the actual area 
of an element and the maximum area assigned to the mesh region it belongs to. 

The user must import or create each feature in Rhino prior to connecting the features to the 

Grasshopper workflow. Note that all features must be located in the same 2-D plane. To 

connect features that exist in the Rhino workbook to the Grasshopper workflow, right-click 

on the input parameter in the top left corner of the component block and choose “Set One 

Curve/Point” or “Set Multiple Curves/Points.” Then select the desired feature in Rhino. This 

process is described in detail for each type of component in the following sections. 

For the “Mesh Regions” components, in the purple box in the upper left of the Grasshopper 

worksheet, all active components must be connected to the “Regions” component. The 

“Regions” component must then be connected to “MMesh” at the terminal labeled “Regions.” 
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5.2.1. The “Domain” Component 

The “Domain” component (Figure 5.2) is used to specify the model domain boundary. All 

parts of the mesh must be contained within the model domain boundary. The input for this 

component must be a closed polyline curve. Note that curves that the user draws in Rhino 

may be non-uniform rational basis spline (NURBS) curves. NURBS curves cannot be used in 

the Grasshopper workflow but may be easily converted to polylines using the “Convert” 

command in the Rhino command line. See the Rhino documentation for more information. To 

connect a closed curve in the Rhino workbook to the “Domain” component in Grasshopper, 

right-click on the “Domain” input parameter in the upper left of the component (Figure 5.2a). 

Select “Set One Curve” (Figure 5.2b). Then select the curve that delineates the model domain 

boundary in the Rhinoceros window.  

The user can check that the desired curve was connected to the “Domain” component by 

clicking on the “Domain” component so that it is highlighted in green. In the Rhino workbook, 

any curve that is assigned to the highlighted component will turn green. Curves may be 

disconnected from the “Domain” component by right-clicking on the “Domain” input 

parameter and selecting the “Clear Values” option in the “Domain” menu, shown in Figure 

5.2b. 

 

Figure 5.2. The “Domain” component: a) the component, b) the “Domain” input parameter 
menu, c) the “Area” input parameter menu 
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The maximum element area is set in two ways depending on whether the “Maximum Area” 

block and “Area” link in the “Domain” block are connected or not. 

If the “Maximum Area” block and “Area” link in the “Domain” block are not connected, the user 

can right-click on the “Area” input parameter, which brings up the menu shown in Figure 5.2c. 

Click on the “Set Number” menu option and enter the maximum element size desired for the 

mesh; note that the user will have the ability to add regions of finer discretization.  

If the “Maximum Area” block and “Area” link in the “Domain” block are connected, it also is 

only possible to set the maximum element area by connecting the grey slider to the left of the 

component, shown in Figure 5.3. The user can either use the slider to determine the value of 

the maximum area or double-click the grey area and enter the value. 

 

Figure 5.3. The “Maximum Area” slider 

It should be noted that if the “Maximum Area” block is connected to the “Area” link of the 

“Domain” block, the value in the “Maximum Area” block will supersede the value that is 

entered in the “Area” parameter in the “Domain” block. 

Blocks may be connected by clicking on the half circle of the “Maximum Area” block and 

dragging the mouse to the half circle of the “Area” parameter in the “Domain” block. Blocks 

maybe disconnected by right-clicking the specific parameter in the “Domain” block (i.e., 

“Area” in Figure 5.3) and selecting “Disconnect” from the pop-up menu. 

5.2.2. The “Mining Area,” “Mining,” and “Fine Area” Components 

The “Mining Area,” “Mining,” and “Fine Area” components are intended to allow the user to 

assign regions of increased mesh density to the area surrounding the mining activities, the 

location of the mining activities themselves, and any other areas that require it. The regions 

that the user assigns to any of these three components must be contained within the model 

domain that the user specified in the “Domain” component. These regions of fine mesh 

discretization may be located completely inside or completely outside of another fine mesh 

discretization region; however, they cannot partially overlap. 

The “Mining Area,” “Mining,” and “Fine Area” components are used in the same way as the 

“Domain” component. The user right-clicks on the “Region” input parameter and selects the 

menu option “Set One Curve” or “Set Multiple Curves” (see Figure 5.2b). The user then selects 

the curve or curves that delineate the region that requires a finer mesh. The user may specify 

the maximum element area in the region by right-clicking on the “Area” input parameter and 

selecting “Set Number” from the menu. Alternatively, the user may set the maximum element 
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size by connecting the “Area” input to the “Maximum Area” slider and using the slider to select 

the desired maximum element size, as shown in Figure 5.3, or enter the value as described in 

Section 5.2.1. 

5.2.3. The “Fault” Component 

The “Fault” component (Figure 5.4a) is used to create faults that have width. The user must 

first create or import a curve that delineates the center line of a fault in Rhino. The user right-

clicks on the “Line” input parameter and selects the menu option “Select One Curve,” shown 

in Figure 5.4b. The user then selects the desired curve in Rhino. The user may also select the 

“Select Multiple Curves” option and then select all the faults that have the same width. If 

different widths are desired, the user must use multiple “Fault” components. To disconnect 

curves, select the “Clear Values” option in the “Line” input parameter menu, shown in Figure 

5.4b. 

 

Figure 5.4. The “Fault” component: a) the component, b) the “Line” input parameter menu, c) 
the “Width” input parameter menu. 

The width of the fault is specified for each “Fault” component by right-clicking on the “Width” 

input parameter and selecting the menu option “Set Number,” then entering the desired fault 
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width. This is shown in Figure 5.4c. Alternatively, the user may connect the “Width” slider, 

shown in Figure 5.5, to the “Width” input parameter and then use the slider to specify the 

desired fault width. Note that if the slider is connected, the “Set Number” option will be greyed 

out.  

 

Figure 5.5. The “Fault” component with the width parameter slider 

5.2.4. The “Points” Component 

The “Points” component (Figure 5.6a) allows the user to specify points that will correspond 

to vertices in the mesh. This is typically used for pumping wells or monitoring wells so that 

the code’s calculation point will exactly match the location of the point feature. To specify 

hard points, the user right-clicks on the “Points” component and then selects either “Set One 

Point” or “Set Multiple Points,” shown in Figure 5.6. The user then selects the desired point or 

points in the Rhino workbook. The “SelPt” command may be used to select all points in the 

Rhino workbook. The command line will say “Point object to reference (Type=Point),” where 

the type is “Coordinate” or “Point.” If the type is “Coordinate,” Grasshopper will save the 

coordinates of the points at the time it is connected to the Grasshopper workflow. If the point 

is moved later, Grasshopper will not update its location. When the “Point” type is used, 

Grasshopper will update the mesh if the point is moved later. 
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Figure 5.6. The “Points” component: a) the component, b) menu options 

5.2.5. The “Polylines” Component 

Curves assigned to the “Polylines” component will correspond to mesh edges. This is typically 

used for rivers or other features that are represented as curves and do not have a width 

assigned to them. The component is shown in Figure 5.7a. To specify a hard curve, right-click 

on the “Polylines” component and select the “Set One Curve” or “Set Multiple Curves” option, 

as in Figure 5.7b. Select the curve or curves that delineate the desired hard curves.  
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Figure 5.7. The “Polylines” component and menu options 

5.2.6. The “Regions” Component 

The “Regions” component receives the outputs from each component in the “Mesh Regions” 

group, merges them together, and outputs the result to the “MMesh” component. The 

component is shown in Figure 5.8. 

 

Figure 5.8. The “Regions” component 
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5.2.7. The “All Faults” Component 

The “All Faults” component receives the outputs from each component in the “Faults with 

Different Widths” group, merges them together, and outputs the result to the “MMesh” 

component. The component is shown in Figure 5.9. 

 

Figure 5.9. The “All Faults” component 

5.2.8. The “MMesh” Component 

The “MMesh” component, shown in Figure 5.10, receives outputs from the “Regions,” “Points,” 

“Polylines,” and “Faults” components discussed above. In addition, “MMesh” has an “Area 

Tolerance” input parameter, which is the ratio of the smallest permissible area to the 

corresponding maximum area constraint. There is also a “Simplify Lines” input parameter, 

which receives a Boolean value from the “Toggle” component. If the value is “True,” all 

polyline inputs will be simplified, meaning the number of control points will be reduced and 

redistributed. This is recommended if there is a small angle between curve features. Both the 

“Area Tolerance” and “Toggle” components are discussed in further detail in the following 

sections. 

 

Figure 5.10. The “MMesh” component 
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5.2.9. The “Toggle” Component 

The user assigns either a “True” or a “False” value to the “Toggle” component. In the 

Grasshopper workflow shown in Figure 5.1, the toggle output is connected to the “Simplify 

Lines” input parameter in the “MMesh” component. Here, the “Toggle” component allows the 

user to choose whether or not the “MMesh” component simplifies any line inputs or not; 

“True” means that lines are simplified, and “False” means that lines are not simplified. 

5.2.10. The “Area Tolerance” Component 

The “Area Tolerance” component specifies the minimum value of the ratio between an 

element’s area and the maximum area specified for the region of the mesh that the element 

belongs to. The “MMesh” routine attempts to create elements that are as close as possible to 

the maximum element area specified by the user. If the “MMesh” routine is not able to create 

elements that are large enough to meet the area tolerance criteria, it will disregard hard 

points so that it can. Therefore, if a curve has too many control points in one section, or if 

there is a cluster of wells too close together to allow for element sizes to meet the area 

tolerance criteria, the “MMesh” routine may disregard points that the user specified to match 

with mesh nodes. 

5.3. Exporting a Completed Mesh 

During the development of the mesh in Grasshopper, the mesh is shown as a preview that 

cannot be selected or modified in the Rhino workbook. Once the mesh is completed, the user 

may save the mesh in the Rhino workbook by right-clicking on the “MMesh” component and 

selecting the “Bake…” menu option, shown in Figure 5.11a. The user will be able to enter the 

name of the mesh and choose the layer it will be found in in the resulting menu, shown in 

Figure 5.11b. 
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Figure 5.11. Saving a mesh: a) the “MMesh” component menu, b) the “Save Attributes” dialog 
box 

In the Rhino workbook, the user can use the design tools to edit the mesh, if necessary. To 

export the mesh in a format compatible with MINEDW, first select the mesh, then choose 

“Export Selected…” in the “File” menu. Save the file as a stereolithography, or .STL, file.  

5.4. The Rhino “Drop” Command 

The “Drop” command in Rhino was developed to aid the creation of open-pit plans. The 

command allows the user to find the elevation of the pit at many x, y points without loss of 

accuracy due to interpolation. To install the function, go to the “File” menu and select the 

“Properties” option. The “Document Properties” dialog box shown in Figure 5.12 will open. 

Chose the option “Plug-ins” from the list on the left side of the “Document Properties” dialog 

box, circled in Figure 5.12. Click the “Install” button and choose the “Drop.rhp” file. Make sure 

that “Drop” is listed under “All Plug-ins” and that the “Enabled” box next to it is checked, as 

shown in Figure 5.12.  
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Figure 5.12. Installing the “Drop” command in Rhino 

To use the function, open a mesh in Rhino. Import points to Rhino; the user may want the 

points to match the x, y locations of the model mesh’s nodes. Type “Drop” into the command 

window and, following the prompts, select the mesh, press [Enter], select the points, and 

press [Enter] again. The points will keep their x and y coordinates but change in elevation 

such that they are located on the mesh. The points may be selected and then exported from 

Rhino as a text file. The text file may then be imported into MINEDW for various uses. 

 

  

 

 



6. NODES AND ELEMENTS 
 

 

MINEDW  55 

 

 

NODES AND ELEMENTS 6 

6.1. Selecting Elements 

The MINEDW software provides tools for selecting nodes and elements to perform the 

following tasks: 

1. Assign and edit properties that are defined on elements, such as hydraulic conductivity 
and storage zones, recharge zones, and evaporation zones; 

2. Assign and edit the boundary conditions related to nodes, such as constant heads, 
pumping wells, and variable-flux boundary conditions; 

3. Move nodes within the finite-element mesh; 

4. Add pinch-outs for increased vertical model discretization; and 

5. Refine and extend the mesh. 

The tool buttons that are used to select nodes and elements are listed in Table 6.1, below. 

Table 6.1. The Nodes and Elements Tool Buttons 

 
Select Elements or Nodes 

 
Select with Polygon 

 
Select with Overlay 

 
Move Nodes 

 
Search Node/Element 

 
View Mode 

When modifying the element- or node-related properties, it is important that the plot item 

being modified (node or element) is the first active plot item in the “Plot Items” pane. When 

selecting elements and assigning new hydrogeologic zones, for example, the “Element” plot 

item should be the first active plot item in the “Plot Items” pane. Conversely, when selecting 

nodes and assigning a ground-surface elevation, the “Node” plot item should be the first active 

plot item in the “Plot Items” pane. To select elements, use the “Select” tool when element-
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related plots are displayed in the View Pane. Element-related plots include “2-D Plane” and 

“3D Element” plots, which can be found in the “Control Panel” under the “List” menu. In the 

“Control Panel” Pane, under either the 2-D or 3-D plot attributes, the user can specify the 

elemental data (e.g., hydraulic zones using the “3D Element” plot item or evaporation and 

recharge using “2-D Plane” plot items) to view, select, and edit. 

6.1.1. Selecting Elements in 2-D 

If an element-related plot is displayed, then the elements can be selected using the following 

approaches: 

▪ Click the “Select” tool and then click individual elements in the View Pane. To 
deselect individual elements, right-click on the selected element. To deselect all 
selected elements, press the [Esc] key. 

▪ Click the “Select” tool and then click and drag the cursor to select the elements in 
a rectangle. Right-clicking and dragging a selection box around selected elements 
will deselect the elements. 

▪ Click the “Select” tool and then click the “Select with Polygon” tool, shown in Table 
6.1. Use the “Select with Polygon” tool to select multiple elements in a desired area 
in the model domain. To close the polygon, press the [Enter] key. 

▪ Add a point, polyline, or polygon file to the View Pane using the “BLN,” “ESRI Shape 
File,” or “Point Data” plot items. The file that will be used as an overlay must be 
added to the View Pane (see Section 3.4.1.8) before the “Select with Overlay” tool 
is clicked. If multiple overlays are added to the View Pane, only the topmost listed 
in the “Plot Items” pane will be used to select. To use the overlay below the 
topmost overlay, the latter should be deactivated. Click the “Select” tool and then 
click the “Select with Overlay” tool. When the “Select with Overlay” tool is activated, 
the dialog box shown in Figure 6.1 appears. To deselect a selected element, right-
click on that element or right-click and drag a rectangle around multiple selected 
elements. Press the [ESC] key to deselect all selected elements. 

 

Figure 6.1. The “Choose Method of Selection” dialog box 

To exit the select mode, click the “View Mode” tool. To deselect all elements before editing, 

press the [ESC] key. 
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As previously described, there are three options when selecting elements with an overlay file. 

If the “Point” option is selected, then the closest elements for each point are selected. If the 

“Polyline” option is selected, then elements along the polyline are selected. If the “Polygon” 

option is selected, then the elements inside the polygon are selected. 

After the elements are selected, press the [Enter] key, and one of the dialog boxes shown in 

Figures 6.2, 6.3, and 6.4 appears. These dialog boxes can be used to edit the recharge zone 

(Figure 6.2), evaporation zone (Figure 6.3), or geological zone (Figure 6.4) input data. 

 

Figure 6.2. The “Select Recharge Zone” dialog box 

To edit the spatial distribution of recharge zones, select elements using a “2-D Plane” plot 

item and change the “Color By” attribute to “Recharge.” When the “Select Recharge Zone” 

dialog box appears, the recharge zone for the selected elements can be assigned using the 

drop-down box next to “Zone.” 

 

Figure 6.3. The “Select Evaporation Zone” dialog box 

Evaporation zones can be assigned and modified in a manner similar to recharge zones. 

Change the “Color By” attribute on the “2-D Plane” plot item to “Evaporation,” select the 

desired region as previously described, and then press the [Enter] key; the “Select 

Evaporation Zone” dialog box then appears. Using the drop-down box in the “Select 

Evaporation Zone” dialog box, select the desired evaporation zone to assign the zone to the 

selected elements. More information on assigning recharge and evaporation is provided in 

Section 7.4. 

Use a “2D Element” or “3D Element” plot item to assign geologic properties to elements. When 

the desired elements are selected, press the [Enter] key, and then the “Select Geological Zone” 

dialog box shown in Figure 6.4 appears. 
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Figure 6.4. The “Select Geological Zone” dialog box  

Element properties in multiple layers can be changed by entering the layer to extend the 

selected elements to, as shown in Figure 6.5. The layer selected in the attribute panel of the 

“Element” plot item determines the uppermost layer that the change affects.  

 

Figure 6.5. The “Select Geological Zone” dialog box showing the multiple layers option 

Selected element numbers can be exported by using the “Export” function shown in Figure 

6.4 and specifying an output file. If elements are exported, then the output file will contain 

the selected element numbers. 

6.1.2. Selecting Elements in 3-D 

Another option to select elements and assign the zone properties to the elements is to use a 

.DXF file. To assign a geologic unit to an element using a 3-D .DXF file, add a “DXF” plot item 

to the View Pane by selecting “List” and then “File Data.” Under “File Data,” double-click “DXF.” 

The “Attributes” tab then appears. Click on the “+” next to “File” and the “Select DXF Data File” 

dialog box opens. Select the desired 3-D .DXF file and click “Open.” If multiple geologic units 

are represented in the .DXF file, the assignment of each geologic unit to the model elements 

should be done individually. Click the “Layers” button under the “Attributes” tab shown in 

Figure 6.6 and disable the other units if there are multiple.  
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Figure 6.6. The “Attributes” dialog box 

Click the symbol next to “To Zone,” as shown in Figure 6.6. The “DXF to Zone” dialog box 

appears. Select the desired zone to assign to the elements in the drop-down box. For geologic 

units (i.e., objects that have a volume), select “Volume”; for structures (e.g., faults), select 

“Face,” as shown in Figure 6.7. For element selection, if the “Whole” option is selected, only 

the elements that are completely inside of the .DXF file are selected. If the “Center” option is 

selected, the elements are selected if the element centers are inside the .DXF file. Click “OK” 

to complete the assignment.  

 

Figure 6.7. The “DXF to Zone” dialog box 

To exit the “Select” mode, click the “View Mode” button. To deselect all elements before 

editing, press the [ESC] key. 

6.2. Selecting Nodes 

The “Select” tool can also be used when node-related plots are displayed in the View Pane. 

Node-related plots include 2-D and 3-D contour plots, which can be found in the “Control 

Panel” on the “List” tab under the “Node” plot items group. The operations that can be 

performed are described in the sections that follow. To select the node, the node plot item 
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should be the first active plot item in the “Plot Item” pane. Nodes can be selected using the 

following methods: 

▪ Click the “Select” tool and then click on the nodes in the View Pane. To deselect 
individual nodes, right-click on the selected node. 

▪ Click the “Select” tool and then click and drag the cursor to select nodes in a 
rectangle. Deselect with a right click. 

▪ Click the “Select” tool and then click the “Select with Polygon” tool. Use the “Select 
with Polygon” tool to select multiple nodes in a desired area in the model domain. 
To close the polygon, press the [Enter] key. 

▪ Add a point, polyline, or polygon file to the View Pane using the “BLN,” “ESRI Shape 
File,” or “Point Data” plot items. Click the “Select” tool and then click the “Select 
with Overlay” tool. When the “Select with Overlay” tool is activated, the “Choose 
Method of Selection:” dialog box appears (Figure 6.1). The file that will be used as 
an overlay must be added to the View Pane before the “Select with Overlay” tool is 
clicked. If multiple overlays are added to the View Pane, only the topmost listed 
in the “Plot Items” pane will be used to select. To use the overlay below the 
topmost overlay, the latter should be deactivated. To deselect a selected node, 
right-click on that node or right-click and drag a rectangle around multiple 
selected nodes. Press the [ESC] key to deselect all selected nodes. 

After the nodes are selected, press the [Enter] key to open the “Assign Properties for Nodes” 

dialog box shown in Figure 6.8. 

 

Figure 6.8. The “Assign Properties for Nodes” dialog box 

Several operations can be performed on the selected nodes. 

▪ Assign boundary conditions (constant head, variable flux, or pumping wells), as 
shown in Figure 6.9. After selecting one of the options, the number of layers to be 
assigned with the boundary conditions should also be specified, as discussed later 
in this section. 
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Figure 6.9. Assign boundary conditions to selected nodes 

▪ Change the elevation of the selected nodes, as shown in Figure 6.10. 

 

Figure 6.10. Assign constant elevation to selected nodes 

▪ Interpolate the elevations of the selected nodes using a data file by clicking on the 
button next to “Interpolated from File,” as shown in Figure 6.11. The format of the 
data file is a series of x, y, z space delimited data. 

 

Figure 6.11. Assign elevation by interpolating elevation data 

▪ After the selection of one of the boundary conditions as shown in Figure 6.9, 
specify the number of layers. If nodes in more than one layer are to be selected, 
then the number of layers to be modified can be selected (Figure 6.12). 

 

Figure 6.12. The multiple layers specification dialog box 

▪ Export the data. The selected node numbers can be exported to a .DAT file by 
using the export button, as shown in Figure 6.13. If nodes are exported, then the 
output file will contain the selected node numbers and the corresponding node 
elevations.  

 

Figure 6.13. The options available for both nodes and elements 

To exit out of the “Select” mode, click the “View Mode” tool after closing the “Assign Properties 

for Nodes” dialog box. To deselect all the selected elements before editing, press the [ESC] key. 
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MODEL INPUT DATA 7 

This chapter describes generating inputs for a MINEDW model using the user interface 

menus and tool buttons. MINEDW saves the model files and results as a project file format 

(.PRJ) from which ASCII input files can be generated for the calculation portion of the 

program. From these files, users can easily restore a saved modeling project and restart the 

model simulation from any selected time. 

7.1. Project Definition 

The first step to create a new model is to define the project properties. This section describes 

the project properties, including simulation parameters, units, type of simulation, solver 

types, and file output names. 

7.1.1. Project Properties 

Project properties are defined by selecting “Project Properties” from the “Project” drop-down 

menu on the Main Menu banner at the top of the window. Select “Project Properties,” and the 

“Project Properties” dialog box shown in Figure 7.1 appears. The required information for 

project properties is described below. 
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Figure 7.1. The “Project Properties” dialog box 

Project Name: The user-defined name of the project. 

Output File Name: The prefix assigned to all MINEDW-created data-set files (e.g., the model 
file would be labeled “TR_model.dat” when “TR_” is the output file name). 

Unit: Length units used in the model (meters and feet are the supported units in MINEDW).  

Type of Simulation: The means by which to select whether the model is a steady-state or 
transient-state simulation. In steady-state simulations, it is good practice to make sure 
that the storage changes are smaller than 1.0 x 10-10 cubic meters per day (m3/day) at 
the end of the model simulation. This information can be found in the budget and output 
files (.BUD and .OUT) that are created in the simulation directory. For steady-state 
simulations, only the first time step defined in the “Time Steps” item in the “Project” 
drop-down menu on the Main Menu banner is used and, starting from the second time 
step, the time-step length is multiplied by a factor of 1.2. For transient simulations, the 
time-step multiplication factor is 1, and the time steps defined in the “Time Steps” dialog 
box are used. The “Time Steps” item is discussed in Section 7.1.2. 

Maximum Outer Iterations: The maximum number of outer iterations (an even number 
generally less than 10) that are to be used to precondition the matrices of equations 
prior to solving. The appropriate number of maximum outer iterations depends on the 
solver that is used and the model that is being run. Starting with a smaller number of 
maximum outer iterations and increasing the iteration value as necessary (review the 
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.BUD or .OUT files for percent residuals) is recommended to ensure the fastest solution 
time.  

Solver: Option for the solver type to be used in the model simulation. There are two solver 
options available in MINEDW: PCG (Preconditioned Conjugate Gradient) and SAMG 
(Algebraic Multigrid Methods for Systems) (Fraunhofer SCAI 2013). 

Outer Iteration Closure Criterion: The head closing criteria for outer iterations. Determination 
of the iteration value depends on the scale of the model being simulated. It generally 
should be less than 1 meter (m) or 3 feet (ft). The value should be defined based on 
computational time, accuracy, and mass balance. 

Maximum Inner Iterations: Maximum number of inner iterations to solve the matrices of 
equations. This value generally is greater than 1,000, depending on the value of the 
inner iteration closure criterion. Inner iterations may often be set to a large value 
without compromising model run time because the solvers use the minimum number 
of iterations necessary to meet the closure criteria. 

Inner Iteration Closure Criterion: The closure criterion for the inner iterations. This value is 
generally less than 1 x 10-10. The smaller the inner closure criterion is, the greater the 
computational accuracy of the results and the longer the computational time. 

Output Time Step Frequency to PLB File: The time-step intervals at which MINEDW saves the 
simulated heads to the output file with a .PLB extension. The default value is 1. 

7.1.2. Time Steps 

The time steps are defined using the “Time Steps” item in the “Project” drop-down menu on 

the Main Menu banner. During the model setup, if the user selects “Steady State” in the 

“Project Properties” dialog box, then the “Setup Time Step” dialog box appears as shown in 

Figure 7.2 when “Time Steps” is selected from the “Project” drop-down menu. If the user 

selects “Transient” for the model run, then the dialog box shown in Figure 7.3 appears. For a 

steady-state model, the “Start Date/Time,” “Maximum # of Time Steps,” and “Initial Time Step 

Length” are the only inputs that need to be defined. The “# of Time steps for this simulation” 

defines the number of time steps to use for a particular model run, but this parameter is 

typically the same value as “Maximum # of Time Steps” for steady-state models. 
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Figure 7.2. The “Setup Time Step” dialog box for steady-state simulations 

There are three different options for defining time steps for a transient simulation: 1) 

“Constant,” 2) “Month,” or 3) “Varied.” If the “Varied” option is selected, then the data can be 

imported from an ASCII data file (the format for the ASCII file is one column that contains the 

time-step number and another column that contains the number of days for each time step; 

the input time-step file created by MINEDW is in this format). The time steps and the 

corresponding dates are shown on the right-hand side of the window (Figure 7.3). The 

maximum number of time steps can be defined from the same window (Figure 7.3). The 

“Maximum # of Time Steps” setting covers all of the time steps for different simulations for a 

project.  
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Figure 7.3. The “Setup Time Step” dialog box for a transient simulation 

Under the simulation time-step section (Figure 7.3), the number of time steps to simulate for 

a simulation can be set. Using the simulation time-step slider or entry, the user can specify 

the number of time steps to simulate by choosing either a complete model simulation or an 

abbreviated model simulation. An abbreviated model simulation will run for the number of 

specified time steps. 

In the simulation start time drop-down box, a model can be restarted from a specified time 

step by selecting the time step at which the simulation will begin. The simulated head output 

file (.PLB) must be read before selecting the restart time step; otherwise, the only available 

option is the first time step. Reading in an output file in MINEDW is described in section 9.1. 

A model simulation should not be restarted during any part of pit-lake filling. 

7.2. Model Geometry 

While the horizontal geometry of the model domain is defined in the mesh generator, the 3-

D layering within the model is defined within the MINEDW GUI using the “Mesh” menu. The 

following sections describe the functions in the “Mesh” menu.  



7. MODEL INPUT DATA 
 

 

MINEDW  67 

 

7.2.1. Generating the Mesh 

The finite-element mesh defines the geometry to simulate a groundwater system. The 

MINEDW finite-element mesh consists of a solid configuration of tetrahedrons. Tetrahedrons 

are difficult solids to use; therefore, the actual mesh is assembled from prismatic elements 

that are triangular in plan view. The prisms are oriented spatially with sub-horizontal 

triangular faces and sub-vertical quadrilateral faces. Three tetrahedrons then are 

automatically fitted into each prismatic element. 

To allow flexibility in the construction of 3-D meshes, the MINEDW program accepts 

prismatic elements that have edges with a height of zero. A prismatic element with one zero-

height edge contains two tetrahedrons and an element with two zero-height edges. These 

special elements can be used to represent geologic features that taper to a thickness of zero 

or to add vertical refinement in areas of particular interest. Without these special elements, 

a vertical zone of fine vertical discretization can be terminated only by carrying it to the edge 

of the model domain. 

Generating a MINEDW mesh involves performing the following steps: 

1. Generate a one-model-layer mesh that incorporates the hydrogeologic features in 
plan view using Rhinoceros 3D and Grasshopper (as described in Chapter 5) or 
another mesh generator. 

2. Add the ground-surface topography to the main model layer. 

3. Add main model layers according to the stratigraphy, geologic information, or other 
data. 

4. If needed, add additional vertical model discretization using pinch-outs. 

7.2.2. Adding Main Model Layers 

After importing the mesh generated by Rhinoceros 3D and Grasshopper (Chapter 5), main 

layers can be added by selecting “Define Main Layer” from the “Mesh” drop-down menu found 

on the Main Menu banner. A main layer is defined as a layer that extends through the entire 

model domain. When “Main Layer” is selected, the dialog box shown in Figure 7.4 appears. 

To add a new main layer to the model, first select a main layer, then click “Insert.” The new 

main layer will appear above the selected main layer. The “Method” option will be “Constant,” 

and the “Value” field will be blank. Select the desired method from the drop-down box in the 

“Method” field if needed, and then enter the appropriate value in the “Value” field. Click “OK” 

to add the main layer with the desired elevation or thickness. Note: if the “Average” method 

is selected, then no value is needed in the “Value” field. The new main layer is placed above 

the originally selected main layer. An example of the information required for main layers is 

described below. 
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Figure 7.4. The “Define Main Nodal Layers” dialog box with layer definition 

The method of defining the elevation of the main layers in Figure 7.4 includes five options, as 

shown in Figure 7.5, below. 

 

Figure 7.5. The “Method” drop-down box showing the available options  

The five options available for main layer creation are the following: 

No Change: This option retains the existing elevation for the selected main layer. 

Constant: This option assigns a constant-elevation value. 

Average: This option assigns an average elevation of two layers to the newly created main 
layer or layers. This option is not available for the top and bottom main layers. 

Thickness: This option assigns the elevation by using the defined thickness from the main 
layer below. This option is not available when adding the bottom layer of the model. 
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Depth: This option assigns the elevation by using the defined depth from the main layer 
above. This option is not available when defining the elevation of the top layer of the 
model. 

The following are examples for inserting several main model layers into MINEDW: 

▪ Constant: Adding a main layer using the “Constant” method will add a nodal layer 
at the elevation specified in the “Value” field. A nodal layer (creating two new 
element layers) can be added anywhere using this method, but care must be taken 
to ensure that the new layer falls between the nodes of the upper and lower node 
layers. 

▪ Average: To add a main layer with an average thickness (Figure 7.6), select a layer 
and click “Insert.” MINEDW will insert a nodal layer above the selected layer. 
Select “Average” from the “Method” drop-down box and click “OK.” MINEDW adds 
a new nodal layer (as shown within the red box) between the top and bottom 
nodal layers, forming two element layers. Node elevations for this layer are 
calculated as the average of the top nodal layer and the bottom nodal layer. 

 

Figure 7.6. Layer definition using the “Average” method 

▪ Thickness: The “Thickness” option will create a nodal layer (shown within the red 
box) that is offset by a user-specified value from the nodal layer immediately 
below, as seen in Figure 7.7. This creates an element layer with elements of 
uniform thickness. Figure 7.7 displays a nodal layer that has a constant elevation 
and an element layer of uniform thickness; however, it is possible to create a 
nodal layer that does not have a constant elevation but that forms an element 
layer of uniform thickness. This occurs when the reference nodal layer does not 
have a constant elevation. 
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Figure 7.7. Layer definition using the “Thickness” method 

▪ Depth: The “Depth” method is similar to the “Thickness” method, with the 
exception that the upper nodal layer (rather than the lower nodal layer) is used 
as the reference layer to calculate the location of the nodal layer that is being 
added. In contrast to the nodal layer with uniform elevation, shown in Figure 7.7, 
the nodal layer in Figure 7.8 does not have a uniform elevation because the upper 
nodal layer that was used as the reference to calculate the location of the new 
nodal layer did not have a uniform elevation.  

 

Figure 7.8. Layer definition using the “Depth” method 

7.2.3. Using Topography Data  

The following describes how to add topographic information to the first model layer, but the 

same steps can be repeated to apply topography to any model layer.  

To incorporate topography in a model, select the “List” tab in the “Control Panel” Pane on the 

right-hand side of the MINEDW Main Menu. Expand the “Node” item by double-clicking 

“Node” or clicking on the small triangle next to “Node.” Next, double-click “3D Contour,” as 

shown in Figure 7.9. The mesh will be displayed in the View Pane.  
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Figure 7.9. The expanded “Node” plot item group 

Click the “Select” tool on the toolbar. From the “Control Panel” Pane on the right-hand side of 

the MINEDW window, select the “Attributes” tab. Make sure that “Layer 1” is selected and 

“Elevation” (in the “Color By” drop-down box) is selected, as shown in Figure 7.10. 
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Figure 7.10. The “Control Panel” Pane showing the “Attributes” tab with  
“Layer” set to “1” 

In the MINEDW View Pane, use the cursor to click and drag a box around the whole domain 

to select all of the nodes in Layer 1. Press the [Enter] key to open the dialog box shown in 

Figure 7.11. Click the button next to “Interpolate From File,” and the “Open Data File” dialog 

box appears. Select a file with XYZ data (this file is formatted as columns of x, y, and z data) 

that contains the topographic information that will be added to the model, and click “Open.” 

The “Grid” dialog box shown in Figure 7.12 appears. Define the interpolation method 

(“Inverse Distance” or “Kriging”) and the required parameters, and then click “OK.” MINEDW 

assigns the topographic information contained in the data file to the top layer of the model 

using the interpolation method. This method can be used to assign elevation data to all of the 

nodal layers in the model. To assign elevation data to other nodal layers, simply select the 

desired layer on the “Attributes” tab of the “3-D Contour” plot item and repeat the steps 

described above. 
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Figure 7.11. The “Assign Properties for Nodes” dialog box 

 

Figure 7.12. The “Grid” dialog box 

To view the ground-surface elevation contours, add an “Isoline” plot item and select 

“Elevation” as the “Color By” attribute. The counter intervals may be manipulated by using the 

options under the “Contour” attribute of the “Isoline” plot item. Click on the “Attributes” tab in 

the “Control Panel” Pane, and then click on the small triangle next to “Contour.” Deselect the 

“Auto” box next to “Interval” and replace the current value with a different value, then press 

the [Enter] key, and elevation contours appear. An example of ground-surface elevation 

contours is shown in Figure 7.13. 
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Figure 7.13. The MINEDW main window showing elevation contours 

7.2.4 Importing Node Elevations 

Node elevations can be assigned to all of the nodes in the model domain by importing a node-

elevation file. Node elevations are written to a file called “node.fem” by the MINEDW GUI. This 

file is a simple text file that can easily be created using another MINEDW model or other 

software. The file contains five columns of data: 1) node number, 2) x location of node, 3) y 

location of node, 4) z location (or elevation) of node, and 5) node layer.  

To import and assign node elevations for the entire domain, select “Import Elevations From 

Node File” found under the “Project” drop-down menu on the Main Menu banner. Use the 

“Import Node File” dialog box that opens to navigate to the location of the node elevation file. 

Select it and click “Open” to complete the assignment. The default file type for node elevations 

in MINEDW is the .FEM file type. MINEDW creates three files with the .FEM extension, but 

only the “node.fem” file can be used to import node elevations. 

7.2.5. Defining a Pinch-Out 

MINEDW provides the option of adding areas of increased vertical discretization. The 

enhanced vertical discretization is referred to as a pinch-out because layers terminate in 

areas where increased vertical discretization is not needed. To define the pinch-out types, 

select “Mesh” from the Main Menu banner and then select “Define Pinch-Out.” The “Define 

Pinch-Outs” dialog box appears (Figure 7.14). 
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Figure 7.14. The “Define Pinch-Outs” dialog box  

In MINEDW, various pinch-out configurations can be defined and simulated. Each 

configuration is defined as one type of pinch-out. Based on their modeling needs, the user can 

define as many pinch-out types as necessary. Each type can contain pinch-outs of as many 

layers as needed.  

Figure 7.15 illustrates the working principle of the pinch-out method. For example, a model 

has four regional layers that are each represented (sequentially, Layer 1 to Layer 4, from top 

to bottom) by a row of black squares in Figure 7.15. The left column shows the number of 

pinch-out layers (shown in blue) allowed for each model layer. For illustration purposes, 

three different combinations are represented, which are each defined as a different type in 

Figure 7.15. Type 1 consists of three pinch-outs on model Layer 2 (represented as red lines). 

Type 2 consists of three pinch-outs on model Layer 2 (represented as red lines) and two 

pinch-outs on model Layer 3 (represented as a green line). Type 3 consists of two pinch-outs 

on model Layer 3 (represented as a green line). Only one number of pinch-outs can be defined 

for each model layer. For example, in Figure 7.15, model Layer 2 cannot have three pinch-
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outs in one area and two pinch-outs in another area. In this example, there will be exactly 

three pinch-outs anywhere pinch-outs are added to model Layer 2.  

 

Figure 7.15. Schematic explanation of pinch-outs  

To define pinch-outs, click the “Add” button on the right side of the “Define Pinch-Outs” dialog 

box. Type the number of pinch-outs for each layer in the column labeled “# of Sublayers,” and 

enable the pinch-out for the related layer by checking the box. Figure 7.16 shows how to 

define pinch-outs to achieve the schematic shown in Figure 7.15. When the pinch-out types 

are completely defined, click “OK.” 

 

Figure 7.16. The “Define Pinch-Outs” dialog box  

In this example, “Type 1” will have three pinch-outs in Layer 2, while “Type 2” will have the 

same three pinch-outs in Layer 2 as well as two pinch-outs in Layer 3. “Type 3” pinch-outs 

will have only two pinch-outs in Layer 3. To assign pinch-outs to an area, select the “List” tab 

in the “Control Panel” Pane. Expand the “Element” item and double-click “Pinch-Out.” From 

the main window, click the “Select” tool on the Main Menu banner. Then use the “Select with 
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Polygon” tool to select the area where pinch-outs are to be added. Figure 7.17 shows an 

example of the nodes being selected for adding pinch-outs. 

 

Figure 7.17. The View Pane with the selected nodes for pinch-out Type 1 

Press the [Enter] key, and the “Select Pinch-Out Type” dialog box opens (Figure 7.18). Select 

the type of pinch-out to add to this location from the drop-down list and click “OK.” 

  

Figure 7.18. The “Select Pinch-Out Type” dialog box  

Figure 7.19 shows the pinch-outs described in Figures 7.15 and 7.16 in the View Pane. 
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Figure 7.19. Cross-sectional view of the defined pinch-outs  

7.2.6. Modifying the Mesh 

Using the “Modify Mesh” function in MINEDW, the user can extend the model domain and 

refine the mesh after it is created or at any time during the model setup. The mesh can be 

refined in a user-specified location or extended to cover a larger area.  

To refine the mesh, click “Modify Mesh” from the “Mesh” drop-down menu found on the Main 

Menu banner. This will open an “Open BLN File” dialog box (Figure 7.20). Select a .BLN file 

that defines an area inside the current model domain to refine and click “Open.”  
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Figure 7.20. The “Open BLN File” dialog box 

The “Refine Mesh” dialog box shown in Figure 7.21 appears. If the .BLN file defines an area 

unconnected to the current model mesh, the operation will yield a warning message. Enter 

the mesh density and click “OK.”  

 

Figure 7.21. The “Refine Mesh” dialog box 
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Figure 7.22. The mesh before (a) and after (b) an area of the mesh was refined 

 

Figure 7.23. The mesh before (a) and after (b) mesh extension 

MINEDW can also extend the mesh after it has been created. Click “Modify Mesh” from the 

“Mesh” drop-down menu found on the Main Menu banner. The area to be extended is defined 

by a .BLN file created in Surfer™ or in a text editor. When “Modify Mesh” is selected from the 

“Mesh” drop-down menu, the “Open BLN File” dialog box shown in Figure 7.20 appears. Select 

the .BLN file defining the area to be extended. Click “Open.” The “Refine Mesh” dialog box 

shown in Figure 7.21 appears. Enter the mesh density and click “OK.” Figure 7.23 shows the 

mesh before and after the mesh extension. 

7.3. Zone Properties – Hydraulic Parameters 

This section describes the zone properties (hydraulic parameters) that are assigned to the 

model. The term “zone” is a synonym for the type of aquifer material that composes the 

element; each element is assigned a zone type. Consequently, the zone definitions change only 

when the user moves a geologic boundary or defines a new geologic material (zone). Zone 

definitions include the hydraulic conductivity, specific storage, specific yield, and the 

principal directions of the hydraulic conductivity field, which can be specified in the x, y, and 

z directions. 
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The hydraulic parameters that characterize each zone are defined by selecting “Project” and 

then “Zone Properties” (Figure 7.24).  

 

Figure 7.24. The “Zone Properties” dialog box 

The information provided in the “Zone Properties” dialog box is described below. 

Name: Name of the geologic unit. The name is used in the display and output files. 

Kx: Hydraulic conductivity in x direction (meters per day [m/day] or feet per day [ft/day]). 

Ky: Hydraulic conductivity in y direction (m/day or ft/day). 

Kz: Hydraulic conductivity in z direction (m/day or ft/day). 

Ss: Specific storage (m-1 or ft-1). 

Sy: Specific yield (-). 

Angle1 (Φ): 3-D anisotropy, the angle of rotation around the z-axis in degrees. 

Angle2 (θ): 3-D anisotropy, the angle of rotation around the y-axis in degrees. 
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Angle3 (ψ): 3-D anisotropy, the angle of rotation around the x-axis in degrees. 

The angles (“Angle1,” “Angle2,” and “Angle3”) used to define the hydraulic conductivity tensor 
are illustrated in Figure 7.25. As described above, the direction of rotation is around the z-
axis, y-axis, and finally the x-axis. 

 

Figure 7.25. A graphical illustration of Angle1 (Φ), Angle2 (θ), and Angle3 (Ψ)  

After defining the “Zone Properties,” see the explanation in Section 6.1 on how to select 

elements and assign them with the created hydrogeological zones. 

7.3.1 Zone Distributions (para.fem) 

As described in Section 6.1, hydraulic zone properties can be assigned using the “Select” tool 

and the “Select Geology Zone” dialog box or a 3-D .DXF. Another method is to import a 

“para.fem” file, which contains the hydraulic zone definition for each element in the model 

domain. This file consists of three columns of data: 1) the element number, 2) the hydraulic 

zone number, and 3) the element layer number. This file can be created using another 

MINEDW model with the same domain or other software. 

To import a “para.fem” file and change the distribution of hydraulic parameters of a model, 

click on “Import Zones from Parameter File” under the “Project” drop-down menu on the Main 

Menu banner. Using the “Import Zone File” dialog box, navigate to the location of the 

“para.fem” file, select it, and click “Open.” The new hydraulic zone distribution will be 

assigned to the model domain.  

7.3.2 Zone Properties (kfile.dat) 

New parameter values for hydraulic zones can be imported into MINEDW from the “kfile.dat” 

file, which can be edited by any text editor. To import a new “kfile.dat,” open the “Zone 

Properties” dialog box (Figure 7.24). Using the “Import” button, open the “Open Zone 

Properties File” dialog box. Navigate to the location of the new or updated “kfile.dat,” select it, 

and click “Open.” The parameter values will be updated in the “Zone Properties” dialog box. 
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7.4. Boundary Conditions 

A groundwater flow model requires an appropriate set of boundary conditions to describe 

the mathematical problem that will be solved. In MINEDW, six types of boundary conditions 

are available: 1) constant head, 2) variable flux, 3) pumping well, 4) rivers, 5) recharge, and 

6) evaporation. Of these six types, constant head, variable flux, pumping wells, and rivers are 

assigned to nodes, while recharge and evaporation zones are assigned to elements. 

To define the boundary conditions, select “BCs” from the Main Menu banner, then choose the 

appropriate boundary-condition type from the “BCs” drop-down menu (Figure 7.26). Each 

boundary-condition type requires a different set of parameters, as described below. (Note 

that the data-input windows have similar features and functionality).  

 

Figure 7.26. The “BCs” drop-down menu 

Boundary conditions are assigned using node or element plot items. Use the “Assign 

Properties for Nodes” dialog box to assign “Constant Head & Drain,” “Variable-Flux,” and 

“Pumping Well” boundary conditions. The “Assign Properties for Nodes” dialog box shown in 

Figure 7.27 can be accessed by adding a “2D Contour” or “3D Contour” plot item from the 

“Control Panel” Pane. Select the desired nodes and then press [Enter] to bring up the dialog 

box. 
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Figure 7.27. The “Assign Node Properties” dialog box 

Recharge and evaporation boundary conditions can be applied to the model using a “2-D 

Plane” plot item. To assign recharge or evaporation to the model, access the “Select Recharge 

Zone” or “Select Evaporation Zone” dialog box, shown in Figures 7.28 and 7.29, respectively, 

by adding a “2-D Plane” element plot item from the “Control Panel” and then selecting the 

desired “Color By” attribute, “Recharge,” or “Evaporation.” 

 

Figure 7.28. The “Select Recharge Zone” dialog box 

Next, select the desired elements using the methods described in Section 6.1, press [Enter], 

and the “Select Recharge Zone” or “Select Evaporation Zone” dialog box appears. Assigning 

recharge and evaporation boundary conditions is described in more detail in Sections 7.4.6 

and 7.4.7. 
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Figure 7.29. The “Select Evaporation Zone” dialog box 

All boundary conditions can be applied as time-varying conditions. The implementation of 

these time-varying conditions is described in Section 7.4.1 below, which is followed by a 

description of each type of boundary condition available in MINEDW. 

7.4.1. Time-Series Data 

Time-series data can be imported from files or directly defined in the time-series dialog boxes 

(Figure 7.30) that are available within the different boundary-condition dialog boxes. A time 

series consists of a user-defined number of data pairs (time, value).  

 

Figure 7.30. The time-series editor 

There are three different options in MINEDW for the input of time-series data (Figure 7.31): 

Constant: The boundary-condition data is constant, regardless of time. 

Annual: The values are defined for a year and repeated each year for the entire model-
simulation time period. 

Varied: The values are defined over time.  

 

Figure 7.31. Time-series input options 
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Time-series data can be imported from a text file (the format for the text file is described in 

Appendix B). The plot on the left-hand side displays the time-series data. For any period 

during which the pump is turned off, enter “0” for wells that are defined as “Pumping Rate” 

or “LPE” wells (lowest pumping elevation wells) and “N/A” or “-99999999” for wells that are 

defined as “Specified Head” wells. Time-series data can also be exported to a .DAT file. After 

any modifications, make sure to click “Apply” to save the changes. 

7.4.2. Constant Head 

The “Constant Head” option is used to implement specified-head boundary conditions, which 

can take the following forms: 

▪ The constant-head boundary is invariant with time (constant time series). 

▪ The constant-head boundary varies with time in accordance with a specified 
hydrograph, which is input in the form of a table of the hydraulic heads at 
specified times (varied time series). 

▪ The constant-head boundary varies annually in accordance with a specified 
hydrograph, which is input in the form of a table of the annual hydraulic heads 
(annual time series). 

▪ The boundary condition is simulated as a drainage node. A drainage node is the 
condition in which water can discharge from—but not into—the groundwater 
system. This condition can exist if groundwater can discharge to a subsurface 
drainpipe, to the pit wall, or to underground workings. Time-series data can also 
be applied to drain nodes and represent the time-varying head (drain level) at the 
drain node. Ensure that drain levels are not lower than the elevation of the node 
that the drain is defined on and that drain levels do not exceed the elevation of 
the node directly above the drain. If this occurs, MINEDW will provide the user 
with a warning and the drain node will not be simulated properly.  

“Constant Head” nodes and “Drain” nodes can be deactivated (turned off) at any time during 

the simulation by entering the appropriate date and a value of “-99999999” in the time-series 

window. Entering a value of “0” for either boundary condition will not deactivate the 

boundary condition, but rather, it will assign the boundary condition a constant head or drain 

level of 0 m. 

When “Constant Head” is selected from the “BCs” drop-down menu, the dialog box in Figure 

7.32 appears. The required data for a constant-head boundary condition are described below. 
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Figure 7.32. The “Constant-Head Boundary” dialog box 

Enable Nonlinear Flow: Option to simulate nonlinear groundwater flow at drains and constant 
heads. If enabled, the user has the option to enable nonlinear flow for every group. If the 
user chooses to use nonlinear flow, they must define the nonlinear flow ratio. The 
nonlinear flow ratio is the ratio of Non-Darcian to Darcian flow; a value of 0 indicates 
the flow is completely Darcian. 

Group Definition: The “Group Definition” portion of the “Constant-Head Boundary” dialog box 
allows the user to define groups of constant-head or drain boundary conditions. 

Constant-head or drain groups are added by clicking the “Add” button at the top of the 
dialog box. With the drop-down box (Figure 7.32), next to the “Activate” checkbox select 
either “Constant Head” or “Drain” to define the type of boundary condition the group 
will be. Each group added will appear in the “Groups” drop-down list shown in Figure 
7.33. The names of each group can be modified as desired, as shown in Figure 7.33. Use 
the “Delete” button to remove unneeded group names, and check or uncheck the “Active” 
box to activate or deactivate constant-head and drain groups. If nonlinear flow is to be 
simulated for the constant-head or drain group, check the box next to “NonLinear Flow” 
and input a value for “Ratio.” 

Constant-head groups allow the user to group constant-head nodes or drain nodes 
together to calculate the flux for each constant-head group (e.g., a set of sub-horizontal 
drain holes or a regional constant-head boundary). Output flux with respect to time is 
calculated for each group and is output in the flow file (.FLW). 
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Figure 7.33. The “Define Group for Constant Heads and Drain Nodes” dialog box  

Node#: The node number where the constant-head boundary condition is defined. 

Group: The constant-head group to which a particular node is assigned. Using the drop-down 
box below “Group Definition,” the user can select any of the constant-head groups. 

Type drop-down list: This drop-down list is located to the right of the “Group” drop-down list. 
It is used to specify the type of constant-head node (constant-head or drain node). 

Head: Constant-head elevation; if constant, varied, or annual, constant-head elevations can 
be edited in the time-series data box on the right side of the “Constant-Head Boundary” 
dialog box. 

Leakance: Leakance factor (square meters per day [m2/day] or square feet per day [ft2/day]). 
Leakance factors can be “Constant,” “Annual,” or “Varied.” These options are available in 
the lower time-series data box on the right side of the “Constant-Head Boundary” dialog 
box. 

Once the constant-head groups are defined, constant-head nodes can be assigned in several 

different ways. First, a “2D Contour” or “3D Contour” plot item can be added and nodes can be 

selected (as described in Section 6.2) to bring up the “Assign Properties for Nodes” dialog box 

shown in Figure 7.34. Here, the boundary conditions for the selected nodes can be modified. 

Once the “Add to Constant-Head Boundary” button is clicked, the user has the option to select 

the constant-head group from a drop-down menu as well as the layers to which the constant 

head will be applied, with the top layer being the one selected in the “Plot Item” attributes 

menu.  
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Figure 7.34. The “Assign Properties for Nodes” dialog box and constant-head groups 

Additionally, constant-head nodes can be created in the “Constant-Head Boundary” dialog box 

(Figure 7.32) in several different ways. First, a “chead.dat” file from a previous model data set 

can be imported using the “Import” button. Also, constant-head nodes can be defined using a 

.BLN file and the “Create” button. This function can be used to quickly create sub-horizontal 

drain holes, which are commonly used in mining operations to minimize pore pressures in 

the pit wall. To use this function, click “Create,” and a “Select BLN File” window opens. Select 

the .BLN file representing the sub-horizontal drain hole and click “OK.” Drain nodes will be 

created at nodes close to the .BLN file. The drain elevation assigned by default to each of the 

drain nodes will be the node elevation. Finally, constant-head nodes can be created manually 

by entering the required parameters in the table. 

Parameters of the constant-head nodes can be edited by group using the “Group” drop-down 

box. When the name of each constant-head group is selected, the nodes composing the group 

appear in the window below the drop-down box. After selecting the desired group, the 

constant-head nodes composing the group can be selected by clicking in the upper left-hand 

corner of the table. Once the nodes in the desired group are selected, they may be edited as a 

group by entering values for “Head” or “Leakance” in the appropriate time-series window. 

When a “Constant Head” or “Drain” record is selected, the time-series dialog becomes active. 

In the time-series dialog, the user is able to import time-series data for constant heads or 

drain nodes. The three options are 1) “Constant,” 2) “Annual,” and 3) “Varied.” These options 

are explained in the beginning of this section. 

7.4.3. Variable-Flux 

The “Variable-Flux” boundary condition is used to specify variable-flux boundary conditions. 

The variable-flux boundary is used to simulate a domain of large extent without the need to 

greatly extend the model domain. The “Variable-Flux” option applies the analytical solution 

for a semi-infinite aquifer to the boundary of the modeled flow domain. To ensure that the 
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variable-flux boundary conditions are implemented properly, the actual boundary of the 

model domain should be far enough from any hydraulic stress so that effects from these 

hydraulic stresses do not reach the variable-flux boundary condition. 

To add a variable-flux boundary condition to the model, add a “2D Contour” or “3D Contour” 

plot item to the View Pane. Next, toggle to the desired node layer using the “Layer” attribute 

of the “2D Contour” or “3D Contour” plot item. Use the “Select” tool from the toolbar to select 

the nodes on the edge of the model domain where the variable-flux boundary condition is to 

be assigned. When the nodes are selected, press the [Enter] key to open the “Assign Properties 

for Nodes” dialog box. Check the radio button next to “Assign to Variable-Flux Boundary”; this 

will activate additional options. The additional options are “All nodes in between 

(counterclockwise) are selected,” which will assign the variable-flux boundary condition to all 

the perimeter nodes of the model domain between two selected nodes in a counterclockwise 

direction, and “From Current Layer # To,” which will assign the variable-flux boundary 

condition from the currently selected layer to the chosen layer. The nodes that have a 

variable-flux boundary condition assigned can be modified using the “Variable-Flux 

Boundary” dialog box under the “BCs” drop-down menu found on the Main Menu banner at 

the top of the screen. The “Variable-Flux Boundary” dialog box is shown in Figure 7.35. The 

information that can be modified for the variable-flux boundary condition is described below. 
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Figure 7.35. The “Variable-Flux Boundary” dialog box 

Node#: The uppermost node number of the variable-flux boundary condition. 

Top Layer: The uppermost layer number in which the variable-flux boundary condition 
begins. 

Bottom Layer: The layer number in which the variable-flux boundary condition ends. 

Option to Apply Constant Flux from Steady-State Simulation: Note that this requires a .DRN file 
from a steady-state simulation. To import the .DRN file, click “Import from DRN File” and 
navigate to the location of the .DRN file using the “Open Variable Flux File” window. 

7.4.4. Pumping Well 

This option is used to specify values for source/sink terms modeled as pumping wells. When 

“Pumping Well” is selected from the “BCs” drop-down menu found on the Main Menu banner 

at the top of the screen, the dialog box shown in Figure 7.36 appears. In MINEDW, there are 

three options available for pumping wells. Pumping wells can be introduced to the model by 



7. MODEL INPUT DATA 
 

 

MINEDW  92 

 

defining pumping rates, specified heads, or pumping rates with an LPE (“Pumping Rate,” 

“Specified Head,” or “Pumping with LPE”).  

Pumping wells can be added to the model by importing a previously created “pumpwells.dat” 

file; the format of this file is discussed in Appendix B. To import the file, simply click on 

“Import” and, using the “Open Pumping File” window that opens, navigate to the location of 

the “pumpwells.dat” file, select it, and click “Open.” Note, if there are any existing wells in the 

“Pumping Well” dialog box, they will be overwritten and replaced with the contents of the 

“pumpwells.dat” file.  

Pumping wells can be created by MINEDW based on x, y, and z data in a .DAT file. To use this 

function, the file should contain three columns of x, y, and z data corresponding to the 

locations of the pumps to be created in the model. Click on the “Create” button and, using the 

“Select DAT file” window that opens, navigate to the directory containing the file with location 

data for the pumps, select it, and click “Open.” MINEDW will select the finite-element node at 

the specified x, y, and z locations, or if no node exists at a location, MINEDW will move the 

closest node to that specified location. The user can then use the “Pumping Well” dialog box 

to modify the screen intervals, pumping rate, and pumping well type.  

Another option for adding pumping wells to the model is to select the nodes where pumping 

wells are to be simulated using a “2D Contour” or “3D Contour” plot item and the “Select” tool 

and then choosing “Add to Pumping Wells” in the “Assign Properties for Nodes” dialog box as 

described in Section 6.2. The user must take care to select the correct node layer in the “3D 

Contour” plot item where the pumping well is to be simulated. For example, if the user 

inadvertently uses the top node layer, the pump or sink will be simulated at the top of the 

model domain and will likely be ineffective at removing groundwater from the system. Also, 

the user will have to specify the screen intervals, pumping well type, and pumping rates in 

the “Pumping Well” dialog box after adding pumping wells using this method. 
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Figure 7.36. The “Pumping Well” dialog box 

In MINEDW, a “Pumping Rate” well allows the user to specify the exact pumping rates they 

want to use for a model simulation. This type of pumping well is useful for a model calibration 

simulation when field-recorded pumping-rate data are available. As mentioned above, using 

a “Pumping Rate” well may dry out the groundwater system within the vicinity of the pumping 

well if the pumping rate is too large or the hydraulic conductivity values assigned are too low. 

MINEDW will print a warning to the “MINEDW.err” file if this occurs during a model 

simulation, but it is the user’s responsibility to check this file, as MINEDW does not stop 

running when this occurs.  

“Pumping Rate” wells have the option to move to the first wet node if the node where the 

pump is located becomes dry. This option should be exercised with care, as MINEDW will 

continue to move the pumping node lower, which may result in the pumping node moving to 

the bottom of the model domain. A pumping node located at the bottom of the model domain 

(on a no-flux boundary) is incorrect, as pumping stresses should not propagate to a boundary 

condition. If the user wishes to use this option, they are advised to check that pumping 

stresses never intersect other user-defined boundary conditions as the pumping node moves 

downward. To activate this option, check the box next to “Well (Pumping Rate only) will be 

moved to first wet node when dry,” and the nodes defined as a “Pumping Rate” well will be 

moved to the next wet node when the pumping nodes become dry. 

“Enable Nonlinear Flow” enables nonlinear flow for pumping wells. If this option is enabled, 

the “Nonlinear” field will become visible in the “Pumping Well” dialog box. Each well where 
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nonlinear flow is to be simulated will need to be enabled individually. The required 

information for the “Pumping Well” dialog box is described below. 

Name: Name of the pumping well. 

Node#: Identity of node in the pumping data set. 

Type: Switch for the type of pumping well (options available are “Pumping Rate,” “Specified 
Head,” and “Pumping with LPE”). 

Screen Top: Elevation of screen top (in meters or feet). 

Screen Bottom: Elevation of screen bottom (in meters or feet). 

Level: Defined as either the LPE or the specified head depending on the type of well defined. 

Nonlinear: Enables nonlinear for the selected well. 

Ratio: The ratio to use for nonlinear flow. 

After selecting a pumping well in the “Pumping Well” dialog box, the time-series menu 

becomes active, as shown in Figure 7.36. In this menu, the user can import time-series data 

for each type of pumping. The three options are “Constant,” “Annual,” and “Varied” (as 

described in Section 7.4.1). 

 “Specified Head” pumping wells are analogues to drains because they can be used to achieve 

a specific-head value within the groundwater system surrounding the well by extracting the 

necessary amount of water. Unlike drains, however, no leakance values need to be defined 

for “Specified Head” wells. “Specified Head” wells are often used in predictive simulations to 

evaluate dewatering requirements. When used for this purpose, the objective is to achieve 

the dewatering needs of the project and quantify the amount of water that will need to be 

extracted to achieve the dewatering target. After quantifying the dewatering requirements, 

the physical well can be designed to achieve the simulated pumping rates. However, if a 

“Specified Head” well is used to simulate an existing well, it would be prudent to ensure that 

the calculated pumping rates of the simulated well do not exceed the maximum pumping rate 

of the physical well. 

Finally, the “LPE” well, which is typically used in a predictive simulation, is defined by 

assigning a pumping rate to the well and the LPE. The LPE allows the user to specify the 

minimum allowable head in a well. If the head within the well is equal to or less than the LPE, 

the pumping rate will be reduced in order to maintain the LPE until the head exceeds the LPE. 

If the head exceeds the LPE, then the “LPE” well will pump at the rate defined by the user. 

This feature allows the user to ensure that a proper water-column height is maintained or 

that the groundwater system does not become dry due to either high pumping rates or low 

permeability. If an “LPE” well is used during calibration, the user should compare pumping 

rates printed in the .FLW file with those that were assigned. If rates in the .FLW file are less 

than the rates that were assigned, this may indicate that the hydraulic parameters assigned 

to the model are too low. Conversely, assigning maximum pumping rates to “LPE” wells 
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during predictive simulations allows the user to determine the maximum pumping rates that 

can be sustained with the assigned hydraulic parameters.  

7.4.5. Rivers 

The “River” boundary condition is used to simulate interactions between a routed river and 

an aquifer. The routed-river function uses Manning’s equation to calculate the flow in an open 

channel. A given reach of the river is represented by a node and corresponding reach length. 

Each reach is connected to the next reach by sequencing the nodes from upstream to 

downstream. River-groundwater system interactions are simulated by comparing the head 

in the groundwater system to the head in the river over time and by transferring water across 

the riverbed accordingly. Rivers can be connected to form a river network. External sources 

of water to rivers are termed “tributaries.” 

The physical accuracy of a river’s representation depends upon the number of nodes used to 

resolve the geometry of the river in plan view and the physical coefficients used to calculate 

gains and losses to and from the river.  

When “River” is selected from the “BCs” drop-down menu on the Main Menu banner at the 

top of the screen, the dialog box shown in Figure 7.37 appears.  

 

Figure 7.37. The “River” tab of the “River” dialog box 

Rivers are defined by clicking the “Add” button at the top of the “River” tab of the “River” dialog 

box. Unlike boundary conditions such as pumping wells, constant heads, drains, or variable-
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flux boundaries, rivers cannot be created using any plot items. A river can only be created in 

the following two ways: 

1. From a “BLN” File: This is done by clicking the “Create” button on the lower right of the 
“River” tab, which opens the “Select BLN file” dialog box. After selecting the appropriate 
.BLN file, click “Open” and MINEDW automatically selects the appropriate nodes based 
on distance from the .BLN defined line. MINEDW then calculates the riverbed elevations 
and the elevation difference between the upstream and downstream node.  

2. Manually: The user can manually enter node numbers; riverbed elevations can then be 
automatically generated by MINEDW using the “Follow Topo” button. 

For any river, the user has the choice of calculating the slope based off the topography using 

“Follow Topo,” which is the default setting, or applying a “Constant Slope.” For the “Constant 

Slope” option for the entire river channel, the “Slope” box will become active and the “Bed 

Elev.” column of the table will no longer be visible. The slope of all segments of the river will 

be constant. If the “Constant Slope” option is used, then the “First (Lowest) Node Bed Elevation” 

is used as a reference to calculate other bed elevations. When using “Constant Slope,” if the 

river is connected to another river, the elevation of the node that forms the river connection 

is used as the reference elevation rather than the “First (Lowest) Node” and “Bed Elev.” 

For each river, the “Manning Coefficient.” river channel “Width,” “First (Lowest) Node,” “Bed 

Elev.,” and bed hydraulic conductivity must be defined. The following is an explanation of the 

required information: 

Manning’s Coefficient: Empirical coefficient for river depth [TL-1/3]. 

Width: Coefficient for river width [L]. 

First (Lowest) Node: The node number of the lowest node, which should correspond to the 
first node forming the river. 

Bed Elev.: The elevation of the riverbed at the downstream node forming the river [L]. 

Additionally, for each node composing the river, the following must be defined: 

Node: The node number for nodes forming the river. 

Riverbed elevation: The elevation of the riverbed at the node (optional if “Constant Slope” is 
used) [L]. 

Bed Conductivity: The riverbed hydraulic conductivity [LT-1]. 

Output: Option to print simulation results for the node to the output file. At a minimum the 
results at the end node, or any connected node, will be printed out. 

Next, “Tributaries” are entered. “Tributaries” are inflows of water to the river and can be used 

to simulate inflow from outside the model domain or discharge from an outfall such as a lined 

channel, pump, etc. inside of the model domain. The flow from a tributary can be “Constant,” 

“Annual,” or “Varied.” Figure 7.38 shows the “Tributary” tab of the “River” dialog box. 
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Figure 7.38. The “Tributary” tab of the “River” dialog box 

Tributaries are added by clicking the “Add” button at the top of the window and specifying 

the node at which the inflow occurs. The start date of the inflow and the amount of inflow in 

m3/day or cubic feet per day (ft3/day) can be specified in the time-series table on the lower 

right. The graph to the left of the table shows the inflow values over time. A time series may 

be imported as a .DAT file using the “Import Series” button.  

The last tab in the “River” dialog box, shown in Figure 7.39, describes the connections 

between individual rivers and between rivers and tributaries. The user does not need to 

specify the connection points but can check here to ensure that the rivers and tributaries are 

connected correctly. If any changes to the river network have been made or a new river 

network has been created, clicking the “Refresh” button redefines the connections. 



7. MODEL INPUT DATA 
 

 

MINEDW  98 

 

 

Figure 7.39. The “Connection” tab of the “River” dialog box 

7.4.6. Recharge 

MINEDW can simulate temporal and spatial variation in recharge. Spatial variation in 

recharge can be added to a MINEDW model by creating any number of recharge zones and 

applying those zones to the model domain. Time-series precipitation data can be used to add 

temporal recharge information to each zone. With MINEDW, the user can also create zones 

with orographically controlled recharge, which may be useful for mountainous regions.  

When “Recharge” is selected from the “BCs” drop-down menu on the Main Menu banner at 

the top of the screen, the dialog box shown in Figure 7.40 appears. To create a recharge zone 

with only temporal variation in recharge, select the “Temporal” tab and then choose 

“Constant,” “Annual,” or “Varied” for the type of time-series recharge data that will be defined. 

Next, define the start date and recharge rate in the box below. Note that if the elevation 

function for recharge is used, then the values defined in the time-series window will not be 

precipitation rates but rather will be scaling factors. The elevation function for recharge and 

scaling factors that can be applied are explained on the following pages. A time-series chart 

appears in the window to the left, displaying the defined data. Note that the units used in this 

dialog box are specified in the uppermost portion of the window. 
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Figure 7.40. The “Recharge” dialog box showing the “Temporal” tab 

The “Elevation” tab in the “Recharge” dialog box allows the user to create zones of 

orographically controlled recharge. Using this method, the net recharge to the groundwater 

system can be calculated as a percentage (0–100%) of the total precipitation that falls in 

orographically controlled precipitation zones. This method works well for groundwater 

models that include mountain and valley systems. 

Orographically controlled precipitation is calculated using a nonlinear relationship between 

precipitation and ground-surface elevation. Parameters for the equation below can be 

estimated by fitting the equation to observed precipitation for a range of elevations. The 

relationship is defined as follows: 

𝑃𝑟𝑒𝑐𝑖𝑝𝑖𝑡𝑎𝑡𝑖𝑜𝑛 =  𝐴 + 𝐵 ∗ 𝑧𝑐   

where 

𝐴 = 𝑖𝑛𝑡𝑒𝑟𝑐𝑒𝑝𝑡 [𝐿/𝑇]  

𝐵 = 𝑐𝑜𝑛𝑠𝑡𝑎𝑛𝑡 [𝐿−𝑐]  

𝑐 = 𝑛𝑜𝑛𝑙𝑖𝑛𝑒𝑎𝑟 𝑠𝑐𝑎𝑙𝑖𝑛𝑔 𝑓𝑎𝑐𝑡𝑜𝑟 [−] 

𝑧 = 𝐸𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛 [𝐿] 

To activate this option, select the “Elevation” tab and check the box next to the elevation-

based precipitation equation and define the required parameters in the now active dialog 
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boxes (Figure 7.41). Below the area where the parameters for the elevation-based recharge 

equation are defined is a window where elevation factors can be defined. These factors can 

be used to specify the percentage of total precipitation, calculated by the elevation-based 

precipitation equation above, that will be applied as recharge to the aquifer for a specific 

elevation band. For example, consider two different elements with average elevations of 800 

and 1,500 m and calculated precipitations of 25 and 80 centimeters per year (cm/yr), 

respectively. Supposing that two elevation factors were defined as displayed in Figure 7.41, 

then recharge for the first and second elements would be 8.75 and 60 cm/yr, respectively. 

The following equation shows how these recharge values are calculated. 

Recharge calculated using elevation factors: 

𝑅𝑒𝑐ℎ𝑎𝑟𝑔𝑒 = 𝑃 ∗ 𝐸𝐹 =  (𝐴 + 𝐵 ∗ 𝑧𝑐) ∗ 𝐸𝐹  

where 

𝑃 = 𝑝𝑟𝑒𝑐𝑖𝑝𝑖𝑡𝑎𝑡𝑖𝑜𝑛 [
𝐿

𝑇
] 

𝐸𝐹 = 𝐸𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟 [−] 

 

Figure 7.41. Defining parameters for elevation-based recharge 

Temporal factors can also be applied to precipitation calculated via the elevation-based 

precipitation equation. Temporal factors can be applied in addition to ground-surface 

elevation factors. To define temporal factors, first activate the elevation-based precipitation 

equation on the “Elevation” tab, define the necessary parameters, and, if desired, define 
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elevation factors. Next, select the “Temporal” tab and create the temporal factors. Temporal 

factors are defined similarly to temporally varying recharge, as described at the beginning of 

Section 7.4.1. The options for temporal factors are “Constant,” “Annual,” and “Varied.” For 

illustration purposes, suppose that recharge to an aquifer during winter is reduced because 

precipitation falls as snow and sublimates rather than melting and infiltrating. In order to 

account for this phenomenon in the model, the user could define temporal factors to reduce 

recharge during the winter months. Figure 7.42 shows an example of how the user might 

define these annually repeating temporal factors. For January and February, the recharge to 

the aquifer is 25% of what is calculated by the elevation-based precipitation equation, 

whereas for March, April, and May, it is 50% of precipitation. For summer months and into 

fall, recharge is 100% of precipitation, and, finally, for late fall into early winter, recharge is 

75% of calculated precipitation. If elevation factors are also defined, then recharge will first 

be adjusted by the appropriate elevation factor and then by the temporal factor. The following 

equations show how recharge is calculated using only temporal factors as well as temporal 

factors with elevation factors. 

Recharge calculated using temporal factors: 

𝑅𝑒𝑐ℎ𝑎𝑟𝑔𝑒 = 𝑃 ∗ 𝑇𝐹 =  (𝐴 + 𝐵 ∗ 𝑧𝑐) ∗ 𝑇𝐹  

where 

𝑇𝐹 = 𝑇𝑒𝑚𝑝𝑜𝑟𝑎𝑙 𝐹𝑎𝑐𝑡𝑜𝑟 [−] 

Recharge calculated using elevation and temporal factors: 

𝑅𝑒𝑐ℎ𝑎𝑟𝑔𝑒 = 𝑃 ∗ 𝐸𝐹 ∗ 𝑇𝐹 = ((𝐴 + 𝐵 ∗ 𝑧𝑐) ∗ 𝐸𝐹) ∗ 𝑇𝐹  

As previously noted, the values defined in the time series section of the “Temporal” tab of the 

“Recharge” dialog box represent scaling factors if the elevation function is activated. If the 

elevation function is not used, then these values will be used by the model as precipitation 

rates. 
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Figure 7.42. Defining temporal factors for elevation-based recharge 

If the “Recharge will be applied to first wet layer” box is checked, then recharge is applied 

directly to the first wet layer; otherwise, it is applied to the top layer. 

The required information for recharge zones is described below. 

Zone: Number of recharge zones. Two options are available: constant (recharge is simulated 
constant over time) and time varied (recharge is simulated variable over time). 

Date: Time. 

Rate: Recharge rate (millimeters per day [mm/day] or feet per year [ft/yr]). 

To assign the created recharge zones, add a “2-D Plane” plot item to the View Pane and select 

“Recharge” as the “Color By” option. Click the “Select” tool in the “Tool Bar” and then select the 

elements where the first recharge zone is to be assigned. Press [Enter] when the selection is 

complete, and select the appropriate recharge zone in the drop-down list and click “OK” to 

complete the assignment. Repeat these steps until all the zones have been assigned.  

7.4.7. Evaporation 

The “Evaporation” boundary condition is used to simulate the discharge of groundwater from 

a shallow water table due to evapotranspiration from vegetated areas or evaporation from a 

bare-soil area. In this option, the evapotranspiration rate depends on the local depth to the 

water table, the extinction depth, the potential evapotranspiration rate, and the size of the 

evaporation zone. The simulation assumes that discharge is linearly related to the depth from 
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just below the ground surface down to the water table. The linear relation holds until a 

maximum depth is reached; this is the extinction depth. At the extinction depth, 

evapotranspiration (or evaporation) ceases, and its value is zero for any depth greater than 

the extinction depth. 

When “Evaporation” is selected from the “BCs” drop-down menu on the Main Menu banner 

found at the top of the screen, the dialog box shown in Figure 7.43 appears. The required 

information for evaporation zones is described below. Similar to recharge zones, evaporation 

parameters must be defined prior to applying them to the model. 

 

Figure 7.43. The “Define Evaporation Zones” dialog box 

Depth to Zero ET: Extinction depth (depth below which there is zero evapotranspiration). 

Maximum ET Rate: Maximum evapotranspiration rate (m/yr or ft/yr). 

Multiplier of ETMAX: ETMAX is defined as the maximum evapotranspiration rate. This defines 
the multiplication factor of maximum evaporation for the time step. The multiplier of 
ETMAX can be defined as time-series data. The three options are constant, annual, and 
varied. Each is explained in the time-series data section (Section 7.4.1). 

After defining the evapotranspiration zones, the plot item “2-D Plane” should be selected from 

the list provided in the “Control Panel.” In the “Color By” attribute, select “Evaporation.” Now, 

using the “Select” tool (see Chapter 6), elements can be selected and the newly created 

evaporation zones can be applied to the elements.  
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7.5. Initial Conditions 

To solve the groundwater flow equation, MINEDW requires an initial estimate for the head 

values (initial conditions). The initial conditions can be specified by either defining a 

constant-head value or reading varied head data from a file created in a previous model run. 

To define the initial conditions, select “Initial Heads” from the “Project” drop-down menu on 

the Main Menu banner found at the top of the screen, and the dialog box shown in Figure 7.44 

appears. 

 

Figure 7.44. The “Set Up Initial Head” dialog box 

Constant: The initial head for all the nodes is a constant value, which is input in the field 
provided. 

Varied: The initial head for all the nodes is imported from a file created by a previous model 
run. MINEDW records the groundwater head for the entire model domain at the last 
time step of a model run in an .MDL file. This is done for both steady-state and transient 
model simulations. To use this information as the initial condition for a subsequent 
model run, click on “Varied” and then the “…” button to the right. Select the .MDL file 
from the folder where MINEDW previously ran (it must be the same model domain). 
The format of the .MDL file is 10 columns of head data. The length of the file will vary 
with the size of the model, but the head value corresponds to the nodes in the model 
beginning with the first node and ending with the last node, reading from left to right 
and top to bottom. 

7.6. Mining Plan 

MINEDW can simulate the progressive excavation of an open-pit mine. The simulation of 

open-pit excavation is performed by collapsing the elements (i.e., changing the z coordinates 

of nodes) in the finite-element mesh. The shape of the excavation is defined by the mine plan, 

usually provided as a 3-D .DXF file, and the excavation of the mine over time is simulated by 

interpolating between known pit geometries. There are two spatial interpolation options that 

can be used to calculate the new z coordinates of nodes as they are moved over time; these 

are explained in Section 7.6.1. The way in which the open-pit mine is excavated is based on 

either depth or volume, which is explained in the following paragraphs. Within the pit extent, 

a finer mesh area improves the accuracy of the simulated seepage face and pore-pressure 

distributions behind the pit wall. 
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To create a mining plan, select the “Mining” drop-down menu and then the “Create Mining 

Plan” function (Figure 7.45). 

 

Figure 7.45. The “Mining” drop-down menu 

As described, the shape of the open pit is defined by XYZ data that may be provided as 3-D 

.DXF files by the mine for specific points in time. To simulate the excavation of the open pit 

between these known geometries, MINEDW provides two methods: depth and volume. 

Depth-based excavation simultaneously moves the pit surface outward in all directions, as 

shown in Figure 7.46. This is done by calculating the distance between two known open-pit 

geometries and dividing the distance by the number of time steps between the two dates 

associated with the geometries.  

 

Figure 7.46. Pit geometry when using “Depth”-based excavation 

Volume-defined excavation will move the pit surface downward, rather than outward, 

toward the next known pit geometry, as shown in Figure 7.47. This is done by calculating the 

total volume to be excavated between two known geometries and dividing the volume by the 

number of time steps between the two dates associated with the geometries. This rate defines 

the volume of material excavated for each time step.  
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Figure 7.47. Pit geometry when using “Volume”-based excavation 

The “Create Mining Plan…” function will allow the user to combine both excavation methods 

when creating a mining plan only if open-pit geometries are provided.  

7.6.1. Creating a Mining Plan 

MINEDW provides the user with two options for entering the mine-plan information, which 

is used to create the mining-plan file used to simulate progressive excavation of an open pit. 

The first option is to provide XYZ data of the open pit over time in .DAT files (Section 7.6.1.2.). 

The second option is to provide XYZ data of the pit at the end of mining (ultimate pit) and pit-

bottom elevations through time (Section 7.6.1.3). 

If the XYZ data for pit topography is provided in 3-D .DXF files, they will need to be converted 

into .DAT file format before they are used to create a mining plan. The Rhino “Drop” function 

can be used to achieve this or any other program that is capable of manipulating .DXF files. 

Alternatively, MINEDW provides a function that can be used to convert .DXF files to .DAT file 

format (Section 7.6.1.1).  

To create a mining plan, from the Main Menu banner click “Mining,” then select “Create Mining 

Plan.” The “Create Mining Plan” dialog box shown in Figure 7.48 appears.  
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Figure 7.48. The “Create Mining Plan” dialog box 

In this menu, mining plans can be created using the following options: 

Interpolated With: Select “Depth” or “Volume” methods for temporal interpolation.  

Input Data Directory: The file path to the location where input files are located must be 
entered here. Two options are available: manual entry, or by clicking the “…” button, 
which opens the “Select Directory” dialog box. The "Select Directory" dialog box can be 
used to navigate to where the input files reside. 

Start Date: Define the start date of the mining stage. 

End Date: Define the end date of the mining stage. Periods of no excavation between mining 
stages can be created simply by ensuring that the start date of the next mining stage 
does not correspond with the end date of the previous stage. The mining periods for 
each of the stages, however, cannot overlap. 

Ultimate-Pit Outline File: Enter pit boundary file name. This file is required to be in a .BLN 
format. 

Add: Add additional records to be used in the mining plan. 

Insert: Insert additional records to be used in the mining plan. 

Delete: Delete records used in the mining plan. 

Open: Open a mining-schedule file that contains a list of records to be used in a mining plan. 
The file format for a mining-schedule file is described in Appendix B.  
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Save: Save a mine plan file. This will save the records of the mining plan to a file that can be 
imported again with the “Open” option. 

Options: Menu defining mining-plan spatial-interpolation options. MINEDW uses inverse 
distance weighting or kriging interpolation methods to create the progressive 
excavation of the open pit from data files that are provided by the user. The 
interpolation methods can be changed in the options menu of the “Create Mining Plan” 
menu. The options menu is displayed in Figure 7.49 below. 

 

Figure 7.49. The “Mining Plan Interpolation” dialog box 

This menu has the following options: 

Inverse Distance: Option to use the inverse-distance method for interpolation. 

Kriging: Option to use the kriging method for interpolation. 

Number of Points to Search: Data points to use in the kriging or inverse-distance method. 

Power: Power used in the inverse-distance method. 

Range: Range used in the kriging method. 

Elevation Increase Is Not Allowed: Option that does not allow elevation increases in the 
interpolation method.  

Duplicate Data Keep: Option to determine which elevation is valid if two elevations exist at 
one point in one .DAT file. The user can either keep the minimum elevation, maximum 
elevation, or an average of the elevations. 

7.6.1.1 Converting .DXF to .DAT files  

Any .DXF file that will be used to create a mine plan needs to be converted to an XYZ data file 

(.DAT). To do so, on the “List” tab, double-click “File Data,” then double-click “DXF.” The 

“Attributes” tab appears. Select the “+” next to the “File” attribute as shown in the green box 

in Figure 7.50, and the “Select DXF data file” dialog box opens. Navigate to the location of the 

desired .DXF file, select it, and click “Open.” Next, select the icon next to “To Data File” to save 
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the information from the .DXF file as a .DAT file. Repeat the same procedure for all mining 

.DXF files that are to be used in the mine plan. For .DXF files that have multiple layers, the 

user may choose the layers that will be used for the mine plan by activating or deactivating 

the layers using the “Layers” attribute. 

 

Figure 7.50. Reading a .DXF file and saving as a data file 

For any pit plan that is created in MINEDW, a pit outline is needed (e.g., the ultimate-pit 

boundary) to define the nodes that will be used for interpolation. This boundary needs to be 

defined using a .BLN file format and is always the first record in the mine plan file. This file 

defines the perimeter of the pit and does not contain elevation information because all 

elevations are assumed to be the top of the mesh. 

Note: All of the .DAT files that are used to create the mining plan file must be located in the 

same directory. 

7.6.1.2 Creating a Mining Plan from Pit Topography files 

The following is a guide to creating a mining plan and schedule based on XYZ data of pit 

topography stored in .DAT files.  

From the Main Menu, click “Mining,” and then select “Create Mining Plan.” Enter the file path 

to where the pit topography files (.DAT file format) are located in the “Input Data Directory” 

box. Enter the name of the ultimate-pit boundary file in the “Ultimate Pit Outline File” box. 
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Next, click “Add” to add a record to the “Create Mining Plan” dialog box for each of the pit 

topography files. For each of the pit topography files, enter the file name and the 

corresponding start and end date, and choose “Depth” or “Volume” under “Interpolated With.” 

Next, enter a name for the new mining plan file in the “Created Mining Plan File Name” box or, 

to select a different directory than the directory where the mining files are located, click the 

button next to the data entry box and select the desired file location and enter a file name 

(Figure 7.51). 

Alternatively, the data detailed in the above steps can be imported from a “Mine Plan File.” If 

a “Mine Plan File” is available, click “Open…” in the “Create Mining Plan” dialog box and 

navigate to the location of the “Mine Plan File.” Select it and then click “Open.” The directory 

path, mining start date, ultimate-pit boundary file name, pit-geometry files, and associated 

dates will be populated. The default for “Interpolated With” is “Depth.” If the “Volume” method 

is desired, then be sure to select it for the appropriate mining stages. Finally, enter a name for 

the new mining plan file in the “Created Mining Plan File Name” box or, to select a different 

directory than the directory where the mining files are located, click the button next to the 

data entry box and select the desired file location and enter a file name. 

 

Figure 7.51. The “Create Mining Plan” dialog box with pit plan 

When the appropriate data have been entered in the “Create Mining Plan” dialog box, click 

“OK” and MINEDW creates the mining file. The file will need to be imported into the model 

using the “Open Pit…” menu, which is discussed in more detail in Section 7.6.2. 
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7.6.1.3 Creating a Mining Plan from Final-Pit Topography 

From the Main Menu banner, click “Mining,” and then select “Create Mining Plan.” Next, enter 

the name of the ultimate-pit boundary file in the box next to “Ultimate Pit Outline File.” Click 

“Add” to add a record to the “Create Mining Plan” dialog box and enter the name of the .DAT 

file containing the ultimate-pit topography. Enter the appropriate start and end date and file 

name under “Date” and “File,” respectively, for the ultimate pit. 

Click “Insert” to add records above the previously created record. For these newly created 

records, enter the pit-bottom elevation and the start and end date in the “File/Elevation,” 

“Start Date,” and “End Date” columns (Figure 7.52).  

 

Figure 7.52. The “Create Mining Plan” dialog box with pit plan 

Once the appropriate data have been entered in the “Create Mining Plan” dialog box, click 

“OK” to create the mining plan file.  

7.6.2. Importing a Mine Plan into MINEDW 

After creating the mine plan, select “Open Pit” in the “Mining” drop-down menu to assign the 

mining file to the model. After the “Open Pit” dialog box opens (Figure 7.53), click “Add” and 

browse to the mining plan file; select it and click “Open” in the “Open Mining Plan File” dialog 

box. 
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Figure 7.53. The “Open Pit” dialog box 

For each pit, there are four different menus: 1) “General,” 2) “Pit Lake,” 3) “ZOR,” and 

4) “Backfilling.” Under the general tab, pit-plan information is provided, including the pit 

name, the start and end dates, and the pit-bottom elevations. In this menu, the user can open 

a different mining file using the “Replace with” command or create a different mining plan 

using the “Create” command. Under the other three tabs, a pit lake (Section 7.6.3), a zone of 

relaxation (ZOR) (Section 7.6.4), and backfilling (Section 7.6.5) can be defined.  

Once a mining plan has been imported into MINEDW, the user may visualize the open-pit 

excavation through time by selecting the “List” tab in the “Control Panel” Pane on the right-

hand side of the Main Menu and adding a “3-D Element” plot item. The mesh will be displayed 

in the View Pane in plan view with geological units. To view pit excavation at a particular time 

step, enter the time-step number in the box on the time-step slider; otherwise, click on the 

time-step slider (Figure 7.54) and move it to the right to view the progressive excavation of 

the pit through time.  
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Figure 7.54. Time-step slider 

The collapsed mesh showing the open pit with geology will be displayed in the View Pane, as 

shown in Figure 7.55. 

 

Figure 7.55. The collapsed mesh showing the open pit with geology 

The elevation change in the pit area through time can be visualized by selecting the “List” tab 

in the “Control Panel” Pane on the right-hand side of the Main Menu banner. Expand the 

“Node” item and double-click “3-D Contour.” The mesh will be displayed on the View Pane in 

plan view with elevation values. You can deactivate and activate “3-D Element” and “3-D 

Contour” to switch between the views at desired time steps to visualize the changes in both 

geology and elevation.  

Mining plans for any model simulation can be activated and deactivated by unchecking the 

“Activate” checkbox. Click “OK” to save the changes and exit the “Open Pit” dialog box.  

7.6.3. Pit Lake 

When mine operations cease, a pit lake can form if the pit bottom is below the pre-mining 

water table. To simulate the pit-lake formation in MINEDW, select “Open Pit” from the 

“Mining” drop-down menu. In the “Open Pit” dialog box (Figure 7.56), select the pit plan that 

a pit lake forms under, and then select the “Pit Lake” tab and check the box next to “Activate.” 

To define a pit-lake simulation, enter a date in the “Start Date” box for the start of the pit-lake 
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formation, an “Initial Lake Elevation,” “Evaporation” rate (if any), and the “# of Stages” in the 

lake. These options are described in more detail below.  

 

Figure 7.56. The “Pit Lake” tab 

The following are options are available in the “Pit Lake” tab: 

Start Date: Date of when pit-lake infilling will begin. This date must be after mining has ended 
and equal to or later than the backfilling date if backfilling is applied. 

Initial Lake Elevation: This value must be equal to or greater than the minimum pit elevation 
or the pit bottom after backfilling operations. In the case of a sump or area of the pit that 
already holds water at the start of pit-lake formation, you would enter an “Initial Lake 
Elevation” greater than the pit bottom. 

Evaporation: Evaporation rate of the pit lake (millimeters per year [mm/yr] or ft/yr). 

# of Stages: Number of stages to be used in the simulation. The user must specify the 
“Elevation” of each stage in the dialog box below the input for the number of stages. 
MINEDW will calculate the “Area” and “Volume” of the stages.  

Create: The “Create” function will automatically calculate the area and volume of each stage 
based on the “# of Stages” the user selects. 

Import: Using the “Import” function, the user can import a pit-lake file. 

Additional Pump/Recharge: Switch for additional sources of discharge (-) or recharge (+) 
(excluding groundwater seepage) when the elevation is lower than a user-specified 
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elevation. When the pit-lake recharge option is activated, click the “Define Rate” button 
and a new menu (Figure 7.57) will appear. In this menu, the user can define any 
additional recharge and pumping to/from a pit lake based on time-series data. 

 

Figure 7.57. Pumping/recharge menu for a pit lake 

7.6.4. Zone of Relaxation for Pit 

In MINEDW, a ZOR can be created around excavations, backfilling operations, longwall coal 

mining, room-and-pillar coal mining, freeze-thaw conditions, or other scenarios in which 

hydraulic conductivity may change during the simulation period.  

To create a ZOR for an open pit, select “Open Pit” from the “Mining” drop-down menu. Select 

the open-pit plan from the drop-down box on the upper left-hand corner of the dialog box 

and then select the “ZOR” tab (Figure 7.58). 
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Figure 7.58. The “Open Pit” dialog box with “ZOR” active 

MINEDW offers two options for specifying the thickness and shape of the ZOR: as a ratio of 

the pit depth or by user-defined thicknesses.  

Using the first option, the user can further subdivide the ZOR into layers that are also defined 

using a thickness that is calculated as a ratio of the pit depth. This results in a ZOR that has a 

minimum thickness at the perimeter of the pit and thickens toward the center of the pit 

(Figure 7.59). Layering within the ZOR is defined in percentages of the total ZOR. The sum of 

user-defined percentages must be less than or equal to 100. In either case, MINEDW will add 

a layer such that the “ZOR Definition” dialog box will always contain n + 1 ZOR layers (where 

n is the number defined by the user) (Figure 7.58). The input file created by MINEDW will 

always contain n + 1 layers, but the layer added by MINEDW will only be used if the user-

defined percentages are less than 100. For example, in a 120-m deep pit with a ZOR thickness 

equal to ¼ of the pit depth, the ZOR will have a maximum thickness of 30 m. The ZOR can 

then be divided into two equal layers by entering “2” in the box next to “# of Additional ZOR 

Layers” and then entering “50%” for both layers. When “Search Zone” is clicked, MINEDW 

adds an additional layer for a total of three ZOR layers, as displayed in Figure 7.59a. The ZOR 

layers that are used in the simulation are “Layer#1” and “Layer#2.” The layer added by 

MINEDW, “Layer#3,” is not used. Alternatively, the ZOR could have been created by creating 
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one ZOR layer, entering “50%” for the layer, and then clicking “Search Zone.” In this scenario, 

the layer created by MINEDW is used and accounts for the remaining 50% of the ZOR (Figure 

7.59b). Also, it is important to remember that, when MINEDW searches for geological units 

within the ZOR, it displays all the units for each layer even though the unit may not form part 

of the ZOR. For example, if the model contains a surficial unit such as alluvium that does not 

form part of the ZOR, it will be shown in the ZOR dialog window but can be excluded by using 

a factor of 1 for the hydraulic conductivity multiplier.  

 

Figure 7.59. Defining the ZOR. A) Default layer is inactive, B) Default layer is active 

Using option two, in which the user defines the absolute thickness, the user specifies the 

number of layers in the ZOR and the thickness (m or ft) of each layer. The sum of these layers 

will be the ZOR thickness no matter the pit depth, as shown in Figure 7.60.  
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Figure 7.60. Defining the ZOR thickness using absolute thickness layers. 

To create a ZOR using option one, click the “ZOR thickness = 1/ of Pit Depth” checkbox to 

activate the ZOR thickness proportionality option and then choose an appropriate ratio. Next, 

define the number of layers to use in the ZOR using the toggle buttons next to the “# of 

Additional ZOR Layers” box or by typing in a number. After that, specify the thickness as a 

percentage for each ZOR layer, keeping in mind that the cumulative sum of percentages must 

not exceed 100. MINEDW will provide the user a warning if the cumulative sum is greater 

than 100%. Layers are ordered from top down, where the top layer forms around the pit 

surface. Once layer percentages are defined, click the “Search ZOR Units” button and MINEDW 

finds the geological zones that lie within the defined ZOR. The “ZOR Definition” box, at the 

right (Figure 7.58), will contain the results.  

To create a ZOR using option two, define the number of layers to use and the thickness of each 

layer, then click “Search ZOR Units.” 

For either method, factors of the original hydraulic conductivity values are entered in the 

columns labeled “Layer#1,” “Layer#2,” etc. After finishing, click “Create ZOR” to create the 

ZOR for the open pit and then check the box next to “Activate” at the top left of the “Open Pit” 

dialog box. Click “OK” to save the changes and close the “Open Pit” dialog box. 

Once a ZOR has been created, it can be visualized by selecting the “List” tab in the “Control 

Panel” Pane on the right-hand side of the Main Menu banner. Expand the “Element” item and 

double-click “Time Varied Conductivity” (Figure 7.61). 

If the mining plan is modified or replaced with a different mining plan, the ZOR will need to 

be recreated.  
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Figure 7.61. ZOR in the model 

7.6.5. Open-Pit Backfilling 

MINEDW can simulate open-pit backfilling. Backfilling may be used in some mining 

applications to prevent the formation of a pit lake or to dispose of tailings after mining has 

ceased. To use this option, select “Open Pit” from the “Mining” drop-down menu. Select the 

desired pit plan on the left and then click the “Backfilling” tab (Figure 7.62). Check the 

“Activate” box and define the “Implement Date” for backfilling. The “Implement Date” of 

backfilling must be before or the same time as the “Start Date” of pit-lake formation. MINEDW 

does not support the backfilling of an existing pit lake and automatically adjusts the “Start 

Date” or “Implement Date” for pit-lake or backfilling operations to prevent backfilling of a pit 

lake. Backfilling operations are simulated in one time step rather than progressive backfilling 

over multiple time steps. The backfill elevation can be defined as constant by checking the 

“Constant Elevation” option and entering a value. Otherwise, if more detailed information is 

available for the backfill, “Varied” can be checked and the file containing elevation 

information, in .DAT file format, can be selected in the “Open Data File” dialog box that opens. 

In the “Grid” dialog box, choose the interpolation method and enter the appropriate 

parameters. The surface for the backfill is then created. Finally, the hydraulic parameters for 

the backfill can be selected from the drop-down list (Figure 7.62). The entire backfilled zone 

will have the same hydraulic properties and cannot be subdivided. When the “Backfilling” 

parameters are completely defined, click “OK” in the “Open Pit” dialog box to ensure that the 

changes are saved. 
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Figure 7.62. The “Backfilling” tab available in the “Open Pit” dialog box 

 7.6.5. Zone of Relaxation for Caving 

In MINEDW, the time-varied hydraulic conductivity related to the displacement of rock 

caused by underground mining can be simulated.  

To create this hydrogeologic zone, select “Zone of Relaxation for Caving” from the “Mining” 

menu on the Main Menu banner. The “Create Zone of Relaxation for Cave Zone” dialog box 

appears (Figure 7.63). Information required for creating this hydrogeologic zone is described 

below. 
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Figure 7.63. The “Create Zone of Relaxation for Cave Zone” dialog box 

Mining Schedule: The spatial extent of displaced rock over time due to block caving, which 
includes the date when the mining phase begins and the file names of 3-D .DXF files 
delimiting the extent of the inner and outer ZOR layers for the mining phase. 

ZOR Definition: The factors by which hydraulic conductivity increases/decreases for each 
hydrogeologic zone that is displaced by caving.  

Date and file name information can be entered manually in the “Mining Schedule” window or 

automatically using a mining schedule file. If “Mining Schedule” information is to be entered 

manually, enter the date when the first mining phase will begin and then enter the file name 

of the .DXF file defining the inner ZOR layer in the column labeled “Layer #1 File.” Next, enter 

the file name of the file defining the outer ZOR layer in the column labeled “Layer #2 File.” 

Click “Add” on the top right of the dialog box to add a new entry, and repeat the steps 
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described above until the ZOR for caving is completely defined. To use a mining schedule file 

to enter information into the “Mining Schedule,” click “Open…” and locate the mining schedule 

file. Select it and then click “Open” in the “Open Caving ZOR File” dialog box. Note that MINEDW 

only supports two ZOR layers for caving, unlike the option for open pits, in which the user 

can define as many ZOR layers as desired. 

After entering the necessary data, click “Search Zone.” The relevant hydrogeologic zone 

appears. Enter the factors by which hydraulic conductivity will change for each ZOR layer 

under the columns labeled “Layer #1” and “Layer #2.”  

Enter the file name of the cave-zone ZOR file to be created in the box at the bottom of the 

“Create Zone of Relaxation for Cave Zone” dialog box and then click “OK.” To assign the created 

time-varied conductivity file for a cave zone to the model, please see the following section. 

7.6.6. Dewatering and Underground Mining 

The “Dewatering and Underground Mining” menu is used to assign the underground ZOR 

mining file to the model and to define groundwater recovery in the mined area at the end of 

mining. The drop-down box at the top of the dialog box contains a list of underground mines 

already defined (this list may be blank if none have been defined). The “Add” and “Delete” 

buttons to the right of the drop-down box are used to add or delete mines from the model. 

The “Dewatering and Underground Mining” dialog box is divided into three tabs: 1) “General,” 

2) “ZOR,” and 3) “Recover” (Figure 7.64), which are explained below.  
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Figure 7.64. The “Dewatering and Underground Mining” dialog box 

The following options are available in the “General” tab: 

Activate: This checkbox is a switch to activate the selected underground mine in the model.  

Name: Defines the name of the underground mine. 

Drain Group Used: This window is used to define the groups of drain nodes that are associated 
with a particular underground mine. This option does not affect how the model runs but 
does change the location of output. Drain groups that appear in the “Drain Groups Used” 
window also appear in the “Mine” column of the .BUD file and in the .MNE file. This 
option makes post-processing much easier but is not necessary to correctly set up a 
model run. 

To assign the underground mining ZOR file to the model and define any groundwater 

recovery, select “Dewatering and Underground Mining” from the “Mining” drop-down menu. 

The “Dewatering and Underground Mining” dialog box (Figure 7.64) appears. Click the “Add” 

button, and the “General” tab becomes active. On this tab, the user can change the name of the 

mine, if desired, using the “Name” option. Next, select the drain groups associated with the 
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underground mine from the drop-down box next to the “Drain Group Used” window and click 

“Add” to move the drain group to the “Drain Group Used” box. Click “OK” to save the changes 

and close the “Dewatering and Underground Mining” dialog box or select the “ZOR” tab to 

define the ZOR. 

 

Figure 7.65. “ZOR” definition for an underground mine 

The “ZOR” tab is used to add the ZOR file created using the “Zone of Relaxation for Caving” 

dialog box to the model. The “ZOR” tab has the following options: 

Activate: This checkbox is a switch to activate the ZOR for the selected underground mine in 
the model.  

Assign: This button opens the “Open Time-Varied Conductivity File” dialog box, which is used 
to select the desired ZOR file. 

Remove: Removes the ZOR from the underground-mine definition. 

Create: Opens the “Create Zone of Relaxation for Cave Zone” dialog box. 
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On the “ZOR” tab, locate the “Assign…” button at the bottom of the dialog box. Click the 

“Assign…” button and, using the “Open Time-Varied Conductivity File” dialog box, browse to 

the previously created ZOR file, select it, and click “Open.”  

If the ZOR factors need to be altered, they can be updated using the “ZOR” tab (Figure 7.65). 

After all changes to the ZOR factors have been made, check the box next to “Activate” to 

activate the ZOR in the model.  

 

Figure 7.66. “Recover” tab parameters 

Using the “Recover” menu, the user can define groundwater recovery and inflow into the 

underground workings after the end of mining. The “Recover” tab has the following options: 

Activate: This checkbox is a switch to activate groundwater recovery for the selected 
underground mine in the model.  
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Start Date: Defines the start of groundwater recovery, which should be after the end of 
mining. 

# of Stages: The number of stages to use to calculate groundwater inflow into the 
underground workings. 

Create: Function used to calculate the elevation and volume of each stage. This function is 
described in further detail below. 

 Import: Function that can be used to import a file containing the stage elevation and volume 
relationship for groundwater recovery. The file format of this input file is detailed in 
Appendix B. 

Additional pumping/recharge; if elevation is lower than: These options allow the user to define 
an elevation below which additional pumping or recharge is active. 

Define Rate: This button opens a time-series window that is used to define the rate of 
additional pumping or recharge for groundwater elevations below the specified level. 

On the “Recover” tab, define the “Start Date” of groundwater recovery and inflow into the 

underground workings. Next, specify the “Initial Lake Elevation” if the value MINEDW has 

automatically assigned is not desired. The default value is based on the lowest mined 

elevation. In the box next to “# of Stages,” enter the number of stages to use to calculate 

groundwater recovery in the underground workings. Note that if importing a file containing 

the stage elevation and volume recovery information, the “# of Stages” will be auto-populated. 

Next, click on “Create” to open the “Create Underground Recover Stage” dialog box shown in 

Figure 7.67 below. This function is used to calculate the stage elevation and volume 

information for groundwater recovery using a 3-D .DXF file and the “# of Stages” input by the 

user. The input for the dialog box is discussed below. 

 

Figure 7.67. The “Create Underground Mine Recover Stage” dialog box 

DXF File: Input for the file path and file name of the 3-D .DXF file to use to calculate the stage 
elevation and volume information for groundwater recovery. 

Maximum Elevation: The maximum elevation of the underground workings. 

Minimum Elevation: The minimum elevation of the underground workings. 
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Stage Space: The space of each stage, which is calculated by MINEDW based on the input 3˗D 
.DXF file and number of stages. This value can be modified by the user if necessary. 

After selecting the appropriate .DXF file and verifying the MINEDW calculated information 

for the stages, click “OK” to close the window. The information for “Elevation” and “Volume” 

in the “Dewatering and Underground Mining” dialog box is automatically updated. If there is 

any additional pumping or recharge to be defined, check the “Additional pumping/recharge” 

box and enter the elevation below which additional pumping or recharge is active in the box 

to the right. Next, click the checkbox next to “Define Rate” to open the time-series window 

where pumping or recharge rates are defined. Figure 7.66 shows the “Recover” tab with the 

necessary input. 

 

Figure 7.68. The “Recover” tab of the “Dewatering and Underground Mining” dialog box 
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The “Backfill” tab in the “Dewatering and Underground Mining” dialog box is used to specify 

backfilling operations of an underground mine. The “Backfill” tab is shown above in Figure 

7.68, and the inputs are discussed below. 

Import: Import will allow the user to import a file describing the backfilling of underground 
workings. 

Create Backfill: This will open the “Create Zone of Relaxation for Cave Zone” dialog box, which 
will allow the user to create a file describing the backfill of the underground workings. 
The same procedures as described in Section 7.6.5 should be followed. 

Turn Off All Drain When Backfill: This option will turn off all drain nodes that were used to 
simulate the dewatering of the underground workings. In order for this function to 
work, the appropriate drain node groups must be added to the “Drain Group Used” 
window on the “General” tab (Figure 7.64). 

Reference Node: The node that is used for a reference elevation.
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MODEL EXECUTION 8
  

The “Run” menu validates the model parameters, generates the data set, and launches the 

model simulation.  

8.1. Validate 

The “Validate” function in the “Run” drop-down menu checks all the model inputs before 

model files are created. Selecting “Validate” from the “Run” drop-down menu opens the 

“Validate Model” dialog box, which has two tabs: “General” and “Extend.” On the “General” tab 

(Figure 8.1), general information about the model is displayed, such as the number of nodes 

and elements.  
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Figure 8.1. The “General” tab in the “Validate Model” dialog box 

The “Extend” tab (Figure 8.2) contains additional information about the model, such as 

boundary conditions and mining information. Reviewing the information on both of these 

tabs is strongly recommended to ensure that the model has been defined correctly. 
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Figure 8.2. The “Extend” tab in the “Validate Model” dialog box 

Clicking the “Validate” button at the bottom of the dialog box checks all the inputs to the 

model. If there is an error in an input, then it is listed in red in a pop-up window; if not, then 

no errors are listed (Figure 8.3). The user is advised to fix all errors prior to running the 
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model. If there are no errors, then the model is ready for the simulation. Click “OK” to close 

the “Validate Model” dialog box. 

 

Figure 8.3. A completed model validation 

8.2. Create Data Set 

To create the data set for a model run, select “Create Data Set” from the “Run” drop-down 

menu. The “Choose a Simulation Directory” window opens. Choose a folder to store all the 

input files created and then click the “Select Folder” button. 

Entering input to the numerical portion of MINEDW is accomplished by reading model-input 

files that define the groundwater problem to be simulated. Depending on the complexity of 

the problem, as many as 18 input files are necessary to run a MINEDW model simulation. For 

relatively simple problems, many of the files contain a zero, indicating that the input for that 

part of the simulation does not apply. The MINEDW program uses the files listed below for 

performing simulations.  

CHEAD.DAT — File containing constant-head conditions information. 

ELM.FEM — File containing finite-element mesh incidences. 

ELEMENTK.DAT — File containing elements that change hydraulic parameters over time. 

EVAP.DAT — File containing evapotranspiration package input. 

FAULT.DAT — File containing fault internal conditions information (file defining where 
nodes are “linked” to simulate hydraulic connection). 

FILE.FEL — Lists all of the input files used for the simulation. 

FLUX.DAT — File containing variable-boundary conditions information. 

KFILE.DAT — File containing aquifer properties for different hydrogeologic zones. 

MINING.DAT — File containing pit-plan data. 
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MODEL.DAT — Main input file containing simulation parameters, output controls, grid, and 
solver parameters. 

NODE.FEM — File containing finite-element mesh (nodes) coordinates. 

PARA.FEM — File containing hydrogeologic-zone specifications. 

PUMP.DAT — File containing pumping data that define where, when, and how much pumping 
is simulated. 

PUMPWELLS.DAT — File containing pumping-well information such as node number, 
number of pump, screen interval, and pumping time-series data (rate and date). 

RECHARGE.DAT — File containing recharge package input. 

RIVER.DAT — File containing river package input. 

TIMESTEP.DAT — File containing time-step length information. 

WATERLEVEL.DAT — File containing initial water-level data. 

8.3. Execute 

To run the simulation, select “Execute” from the “Run” drop-down menu on the Main Menu 

banner at the top of the screen. The “Choose a Working Directory” window opens. Choose the 

folder containing the input files and click “Select Folder.” A window like that shown in Figure 

8.4 opens. The simulation’s progress is shown at the top of the window. Any errors that are 

not fatal are displayed in red in the progress window on the left. The file “MINEDW.ERR” can 

also be reviewed after each model run to view any errors. The “Abort” button will terminate 

the simulation, while the “Output Current Result” button will print the current simulation 

results to the appropriate output files. 

 

Figure 8.4. Screen display of output from the model run
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MODEL OUTPUT 9 

This chapter provides information on the following: 

▪ Reading, 

▪ Visualizing,  

▪ Exporting, and 

▪ Working with model outputs. 

Different options to display, customize, and export the simulation results are described in the 

following sections. 

9.1. Read Results and Export Results as Text File 

The “Read Results” function is used to read the simulated-head output file. The simulated 

heads are stored in a file with a .PLB extension in binary format. The “Read Results” function 

reads the results for simulated time steps. To visualize and export the simulation results, click 

“Results” from the Main Menu and then choose “Read Results.” Select the .PLB file from the 

folder where MINEDW was executed. There is another option for result files (e.g., a .PLT file) 

in the “Open Result File” dialog box. The .PLT file is an older text-file format used by previous 

versions of MINEDW. The .PLT file is no longer created by MINEDW during a model run but 

can be created using the “Export Results as Text File” function. When using the “Export Results 

as Text File” function, a .PLB file can be converted to a .PLT file. First, the .PLB file must be 

imported using the “Read Results” function. Then, using the “Export Results as Text File” 

function, a .PLT file can be created. To view model results at a desired time step, enter the 

time step in the variable field of the time-step slider or move the time-step slider to the 

desired time step. 

9.2. Observations 

Observation locations can be defined using the “Observations” function. This information is 

used to create the hydrographs for user-specified locations. In MINEDW, observations are 

input as either “Monitoring Boreholes” with screened intervals or as “Piezometers” with 

measurements at discrete x, y, and z locations. “Piezometers” differ from “Monitoring 

Boreholes” because results are extracted from a discrete x, y, and z location, whereas 
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“Monitoring Boreholes” extract results that have been averaged along a screened vertical 

interval.  

To add a new monitoring borehole, select the “Monitoring Borehole” tab and then click “Add” 

at the right of the dialog box. A new entry is added. Enter the name of the monitoring borehole 

and the corresponding “X” and “Y” as well as “Screen Top” and “Screen Bottom” information. 

The information required for monitoring wells is described below. The “Add,” “Insert,” and 

“Delete” buttons on the right of the “Monitoring Borehole” tab add or delete monitoring 

boreholes. 

 

Figure 9.1. The “Edit Observations” dialog box 

Name: The name (or other identifier) of the monitoring borehole. 

X: The x coordinate of the monitoring borehole (m or ft). 

Y: The y coordinate of the monitoring borehole (m or ft). 

Screen Top: Elevation at the top of the screen (m or ft). 

Screen Bottom: Elevation at the bottom of the screen (m or ft). 
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To add a new piezometer, select the “Piezometer” tab and then click “Add” at the top of the 

dialog box. This adds a new “Piezometer” group to the model, but no observations can be 

extracted unless individual piezometers are added to the group. Under each piezometer, 

different measurement points can be input (e.g., multi-level piezometers). To add individual 

measurement points, click “Add” on the lower right of the “Edit Observations” dialog box and 

a new blank entry is added. Enter the name of the piezometer and the corresponding x, y, and 

z location.  

To navigate between different piezometers, a drop-down menu is available at the top. The 

“Add,” “Insert,” and “Delete” buttons at the top of the “Piezometer” tab add or delete 

piezometer groups. 

The information required for a piezometer is described below. 

 

Figure 9.2. The “Edit Observations” dialog box 

Name: The name (or other identifier) of the piezometer. 

X: The x coordinate of the piezometer (m or ft). 

Y: The y coordinate of the piezometer (m or ft). 

Z: The z coordinate of the piezometer (m or ft). 
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At the base of the “Edit Observation” menu, the user can import or export observation files 

using the “Import” and “Export” buttons.  

9.3. Hydrograph 

To create hydrographs from simulation results, use the “Hydrograph” function under the 

“Results” drop-down menu. Ensure that model results have been imported from the .PLB file. 

In the “Create Hydrograph File” dialog box that opens, choose a directory to export the 

hydrograph file to and enter a name, then click “Save.” The groundwater-head data from 

monitoring boreholes and piezometers are then exported to a .DAT file. This file will include 

time steps, corresponding dates, well identification (ID), and corresponding groundwater-

head data for all of the time steps. If the monitoring location becomes dewatered during the 

simulation, i.e., the groundwater head drops below the monitoring level, the hydrograph file 

will contain “unsat” appended to the head value. Also, if the monitoring location is mined out 

during the simulation, the hydrograph file will contain “mined” appended to the head value 

for that location. Data from this file can easily be plotted using Microsoft ExcelTM or another 

plotting software, as shown in Figure 9.3. 

 

Figure 9.3. Plotting hydrograph data from MINEDW 

9.4. Particle Tracking 

The particle tracking function (Figure 9.4) in MINEDW allows the user to investigate potential 

capture zones for pumping wells or the general movement of groundwater in the system. 
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Particle tracks are calculated after a model run is completed using data stored in the .PLB file. 

The information required for particle tracking simulations is described below. 

 

Figure 9.4. The “Particle Tracking” dialog box in MINEDW 

Start/End Time: Defines the start or end date and time for particle tracking. If “Forward” is 
selected as the “Tracking Direction,” this represents the start date time of the particle. 
Conversely, if “Backward” is selected, it represents the end date time. 

Tracking Time (days): Defines the period through which particle tracking is conducted. 

Step Size (m): Defines the distance particles traverse in each step. 

Tracking Direction: Defines the direction (forward or reverse in time) in which particle tracks 
are calculated. 

Add: Adds an entry in the window to the left where the starting or ending XYZ data can be 
defined for a particle. 

Delete: Deletes the currently selected entry in the window to the left. 

Import: Imports a particle-tracking file that contains all of the necessary information for a 
particle-tracking calculation. 
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Export: Exports a particle-tracking file that contains the necessary information for a particle-
tracking calculation. 

OK: Calculates particle tracks if all parameters are defined and closes the “Particle Tracking” 
dialog box. 

Cancel: Closes the “Particle Tracking” dialog box. 

Results Output: Specifies the location and file name of the particle-tracking file that is to be 
created. 

X: The x coordinate of the starting or ending position of the particle. 

Y: The y coordinate of the starting or ending position of the particle. 

Z: The z coordinate of the starting or ending position of the particle. 

Advanced: Opens the “Advanced Options” dialog box (Figure 9.5). 

 

Figure 9.5. The “Advanced Options” dialog box 

Variogram Model: Allows the user to select “Exponential,” “Spherical,” or “Gaussian” 
variograms for interpolation of head data from a triangular mesh to a rectangular mesh. 

Variogram Range: Defines the range to use for the chosen variogram. 

Number of Neighbors: Defines the number of points to use in the interpolation. 

OK: Saves the changes and closes the “Advanced Options” dialog box. 

Cancel: Discards any changes and closes the “Advanced Options” dialog box. 

To use the particle-tracking function, first import the .PLB file using the “Read Results…” 

function under the “Results” menu. Next, open the “Particle Tracking” dialog box by clicking 

on “Particle Tracking…” under the “Results” menu. In the open dialog box, define the 

“Start/End Time” for particle tracking, the amount of time to track the particles in the box 

next to “Tracking Time (days),” and the “Step Size (m).” Choose “Forward” or “Backward” for 

the type of particle tracking. To add particles, click “Add,” which is to the right of the “Particle 

Tracking” dialog box. This creates an entry where the x, y, and z location of the start or end of 

the particle track can be defined. When all the particles have been added, click the button next 

to “Result Output”; this opens the “Particle-Tracking Results” dialog box. Using this dialog box, 

choose the location to save the particle-track file and enter a name for the file, then click 

“Save.” Finally, click “OK” to create the particle-tracking file.  
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To visualize the particle tracks created in the preceding steps, navigate to the “Post 

Processing” plot items on the “List” tab of the “Control Panel” Pane and add a “Particle 

Tracking” plot item. Click the icon next to “File” on the “Attribute” tab to open the “Select 

Particle-Tracking File” dialog box. Using this dialog box, navigate to the location where the 

particle-tracking file was saved; select it and click “Open.” The particle tracks appear in the 

View Pane. The options described in Section 3.4.1.10 can be used to customize the particle 

tracks as needed. 

9.5. Section Flux 

This function calculates groundwater flux across a cross-sectional area defined by the user. 

The inputs, as displayed in Figure 9.6, are x and y coordinates of the start and end points of 

the cross-sectional area as well as the z coordinates of the top and bottom of the area across 

which flux will be calculated. When “Calculate” is pressed, MINEDW will calculate the flux in 

m3/day or ft3/day and display the result in the bottom of the dialog box. Click “OK” to close 

the “Section Flux” dialog box. 

 

Figure 9.6. The “Section Flux” dialog box 

9.6. Seepage Component to Pit 

MINEDW provides the user with a function to compute seepage to the pit and a plot item to 

view the locations where seepage is occurring. Seepage to the pit is recorded in a file with an 

.SEP extension. Seepage recorded in this file includes seepage during mining operations and 

seepage during pit-lake formation. Seepage is recorded for each time step at each node that 

forms the open pit. Using the “Seepage Component to Pit” function and the .SEP file, the user 

can compute seepage to the pit by geological unit or by another user-specified division. This 

output can be plotted or used in geochemical modeling for pit-lake chemistry predictions. 

With the “Pit Flux” plot item and the .SEP file, the user can visualize the locations and relative 
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magnitude of seepage that is occurring at any time step after the start of mining. This output 

may be used to assess future dewatering needs and optimum locations for in-pit dewatering 

solutions. The “Seepage Component to Pit” function and “Flux” plot item are explained in the 

following sections.  

9.6.1. Calculating Seepage to the Pit 

The “Seepage Component to Pit” function computes the total seepage to the pit and 

contributions of each geologic unit to total seepage through time. To compute seepage to the 

pit, click “Results” on the Main Menu banner, and then choose “Seepage Component to Pit.” 

The “Seepage Component to Pit” dialog box appears (Figure 9.7). Select the .SEP file from the 

folder where MINEDW was executed. Choose “Geological Units” to determine the seepage rate 

from each geologic unit. To define an output name and location, click the button at the bottom 

right box. The “Save Pit Flow File” dialog box appears (Figure 9.8). 

 

Figure 9.7. The “Seepage Component to Pit” dialog box 
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Figure 9.8. The “Save Pit Flow File” dialog box 

Type a name at the bottom of the window and click “Save.” In the following dialog box, click 

“OK.” The seepage file is then created.  

The created file can be imported to Microsoft ExcelTM or other graphing software in which 

total seepage versus time (Figure 9.9) and seepage from each geologic unit through time 

(Figure 9.10) can be plotted.  
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Figure 9.9. Total seepage to the pit through time 

 

Figure 9.10. Seepage rate from each geologic unit through time 

9.6.2. Visualizing Seepage and Drains 

As previously mentioned, it is possible to visualize the location where seepage to the pit is 

occurring, as shown in Figure 9.11. To do this, expand the “Post Processing” item under the 

“List” tab in the “Control Panel” Pane. Add a “Flux” plot item to the View Pane by double-

clicking it. On the “Attributes” tab for the “Flux” plot item, select “+” next to the “File” attribute. 

In the “Select Flux File” dialog box that opens, change the type of file to “Seepage Flux Files 
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(mdw_output.SEP)” using the drop-down list next to “Files of Type.” Now navigate to the 

location where the model was executed and select the file ending in .SEP. The nodes where 

seepage to the pit occurred are visible as colored squares. The colors indicate the magnitude 

of seepage occurring at the node forming part of the open pit. The size and color ramp can be 

modified on the attributes tab of the “Flux” plot item. 

 

Figure 9.11. Visualizing seepage locations within the open pit 

The “Flux” plot item can also be used to visualize the magnitude of flow through “Drain” 

boundary conditions. Seepage nodes that form the pit shell are considered drains and are 

automatically created when a mine plan is created (Section 7.6). “Drains,” in contrast, are 

created by the user and can be used to simulate sinks such as underground excavation, sub-

horizontal drains, and sumps. The workflow for visualizing “Drains” is similar to the workflow 

for seepage, with one exception: instead of choosing “mdw_output.SEP,” select the 

“mdw_output.DRN” option if it is not already selected, then navigate to the .DRN file and select 

it. Flow through user-created drains is displayed in the View Pane. The size and color of the 

drain nodes can be altered using the “Contour” and “Point” attributes. 

9.7. Pit Node Elevation and Water Table 

MINEDW enables the user to plot pit node elevations and the water table beneath the pit over 

time. Click “Results” from the Main Menu banner, and then choose “Pit Node Elevation and 

Water Table.” The “Elevation of Pit Node” dialog box appears (Figure 9.12). Enter the “Node 

Number” on the left and click “View.” For the specified node, the changes in the water table 

beneath the node and the pit-surface elevation are plotted as shown in Figure 9.12.  
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Figure 9.12. The “Elevation of Pit Node” dialog box 

If multiple nodes are to be plotted, click “Add” and insert additional node numbers. Then click 

“View.”  

9.8. Export State 

Data from MINEDW simulations can be exported for all of the nodes to a .DAT file. 2-D data, 

which include “X,” “Y,” “Elevation,” “Head,” “Pressure,” “Water Table,” “Drawdown,” and “Head 

Difference,” can be exported for each model layer. For 3-D data, the options are 1) “X,” 2) “Y,” 

3) “Elevation,” 4) “Head,” 5) “Pressure,” and 6) “Head Difference.” To export these data in 2-D 

or 3-D, choose “Export State” from the “Results” drop-down menu. Using the “Choose Export 

Items” dialog box (Figure 9.13), select the appropriate data set in “2-D” or “3-D” and then click 

“OK” to generate the file. Note, if neither the “X” nor “Y” box is checked, the data are exported 

as a list of values. The coordinates associated with these values correspond to the nodes in 

the model for the selected time step. They are ordered using the same order as nodes in the 

“node.fem” file (i.e., 1 to n) generated by MINEDW. Alternatively, checking the boxes next to 

“X,” “Y,” and “Elevation” adds coordinates for each of the exported data values.  
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Figure 9.13. The “Choose Export Items” dialog box with “2D” selected 

9.9. Exporting Pore Pressure 

To export the pore pressures in 3-D, click “Results” from the Main Menu banner and then 

choose “Export Pore Pressure.” The “Output Pore Pressure” dialog box appears (Figure 9.14). 

 

Figure 9.14. The “Output Pore Pressure” dialog box 
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Select the folder and type a file name at the bottom of the “Output Pore Pressure” dialog box, 

and then click “Save.” The “Grid-Export Pore Pressure” dialog box opens. Choose the 

interpolation method (Inverse Distance or Kriging) and define the related parameters (Figure 

9.15). The options for this menu are described below. 

Inverse Distance: Option to use the inverse-distance method for interpolation. 

Kriging: Option to use the kriging method for interpolation. 

Number of Points to Search: Data points to use in the kriging or inverse-distance method. 

Power: Power used in the inverse-distance method. 

Range: Range used in the kriging method. 

X Direction (Minimum, Maximum): The region defined along the x-axis to include in the export. 

Y Direction (Minimum, Maximum): The region defined along the y-axis to include in the export. 

Z Direction (Minimum, Maximum): The region defined along the z-axis to include in the export. 

# of Lines (X, Y, Z): The grid spacing in the x, y, and z directions. 

Save: Option to save a file with the parameters for exporting pore pressures. 

Open: Opens a saved parameter file. 

Define the minimum and maximum x, y, and z coordinates and the number of lines (the 

number of lines defines the grid space), then click “OK.” 

 

Figure 9.15. The “Grid – Export Pore Pressure” dialog box 

The pore pressures are be interpolated to the defined grid and saved in a .DAT file. The .DAT 

file includes x, y, and z coordinates as well as pore pressures.  
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9.10. Export Cross-Section Pore Pressure  

MINEDW can export the pore pressures in both 2-D and 3-D to a .DAT file with a specified 

grid space and dimensions for geomechanical models. To export the pore pressures in a cross 

section (2-D), click “Results” from the Main Menu banner and then choose “Export Cross-

Section Pore Pressure.” The “Output Cross-Section Pore Pressure” dialog box appears (Figure 

9.16). 

 

Figure 9.16. The “Output Cross-Section Pore Pressure” dialog box 

Select the folder and type a file name at the bottom of the “Output Cross-Section Pore Pressure” 

dialog box and click “Save.” The “Grid – Export Cross-Section Pore Pressure” dialog box 

appears. Choose the interpolation method (Inverse Distance or Kriging) and define the 

related parameters (Figure 9.17). The options for this menu are described below. 

Inverse Distance: Option to use the inverse-distance method for interpolation. 

Kriging: Option to use the kriging method for interpolation. 

Number of Points to Search: Data points to use in the kriging or inverse-distance method. 

Power: Power used in the inverse-distance method. 

Range: Range used in the kriging method. 

Vertical (Minimum, Maximum): The height (Minimum Z, Maximum Z) of the cross section to 
be exported. 
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Start X/Y: The starting location of the cross section. 

End X/Y: The ending location of the cross section. 

# of Lines (Horizontal, Vertical): The discretization in the x and y directions. 

 

Figure 9.17. The “Grid – Export Cross-Section Pore Pressure” dialog box 

Define the minimum and maximum x and y coordinates of the cross section and the number 

of lines (changing the number of lines changes the grid space), then click “OK.” The pore 

pressures are interpolated to the defined grid and are saved in a .DAT file. The .DAT file 

includes x and y coordinates as well as pore pressures.  

9.11. Drawdown-Base Time Step 

The “Drawdown-Base Time Step” option enables users to select a date from which drawdown 

is calculated. In most cases, the initial date is the first time step of the simulation. If the 

drawdown is to be calculated using a different time step, then the date for the first time step 

should be entered. Select “Drawdown-Base Time Step” from the “Results” drop-down menu to 

open the “Define Drawdown Initial Date/Time” dialog box (Figure 9.18). 
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Figure 9.18. The “Define Drawdown Initial Time/Date” dialog box 

9.12. Visualizing the Results 

MINEDW offers different options for presenting the simulation results graphically. The 

“Control Panel” options can be used to display the results. Choose the “Node” plot items under 

the “List” tab in the “Control Panel” Pane to produce both 2-D and 3-D contours. Using “2D 

Contour” plot items, 2-D color floods of head, pore pressure, head difference, water table, and 

drawdown can be produced. Using “3D Contour” plot items, 3-D contours of head, pore 

pressure, and head difference can be created. The display for each of these plots can be 

customized using the “Attributes” tab in the “Control Panel” Pane (Chapter 3). The figures 

below are examples of the 2-D and 3-D plots (Figures 9.19 and 9.20). 

  

Drawdown Water Table 

 

 

Head Difference  

Figure 9.19. Sample 2-D contour plots 
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Elevation Head 

  
Pressure Head Difference 

Figure 9.20. Sample 3-D contour plots 

To create a 3-D pore-pressure plot, select the “List” tab from the “Control Panel” Pane, expand 

the “Node” item, and then double-click the “3D Contour” option (Figure 9.21). Next, select the 

“Attribute” tab from the “Control Panel” Pane and select “Pressure” from the “Color By” setting. 

Pore pressures are visible in the View Pane. By changing the time step on the time-step slider, 

the desired time step can be viewed. 
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Figure 9.21. Attributes of the “3D Contour” plot item 

To export an image of the 3-D pore-pressure plot, ensure that the desired time step is 

selected, then choose “Export Base” from the “File” item on the Main Menu banner and select 

“Bitmap.” The exported bitmap is shown in Figure 9.22.  
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Figure 9.22. Screen display of head distribution in 3-D 

9.13. Cross Sections 

Cross sections are useful because they allow the user to visualize different types of data 

together at any point within the model domain. For example, a user may wish to view a cross 

section of the open pit showing geological units overlaid by contours of pore pressure, head, 

or head difference. This can be achieved by using the “3D Element,” “Isosurface,” and “Plane” 

plot items. 

To draw a cross section, the first step is to plot the desired “3D Contour” (Elevation, Head, 

Pressure, or Head Difference) or “3D Element” plot item. Model geology and pore pressures 

are used as an example; however, similar steps can be followed to plot a cross section of any 

other model results. 

To view model geology and pore pressures, select the “List” tab from the “Control Panel” Pane, 

expand the “Element” item, and double-click “3D Element.” Now, add an “Isosurface” plot item 

(be sure to import results) by expanding the “Node” item and double-clicking “Isosurface” 

(Figure 9.23). On the “Attributes” tab for the “Isosurface” plot item, select “Pressure” as the 

“Color By” attribute. A 3-D color flood of model geology with “Isosurfaces” of pore pressures 

appears in the View Pane, but the “Isosurfaces” are not visible, as they are hidden by the “3D 

Element.” Select the desired time step to view with the time-step slider. 
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Figure 9.23. The “3D Element” and “Isosurface” plot items 

The easiest method for creating a cross section is to use the “Plane” tool located on the 

Toolbar. To use it, click on it, then select two points on the displayed “3D Element” plot item. 

The “3D Element” and “Isosurface” plot items will be cut by a plane that passes through the 

two points that were selected. 

Alternatively, create a cross section by selecting the “List” tab from the “Control Panel” Pane, 

expanding “Cutting Planes,” and double-clicking “Plane” (Figure 9.24). 
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Figure 9.24. The “Plane” plot item 

On the “Attributes” tab, define the origin, dip, and dip direction of the plane (Figure 9.25). 
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Figure 9.25. The attributes of the “Plane” plot item 

For both methods of creating a cross section, display the front or back sections that have been 

cut (i.e., to turn a 2-D item into a 3-D item) by selecting “3D Element” from the list in the “Plot 

Items” pane and checking the box for “Front” or “Back” under “Cutplane” on the “Attributes” 

tab (Figure 9.26). 
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Figure 9.26. The attributes of the “3D Element” plot item 

The cross section will display model geology through the open-pit area overlaid by contours 

of pore pressure (Figure 9.27). To export the plot as a bitmap, select “Export Base” under the 

“File” menu and choose the “Bitmap” option.  
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Figure 9.27. Screen display of output from the model run 

9.14. Pit Lake – Water Level vs. Time 

The water-level change in a pit lake can be computed in MINEDW if a pit lake is simulated in 

a model. To plot pit-lake level changes over time, import the .LAK file (Appendix B) from the 

folder where MINEDW was executed to Microsoft ExcelTM or other plotting software (Figure 

9.28). The .LAK file also contains other useful information about the pit lake. This file contains 

the net flux to the pit lake as well as seepage to and from the pit lake. Evaporative losses, 

volume, and lake area are also recorded in this file. Note that these data are only recorded in 

time steps during which a pit lake is active. If seepage to the pit occurs during mining 

operations, it is not recorded in the .LAK file. This seepage data can be located in the .SEP file 

(Section 9.6). 
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Figure 9.28. Pit-lake water level with time 

9.15. Pumping Well – Discharge vs. Time 

Pumping rates are reported in the output file with an .FLW extension. This file also contains 

the flux for each of the constant-head groups defined in the “Constant-Head Boundary” dialog 

box. The .FLW file reports extraction of groundwater from the model as negative numbers 

and addition of groundwater as positive numbers. Flux into or out of the model domain is 

reported for each time step. 

 

 

 


	Table of Contents
	List of Figures
	List of Tables
	Acronyms and Abbreviations
	Symbols
	Introduction 1
	Features of MINEDW 2
	MINEDW Interface  3
	3.1. View Pane
	3.2. Main Menu
	3.2.1. The File Menu
	3.2.2. The Project Menu
	3.2.3. The Mesh Menu
	3.2.4. The BCs Menu
	3.2.5. The Mining Menu
	3.2.6. The Run Menu
	3.2.7. The Results Menu
	3.2.8 The View Menu
	3.2.9. The Tools Menu
	3.2.10. The Windows Menu
	3.2.11. The Help Menu

	3.3. Toolbar
	3.4. Control Panel Pane
	3.4.1. Plot Items
	3.4.1.1. Legend
	3.4.1.2. Display Settings
	3.4.1.3. Global Settings
	3.4.1.4. Axes
	3.4.1.5. Observation
	3.4.1.6. Boundary Conditions
	3.4.1.7. Element
	3.4.1.8. File Data
	3.4.1.9. Node
	3.4.1.10. Post Processing
	3.4.1.11. Cutting Planes
	3.4.1.13. Clip Box

	3.4.2. View
	3.4.3. Information


	Importing Data Sets 4
	4.1. Importing Earlier Versions of MINEDW Model Data Sets
	4.2. Display the Imported Model

	Mesh Generator 5
	5.1. Creating a Mesh
	5.2. The Mesh Components
	5.2.1. The “Domain” Component
	5.2.2. The “Mining Area,” “Mining,” and “Fine Area” Components
	5.2.3. The “Fault” Component
	5.2.4. The “Points” Component
	5.2.5. The “Polylines” Component
	5.2.6. The “Regions” Component
	5.2.7. The “All Faults” Component
	5.2.8. The “MMesh” Component
	5.2.9. The “Toggle” Component
	5.2.10. The “Area Tolerance” Component

	5.3. Exporting a Completed Mesh
	5.4. The Rhino “Drop” Command

	Nodes and Elements 6
	6.1. Selecting Elements
	6.1.1. Selecting Elements in 2-D
	6.1.2. Selecting Elements in 3-D

	6.2. Selecting Nodes

	Model Input Data 7
	7.1. Project Definition
	7.1.1. Project Properties
	7.1.2. Time Steps

	7.2. Model Geometry
	7.2.1. Generating the Mesh
	7.2.2. Adding Main Model Layers
	7.2.3. Using Topography Data
	7.2.4 Importing Node Elevations
	7.2.5. Defining a Pinch-Out
	7.2.6. Modifying the Mesh

	7.3. Zone Properties – Hydraulic Parameters
	7.3.1 Zone Distributions (para.fem)
	7.3.2 Zone Properties (kfile.dat)

	7.4. Boundary Conditions
	7.4.1. Time-Series Data
	7.4.2. Constant Head
	7.4.3. Variable-Flux
	7.4.4. Pumping Well
	7.4.5. Rivers
	7.4.6. Recharge
	7.4.7. Evaporation

	7.5. Initial Conditions
	7.6. Mining Plan
	7.6.1. Creating a Mining Plan
	7.6.1.1 Converting .DXF to .DAT files
	7.6.1.2 Creating a Mining Plan from Pit Topography files
	7.6.1.3 Creating a Mining Plan from Final-Pit Topography

	7.6.2. Importing a Mine Plan into MINEDW
	7.6.3. Pit Lake
	7.6.4. Zone of Relaxation for Pit
	7.6.5. Open-Pit Backfilling
	7.6.5. Zone of Relaxation for Caving
	7.6.6. Dewatering and Underground Mining


	Model Execution 8
	8.1. Validate
	8.2. Create Data Set
	8.3. Execute

	Model Output 9
	9.1. Read Results and Export Results as Text File
	9.2. Observations
	9.3. Hydrograph
	9.4. Particle Tracking
	9.5. Section Flux
	9.6. Seepage Component to Pit
	9.6.1. Calculating Seepage to the Pit
	9.6.2. Visualizing Seepage and Drains

	9.7. Pit Node Elevation and Water Table
	9.8. Export State
	9.9. Exporting Pore Pressure
	9.10. Export Cross-Section Pore Pressure
	9.11. Drawdown-Base Time Step
	9.12. Visualizing the Results
	9.13. Cross Sections
	9.14. Pit Lake – Water Level vs. Time
	9.15. Pumping Well – Discharge vs. Time


